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welcome to progeCAD!

By learning how to work with progeCAD, you are joining over a
million others who use the computer-aided design software to
draft drawings. It is exciting software, because it has many of the
features of CAD software that costs ten times as much — yet it is
very similar to the market leader, AutoCAD.

About progeCAD
progeCAD is based on IntelliCAD, and comes from progeSOFT
(www.progesoft.com).

One of the main benefits to progeCAD is its GUI, designed to have an “AutoCAD-like” feel-
ing. 

Features and Add-ons Exclusive to progeCAD

Here is a summary of features and enhancements new to the latest release of progeCAD:

ALE, Block Library Management
progeCAD Professional contains the full version of ALE, progeSOFT's powerful module for block
management. More than 11,000 blocks are included, with more delivered on a regular basis.

C • H • A • P • T • E • R 1

Welcome to
progeCAD
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Raster to Vector
progeCAD 2009 Professional includes WinTopo raster to vector tool.

Convert PDF to DXF
progeCAD 2009 Professional automatically adds a virtual printer, which can produce PDF

prints.
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O2C Converter
progeCAD Professional contains o2c features, where 3D models are easily exported and man-
aged with the o2c tool. o2c is the best tool for 3D model presentations.

Google Earth (new)
Export your models to Google Earth.
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Layer Filters
AutoCAD-like layers management with layers filters support.

Drawing Tabs (new)
Open multiple drawings in tabs across the top of the editor window.

Layout Paper Preview
Shows you how your drawing will look when printed.

One-click Single Line Text Edit
Click single-line text with your mouse and edit it immediately.

eTransmit
Compact and transmit your DWG drawing files by email.

Graphic Purge
Interactive interface for the Purge command.

Find
Find and replace text and block attributes in drawings.

Spell Check
Spell checker is updated to include more accurate compari-
sons of misspelled words.

Advanced Data Extraction
An easy-to-use wizard for exporting data from attributes and
blocks.

Qdim
Quick dimensioning by simply selecting the objects to dimension and placing the dimensions

New Express Tools
These powerful tools improve your productivity:

• Create perspective views.

• Replace block with xref.

• Justify text.

• Delete duplicate objects.

Standard GUI
More comfortable, standard graphic interface, new toolbars, and an AutoCAD-like feeling.

Properties Palette
AutoCAD-like interface for modifying properties: color, layer, text height, lineweights, linetype,
geometry, and so on.
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Layer Manager
Save and restore layer configurations.

progeSOFT DWG Explorer
Windows Explorer-style window for browsing drawngs and and inserting blocks.

progeSOFT New Wizard
Initial configuration template of new designs based on prototypes or predefined values.

Bitmap Clipping
Clip and polygonal clip of images.

Polar Tracking
Keeps the line to exact angles automatically.

Snap 'From'
The smart tool completing the snap family.

Print 3D
Output your 3D models to a rapid prototyping service bureau, and receive your part back within
2-3 days.

JPG and PDF print
Export drawing to JPG and PDF formats.

ECW and Jpeg 2000 raster format
The standard wavelet compression format optimized for aerial and satellite imagery.

BAttMan
Local editing of block attributes.

EAttEdit
Advanced attribute editing.

progeSOFT Wblock Manager
Tool for the improved creation of blocks on disk.

Extended Hatches
More than 300 new hatch patterns available.

progeSOFT Rendering
Advanced rendering module with multiple lights
management and the creation/editing of materials.
Includes reflection, mirror, transparency, smooth
shadows, customizable size bitmap output.
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Advanced Layout Features
• Hide on layout.

• Shade on layout.

• Selection of model space with double-click.

• Layout tabs.

Redline and Markup Support
Support for redlining, commenting, markup, and collaboration with progeCAD Viewer DWG,
the low cost viewer program from progeSOFT.

Asiatic Fonts
Chinese, Korean and Japanese improved compatibiliy and new fonts.

progeCAD is distributed in the United States by iCADsales (www.icadsales.com).  In addi-
tion, iCADsales offers industry-specific add-ons that run within progeCAD

• progeEARTH for civil/survey work.

• progeCAM Basic and Professional for CNC machining, using progeCAM Link to
transfer geometry directly to the toolpath generator, Dolphin Partmaster.

• progeOFFICE suite for interfacing with office apps (progeTABLE for spreadsheet
files, progeWORD for word processing documents, and progeDATABASE for data-
base files, and progeFIELD).

About This eBook
Inside progeCAD is based on progeCAD 2009, a commercial version of progeCAD. This book
is divided into three major sections.

Section 1 introduces you to progeCAD by taking you on a guided tour. (If you know AutoCAD,
then you are probably already familiar with progeCAD. Feel free to skip ahead to Chapter 4,
“progeCAD for AutoCAD Users” for an overview of the differences.)

Section 2 takes you through a tutorial that designs the floor plan of a one-bedroom apart-
ment.

Section 3 consists of an appendix that summarizes user interface elements.
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in this chapter, you learn how to start progeCAD, and then take a guided tour. In addition,
you learn the basics of working with any CAD system.

Starting progeCAD

You can start progeCAD in any of these ways:

• Double-click the progeCAD icon found on your computer’s desktop.

• Or, on the Windows taskbar, click the Start button, and then select Programs |
progeCAD | progeCAD 2009.

• Or, in Windows Explorer, double-click the name of a .dwg file. (This option works
only when progeCAD is specified to work with .dwg files.)
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Exploring the User Interface

When progeCAD starts, it presents itself like the image shown below. (Shown is the user inter-
face for progeCAD 2009 Pro. If you use another version of progeCAD, you may see something
different due to minor differences among user interfaces.)

TIPS To read more tips, click Next Tip repeatedly. Or, open the icad.tip file in Notepad,
and then read them all at once. The \\ marker indicates the start of the next tip.

You can access the Tip of the Day dialog box from within progeCAD: from the Help
menu, select Tip of the Day.

12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567

Tip of the Day

If you would like to see a handy tip on using progeCAD each time you start the software, then
you may want to turn on Tip of the Day, as follows: Go to Help | Tip Of The Day,  and then turn
on the Show Tips on Startup option.
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Title Bar

At the top of every Windows program is the title bar. It reports the name of the software
(progeCAD 2009 Professional in this case) and the name of the current drawing: [Draw-
ing1], as in the figure below.

Sometimes the title bar shows additional information. When the drawing has not yet been
saved, the “.dwg” file extension is missing from the drawing name. Once the drawing is saved
for the first time, .dwg is added to the drawing name.

When drawings are opened in read-only mode, the phrase (Read-Only) is added to the file
name. It reminds you that changes made to the drawing will not be saved to the same file.

To save a read-only drawing, save it by another file name.

Control Menu

At the left end of the title bar is an icon (  ). Click the icon to see a hidden menu that controls
the window. You can usually ignore this control menu. Sometimes, though, it is useful to know
that Alt+F4 is the keyboard shortcut that closes the current program.

At the other end of the menu bar are three buttons that do some of the same things as this
hidden menu. From left to right, they minimize ( _ ) , restore ( •  ), and close (X) the program
window.

TIPS To maximize and restore the progeCAD window, double-click the title bar.
To quickly exit progeCAD (and save the drawing), click the X button or press

Alt+F4. progeCAD automatically asks if you want to save the drawing; click OK. The
drawing is saved and the program is closed.
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Drawing Tabs
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Scroll Bars
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Properties Palette

X, Y, Z Coordinates
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Menu Bar

Below the title bar is the menu bar. Its purpose is to sort progeCAD’s many commands into
logical groups. For example, almost all file-related commands, such as Open, Save, and Close,
are found in the File menu. All commands related to dimensions are in the Dimensions menu.

progeCAD’s menus operate like those in other Windows programs. Select a menu item, and
then select a command from the dropdown menu.

For example, to save the drawing, use the mouse and cursor to select the File item, and then
choose Save.

Menus use these notations:

File (underline) means that the menu item can be accessed from the keyboard, in
place of using the mouse. To do so, hold down the Alt key, and then press the
letter — F in this case.

Ctrl+N means the command can also be activated with a keyboard shortcut. In this case,
hold down the Ctrl key, and then press the N key to activate the New command.
Other keyboard shortcuts involve the Alt, Shift, and F (function) keys. You can
customize the menu bar and its dropdown menus. From the Tools menu, select
Customize, and then select the Aliases tab.

New... (ellipsis or three dots) means the command displays a dialog box. When there are
no ellipses, look for prompts on the command line or in the prompt box.

______ (separator line) separates groups of commands within the dropdown menu.

(check mark) means the option is turned on; no check mark means the option is
turned off. You turn on and off the option by selecting the menu item.
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(arrowhead) means the menu item displays an additional menu, also called a “sub
menu.” In some cases, sub menus display further sub menus.

(You can customize aliases, the menu bar, and dropdown menus. See our Tailoring progeCAD
e-book for details.)

Toolbars

While menus display commands as words, toolbars display commands as pictures on buttons called
“icons.” As with other Windows programs, you activate commands by clicking the buttons.

progeCAD provides a couple of assistants for decoding the meaning of icons. When you move
the cursor over a button, look to the status line at the bottom of the window: it displays a one
sentence description of the button’s purpose.

When you leave the cursor sitting over the toolbar button, a “tooltip” appears after a few sec-
onds. The tooltip’s yellow rectangle contains a word or two describing the command executed
by pressing the button.

On high resolution monitors, the buttons might be too small to see. You can double their size by
right-clicking any toolbar, and then select Toolbars. Select Large Buttons, and then click OK.

progeCAD displays five toolbars initially; other toolbars are accessed by right-clicking any tool-
bar, and then selecting its name from the list.

(You can customize any toolbar and its buttons. From the Tools menu, select Customize,
and then select the Toolbars tab. See our Tailoring progeCAD e-book for details.)
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Entity Properties Bar

The Entity Properties bar is a special toolbar that shows you the settings for (left to right)
layers, colors, linetypes, lineweights, and plot styles.

It works in three ways:

• No objects selected: the drawing’s default settings are reported, as shown above.

• One or more objects selected:

Reports settings for the selected object(s).

Modifies the properties of the selected object(s).

Drawing Tabs

progeCAD can display one or more drawings at a time, each in its own window. To switch
quickly between drawings, progeCAD sports a row of tabs between the toolbars and the draw-
ing area.  For every drawing that is currently open in progeCAD, a file name appears on a tab.
Click a tab to switch to the drawing.

Alternatively, you can switch between drawings with the Windows menu, or by pressing
Ctrl+Tab.

Right-click a drawing tab to see a shortcut menu of options:

When you choose New Window, progeCAD creates a new window that contains a copy of the
original drawing. Any changes made in one copy is reflected in the second.
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Drawing Area

The drawing area is where you view, draft, and edit drawings.

When you start a new drawing with the New command, progeCAD opens a new, blank draw-
ing. When you open existing drawings with the Open command, they appear in the drawing
area.

You can change the color of the drawing area. Some drafters like it to be black, because it
makes entity colors stand out. Other drafters (myself included) prefer white for the background
color, because this color is the same as that of the paper upon which drawings will be printed.

You can change the background to any of 254 colors and shades of gray, as follows:

1. From the Tools menu, select Options, and then select the Display tab.

2. Click the Color button, found next to Graphics Screen Color.

3. Select a color in the Color dialog box.

4. Click OK twice to dismiss both dialog boxes.

(This book illustrates progeCAD with the white drawing area.)

Cursors

The cursor shows you where “you” are in progeCAD. It also provides you with information: in
different areas and in different situations, it changes its shape.

Outside of the drawing area, the cursor displays the familiar arrowhead found in other Win-
dows applications.
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When the cursor is paused over a toolbar button, a tooltip appears after a second or
two. The tooltip explains the purpose of the button. If you do not see tool-
tips, you can turn them on: right-click any toolbar, and then select Tool-
bars from the shortcut menu; choose the Show Tooltips option.

On the edge of windows, toolbars, and stretchable dialog boxes, the stretch cursor ap-
pears, indicating you can change the size of the user interface element.

In the drawing area, the cursor changes in these ways:

Cursor Meaning

No command is active: progeCAD is ready to select an object. The small square is
called the “pickbox”: within it, progeCAD searches for objects. The size of the pickbox
is changed with the Pickbox system variable.

The colored cursor indicates the direction of the x (cyan) and y (pink) axes. In 3D
space, the z axis is indicated by a yellow cursor line. The colors of the cursor can be
changed with the Option command’s Cursor option.

Command and esnap (entity snap) are active: progeCAD is ready to select objects.
The square is called the “aperture,” and is displayed only when esnaps are turned on.
progeCAD searches for geometric features within the aperture. The size of the aperture
can be changed with the Aperture system variable.

Entity snap found: When progeCAD finds a geometric feature, it displays a yellow icon
called a “marker,” which shows the location of the geometric feature; the yellow tooltip
describes the feature (Endpoint, in this case); see full list below. The color and size of
the marker can be changed with the Options command’s Snap Cursor option.

The “drumstick hitting the bassdrum” cursor is called “snap cursor decoration.” It alerts you
that two or more entity snaps are active. Other decorations are displayed for specific entity
snaps; entire list described later. Decoration are off by default; to turn them on, use the
Options command’s Show Snap Setting on Cursor option.

  The magnifying glass icon is displayed in place of the cursor during the Zoom command.

    The hand icon is displayed in place of the cursor during the Pan command.

 The 3D spin icon is displayed in place of the cursor during the RtRot command.

You will see these icons during other commands:

RtRotX: Spin about x axis.

RtRotY: Spin about y axis.

RtRotZ: Spin about z axis.

Entity snaps employ a different icon for every mode. There are decoration icons that report the
current entity snsap mode, and marker icons that report when progeCAD finds the matching
geometric feature. Here is the list of entity snap icons and their meanings:
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Esnap Mode Cursor Decoration Geometric Marker

Endpoint

Nearest

Perpendicular

Quadrant

Insertion

Center

Midpoint

Point

Tangent

Deferred no icon

Intersection

Plan View

Parallel no icon

UCS Icon

The purpose of the UCS icon is to show you the drawing’s orientation in 3D space. (UCS is
short for “user coordinate system.”) The icon is usually found in the lower left corner of the
drawing area.

In 2D space, the x and y axes are shown; the z axis is looking straight down on the x,y-plane.
The letter W means that the view is in the “world coordinate system” — basically, the default
and any time a UCS is not invoked. (See figure below, at left.)

In 3D space, the z axis shows up. The colors of the axes mimic that of the cursor.

The UCS icon is pointless for 2D drafting, and can be turned off with the UcsIcon command’s
Off option. When in paper space (layout mode), the UCS is also pointless, because paper space
is 2D-only. (Paper space is discussed in Chapter 11.)

The UCS icon changes to an icon that mimics a sheet of paper.
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Layout Tabs

Layout tabs are located below the drawing area. They allow you to switch quickly between
model space and named layouts.

Model space is where the drawing is created, where the 2D or 3D model is designed. Layouts
are meant primarily for plotting: you arrange 2D views of the model inside viewports with
drawing borders or title blocks.

While there is just one model tab, drawings can have many layouts. You would work with more
than one layout when you have color and black-white plot layouts, for example, or when you
have more than one sheet showing the drawing.

When you right-click a layout tab, a shortcut menu displays options for creating, renaming,
and deleting tabs. (The Model tab cannot be renamed nor erased, and the first  layout tab
cannot be erased.)

Command Bar

The command bar is the area where you type commands; this is also the area where progeCAD
most often reports information to you. Typically, you look here to see command options; this
does not apply to dialog boxes, ’natch.

The command bar normally hangs off the bottom of the progeCAD window, but you can drag it
away to make it a floating window. Once floating, you can resize the command bar to be wider,
narrower, taller, and shorter.

You can double-click the status bar to toggle the display of the command bar. Toggle means to
turn on and off.

Command Prompt

The command prompt is the word ‘Command’ followed by the colon ( Command: ). When you
see the prompt by itself on the lowermost line of the command bar, you know that progeCAD is
ready for you to enter a command. If it is not clear, press Esc to clear the prompt line.

TIP Use the CmdLnText system variable (short for “command line text”) to change
the prompt character.
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Prompt History Window

Press F2 to see the prompt history window. It remembers the last several hundred lines of
commands and prompts.

Right-click the prompt history window to display a shortcut menu that lets you copy the text to
the Clipboard, or to paste text into the window.

You can change the number of lines remembered by progeCAD: use the Tools | Options |
Display command. The maximum and minimum values are 500 and 1 lines.

Prompt Boxes

Many of progeCAD commands involve options. The Line command, for example, has options
for undoing (undrawing) the last segment, closing the lines as a polygon, and so on. Typically,
you specify the option by entering its first letter, such as “U” for Undo and “C” for Close.

progeCAD provides an alternative to typing characters: prompt boxes are shortcut menus that
display lists of option names, which you can select with the cursor.

The display of prompt boxes can be turned on and off through the Config command’s Display
tab: change the setting of Display prompt boxes.

Here is an example of the different prompt boxes that appear during the Line command:

(no prompt box) Command: line

(no prompt box) Start of line: (Pick a point.)

Angle/Length/<End point>: (Pick another point, or select an option.)
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Angle/Length/Follow/Undo/<End point>: (Pick another point, or select option.)

Angle/Length/Follow/Close/Undo/<End point>: (Pick a point, or select option.)

Prompt boxes disappear when commands end.

Some commands, such as Circle and Move, end on their own; for other commands, such
Line and Trim, you need to press Esc or Enter to end them.

Scroll Bars

Scroll bars appear at the right and bottom edges of the drawing area. They are an alternative to
using the Pan command to move the drawing view. By default, scroll bars are turned off, be-
cause that provides a bit more drawing area.

To turn on the scroll bars, use the ScrollBar command. Or, from the View menu, select
Scroll Bars item.

Status Bar

The status bar reports information on the status of the drawing and the drafting process.  From
left to right, the bar provides the following info:

• Help Text — a sentence of help appears when selecting menu items and toolbar
buttons; otherwise, the word “Ready” appears. You can right-click the status bar to
change the data it displays. Double-click the status bar to toggle the display of the
command bar.

• X,y,z — reports the coordinates of the cursor position in the drawing area; the z
coordinate reports the current elevation setting. During drawing and editing com-
mands, the display changes to show distance and angle:

Right-click to change the display of units.

• SNAP — toggles snap mode; right-click to access snap settings.

• GRID — toggles the display of the grid; right-click to access grid settings.
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• ORTHO — toggles orthographic mode, which constrains cursor movement to right
angles.

• ESNAP — toggles entity snap mode; right-click to access esnap settings.

• LWT — toggles the display of lineweights.

• MODEL — toggles model and paper space.

• ETRACK — toggles entity tracking mode.

• POLAR — toggles polar mode.

• Drag corner — drag with cursor to make the progeCAD window larger and smaller.

To change a toggle (snap, grid, ortho, esnap, model, and tablet), click its “button.” When on,
the word (SNAP, GRID, etc) looks indented; when off, outdented.

Changing the Status Bar

The display of the status bar can be turned on and off with the StatBar command. You might want
to turn it off to gain a fraction of an inch more drawing area, but the status bar is far too useful to
keep off. It provides an overview at the state of the drawing, and provides instant access to fre-
quently-used toggle commands.

Right-clicking different areas of the status bar provides a variety of shortcut menus.

User Input

progeCAD accepts input from the keyboard, mouse, and digitizing tablet. It also supports other
input devices, provided drivers are available that are recognized by progeCAD.

Keyboard

It is possible to run progeCAD almost entirely by mouse, the keyboard is still needed for input-
ting some coordinates, entering command options, and naming files. Indeed, there are some
— such as me — who prefer the keyboard over the mouse. Commands and options are entered
by typing their names in the command bar.

(Right-click the command bar to display a shortcut menu that lets you copy all text to the
Clipboard, paste text, and access the Options dialog box.)

Spacebar and Enter

Pressing the spacebar performs several functions, whose meaning depends on when you press
it: end input, exit commands, or repeat commands. (Pressing the spacebar is equivalent to
pressing the Enter key.)
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The spacebar tells progeCAD that you are done entering data, such as the name of a command,
an option, or coordinates:

Command: line (Press spacebar or Enter.)

Start of line: (Type coordinates, and then press spacebar or Enter.)

Press the spacebar to tell progeCAD you want the command to end:

Angle/Length/Follow/Undo/<End point>: (Press spacebar or Enter.)

Command:

At the : prompt, the spacebar tells progeCAD to repeat the previous command:

Command: (Press spacebar or Enter.)

LINE Start of line:

Esc

Pressing the Esc key means “cancel.” You press it to get out of commands and to cancel grips.

Sometimes you have to press Esc two or three times to get out of deeply nested commands,
like PEdit. It is also the equivalent of clicking the Cancel button in dialog boxes.

Cursor Keys

The keys found on the keypad control panning. Panning moves the drawing inside the win-
dow; it is most useful when zoomed in close. Press the cursor keys (up, down, left, right) to
move the drawing a small amount.

To pan by an entire screenfull, hold down the Shift key while pressing the cursor keys.

Shortcut Keys

Shortcut keys let you carry out commands by pressing assigned keys on the keyboard. Some
users find this is much faster than selecting commands from menus, or typing entire command
words at the keyboard. Out-of-the-box, progeCAD defines the shortcut keystrokes shown by
the table below.
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Shortcut Meaning Command Executed

Function Keys
F1a Displays on-line help. HELP
F2a Displays Prompt History window. PMTHIST
F3a Toggles object snap mode. ESNAP T
F4a Toggles tablet mode. TABLET T
F5a Switches to next isoplane. ISOPLANE
F6a Toggles coordinate display. COORDINATE T
F7a Toggles display of the grid. GRID T
F8a Toggles ortho mode. ORTHOGONAL T
F9a Toggles snap mode. SNAP T
F10 Toggles status bar. STATBAR T

Control Keys
Ctrl+Aa Selects all objects in drawing. SELGRIPS ALL
Ctrl+Ca Copies selected objects to Clipboard. COPYCLIP
Ctrl+Da Toggles coordinate display. COORDINATE T
Ctrl+Ea Switches to next isoplane. ISOPLANE
Ctrl+Ha Backspaces the command line. ...
Ctrl+K Displays the previous command. ...
Ctrl+L Displays the next command. ...
Ctrl+Ma Same as pressing Enter. ...
Ctrl+Na Starts a new drawing. NEW
Ctrl+Oa Opens a drawing file. OPEN
Ctrl+Pa Prints the drawing. PRINT
Ctrl+Sa Saves the drawing. QSAVE
Ctrl+Ta Toggles tablet mode. TABLET T
Ctrl+Va Pastes from Clipboard into drawing. PASTECLIP
Ctrl+Xa Cuts selected objects to Clipboard. CUTCLIP
Ctrl+Ya Redoes the last undo. REDO
Ctrl+Za Undoes the last command. U

Other Keys
Dela Deletes selected objects. DELETE
Left Arrow Pans left. PAN L
Right Arrow Pans right. PAN R
Down Arrow Pans down. PAN D
Up Arrow Pans up. PAN U
Shift+Left Arrow Pans left a pagefull. PAN PGL
Shift+Right Arrow Pans right a pagefull. PAN PGR
Shift+Down Arrow Pans down a pagefull. PAN PGD
Shift+Up Arrow Pans up a pagefull. PAN PGU
Page Down Pans down a pagefull. PAN PGD
Page Up Pans up a pagefull. PAN PGU

a Shortcut key is the same as in AutoCAD.
 Shortcut key is standard among  Windows software.
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Mouse

Like other Windows software, progeCAD supports
the multi-button mouse as an input device. It does
not, however, allow you to change the meaning of
the buttons. The functions of mouse buttons vary,
depending on the current circumstance. Here is an
overview of their actions.

First (Left) Button

One click of the first (left) button always selects something —
whether a menu, a toolbar button, or an entity in the drawing.

You can click dfferent parts of the status bar for different effects
(see the section on the status bar, earlier.)

Double-clicking the left button performs additional tasks that de-
pend on the context. (Double-clicking means pressing the first button
twice quickly.) For instance, when you double-click:

• A single-line text entity, progeCAD displays the edit text dialog box.

• A multiline text, progeCAD displays the mline text dialog box.

• A dimension, progeCAD displays the dimension setting dialog box.

• A hatch pattern, progeCAD display the boundary hatch dialog box.

• Any other entity, progeCAD displays the Properties palette box with the properties of
the entity.

• progeCAD’s title bar, the window changes between maximized and windowed.

TIPS Through the mouse driver, I like to assign double-click to the middle button. That
saves wear and tear on my hand, because I press the middle button once to get the
double-click effect.

The MButtonPan system variable toggles behavior of the middle mouse button.
0 Operates as defined by the .mnu file.
1 Hold and drag to pan the drawing.

When you hold down the Ctrl key and press the first button, progeCAD goes into real-time 3D
motion (same as executing the RtRot command).

Second (Right) Button

One click on the second (right) button repeats the last command.

Right-click a toolbar, the status bar, the command bar, or a selected entity brings up a context-
sensitive shortcut menu.

Hold down the Shift key, and press the right button to display a shortcut menu of entity snap
modes.
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Hold down the Ctrl key, and hold down the right button for real-time rotation around the z
axis (RtRotZ).

Roller Wheel

Rolling the roller wheel on the mouse (if it has one) pans the drawing up and down. To pan left
or right and to zoom the drawing:

• Hold down the Shift+Ctrl keys together to pan left and right.

• Hold down the Ctrl or Shift keys to zoom the drawing in and out.

You can reverse the direction of the zoom relative to the roller wheel through the Options
command’s Reverse mouse wheel zoom direction option (found in the Display tab).

Tablet

progeCAD supports digitizing tablets of any size, and digitizer pucks with up to 16 buttons.
Digitizing tablets consist of two parts: the tablet and a mouse-like puck or
stylus. The tablet determines the precise location of the
puck.

Illustrated at right is a typical digi-
tizing tablet with 16-button puck.
As an alternative, a pencil-like sty-
lus can replace the puck.

Tablets were the preferred method of
interacting with CAD software in the
1980s and into the 1990s. When Win-
dows became popular in the mid-1990s,
the mouse took over, because it was much,
much cheaper (less than a hundred dollars
versus several hundred or more), took much,
much less desk space (a quarter-square foot
versus a square foot or more), and was much,
much easier to use (few options versus many options).

Tablets are still in use today, because they have features that mice lack:

• Pucks typically have 4, 12, or 16 buttons, whereas mice have fewer buttons.

• Tablets can select hundreds of commands in plain view on overlays; mice cannot.

• Tablets can trace paper drawings into CAD, because they employ absolute coordi-
nates; mice cannot, because they use relative coordinates.

Using Tablets with progeCAD

Before you can use a digitizer with progeCAD, you need to implement the following steps:

1. Attach the digitizing tablet to your computer.
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2. Configure the tablet with the WinTab driver.

3. Start progeCAD, and print a copy of the Digitizer progeCAD.dwg to fit your tablet’s
surface area. (See the figure of the tablet overlay on the next page.) The overlay
drawing is provided with progeCAD in the progeCAD 2009 folder.

4. Align the overlay with progeCAD’s Tablet command. See below.

5. For additional commands specific to tablets, load the tablet.lsp file, found in one of
folders included with the progeCAD installation. See below.

Commands Specific to Tablets

The Tablet command provides four options:

• Configure adapts the overlay to the tablet.

• Calibrate maps the paper drawing to the electronic drawing.

• ON uses the tablet for drafting.

• OFF uses the tablet for selecting commands from the overlay.

The tablet.lsp routine defines additional commands:

ButM (Button_Modify) changes the commands associated with the buttons on the puck. The
first (pick) and second (Enter) buttons cannot be changed.

TabM (Tablet_Modify)
changes the commands asso-
ciated with cells on the over-
lay.

TabI (Tablet_Import)
imports AutoCAD-style
tablet menu files (.mnu but
not .cui) into progeCAD.
Note that the tablet overlay
provided with AutoCAD is a
25 x 25 grid, while
progeCAD’s tablet menu is
26 x 26.

TabE (Tablet_Export)
exports tablet and button
settings to a file for use by
other computers.
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Coordinate Input

Now that you have a familiarity with progeCAD’s user interface and how to control the soft-
ware, the next items to understand are commands and methods of input.

To draft drawings, you use commands that create and modify entities. Commands also per-
form utility functions, such as saving and plotting drawings, and extracting information from
drawings. You learn how to use progeCAD’s commands during the tutorial sections of this
book.

Drawings consist of entities — lines, circles, arcs, text, dimensions, and so on — that you create
and manipulate through inputting commands and coordinates.

Vector Entities

All CAD software works with vector entities. “Vector” means that entities are defined by their
geometric features. You never draw the entities themselves; instead, you specify their features,
and then progeCAD draws the entities.

For instance, instead of drawing a line, you specify the two endpoints of the line:

Command: line
Start of line: (Pick the first end point.)
Angle/Length/<End point>:  (Pick the second end point.)

progeCAD then fills in the line segment between the two points.

1. Start of
Line

2. End Point

The same technique applies to other entities: progeCAD draws them after you specify their
geometric features. Here are a few more examples:

Circles — indicate the location of the center point and the radius; progeCAD draws the circle.

Command : circle

2Point/3Point/RADTT/TTT/Arc/Multiple/<Center of circle>: (Pick the center point.)

Diameter/<Radius>: (Specify the radius.)

1. Center of
Circle

2. Radius
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Arcs — indicate two endpoints and another point on the arc.

Command: arc

Center/<Start of arc>:

Angle/Center/Direction/End/Radius/<Second point>:

End point:

2. Another
Point

3. End Point

1. Start of Arc

Ellipses — indicate the location and length of two axes.

1. First End of
Ellipse Axis

3. Other
Axis

2. Second End
of Axis

Text — indicate the starting point of the text, and its height and angle.

1. Start Point

2. Height of
Text

Text
3. Rotation

Angle of Text

Dimension — indicate the location of two extension lines, and the dimension line and text.

1. Origin of First
Extension Line

1"

2. Origin of Second
Extension Line

3. Orientation of
Dimension Line

and Location of Text
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Alternative Entity Specification

While you can specify line segments by their two endpoints, this may not be the most conve-
nient method. For example, in drawing lines that represent walls, you often know their length,
but not where their end points are located.

progeCAD is flexible enough to provide multiple methods of defining entities. To draw walls,
for instance, you can specify the start point, the length, and the angle of lines. Again, you don’t
draw the line itself, but specify its parameters.

1. Start of
Line

2. Length of
Line

3. Angle of
Line

(The angle is measured from the x axis.)

The same is true for nearly all entities created by progeCAD: often, there are two or more ways
to draw each of them. The arc, for example, is the most flexible: there are more than a dozen
different ways to draw it.

Specifying Coordinates

To draw entities, you need to specify the coordinates (locations) of geometric features. progeCAD
provides two methods for specifying geometric features: the keyboard, and the mouse (cur-
sor). The keyboard is used to enter specific numbers, distances, and angles; the mouse is used
to show locations in the drawing.

Let’s take the Line command as an example.

Keyboard Input

The keyboard enters the names of commands and options, as well as to specify exact x, y coor-
dinates, distances, angles, and amounts.

Command: line

ENTER to use last point/Follow/<Start of line>: (Enter coordinate, or enter an option.)

At the “ENTER to use last point/Follow/<Start of line>” prompt you can do any of the follow-
ing at the keyboard:

• Press Enter to continue the line from the last point entered in the drawing.
ENTER to use last point/Follow/<Start of line>: (Press Enter.)
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• Press F and then Enter to specify the Follow option.
ENTER to use last point/Follow/<Start of line>: f (and then press Enter.)

• Type x, y coordinates, such as 1.2,3.4, and then press Enter.
ENTER to use last point/Follow/<Start of line>: 1.2,3.4 (and then press Enter.)

Angle/Length/<End point>: (Enter the next set of coordinates, or enter an option.)

Specifying Coordinates

Although entering x, y coordinates is very common among CAD users, it is not the only way;
progeCAD supports a variety methods of inputting coordinates.

• x,y — two-dimensional coordinates are used for 2D drafting. A comma ( , ) separates
the x and y values.

<Start of line>: 1,2

You can specify coordinates in imperial or metric units.

The z coordinate is fixed by the Elevation system variable and is usually set to 0.

• x,y,z — three-dimensional coordinates, also known as Cartesian coordinates.
<Start of line>: 1,2,3

• d<a — polar coordinates specify the distance and angle from the current point.
Think of being at the North Pole, and finding any point on the earth by a distance
(from the North Pole) and an angle (around the North Pole).

<Start of line>: 23<45

The angle bracket ( < ) prefix indicates the angle. You can specify the angle in de-
grees, radians, grads, or surveyor’s units.

• x,y<a — cylindrical coordinates  combine an x, y coordinate with an angle. Think of
being inside a pop can: the x measures the radius of the can, the y measures the
height of the can, and the a measures the angle around the can.

<Start of line>: 1,2<45

• d<a<A — spherical coordinates, the 3D version of polar coordinates. These specify a
distance and two angles. Think of being in the center of the Earth: the d measures the
distance from the center, the a measures the angle left-and-right around the equator
(x, y plane), while the A measures the angle up-and-down along the International
Data Line (y, z plane).

<Start of line>: 1<45<90

Remember that commas ( , ) separate distances, while brackets ( < ) signify angles. There are
additional symbols that modify coordinates:

• Negative distances and angles — dash ( - ). Negative angles are measured clock-
wise from the x axis, and are indicated by the dash prefix.

<Start of line>: -1,-2<-45

(Positive angles are measured counterclockwise from the x axis, although the direc-
tion can be reversed with the Units command, as can the location from which they
are measured.)
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• Relative coordinates — at ( @ ). Most coordinates are relative to the origin of the
drawing (0,0) and are called “absolute coordinates.” By placing the @ symbol in front
of the coordinate, you measure distances and angles relative to the last point picked
in the drawing.

<Start of line>: @1<45

End point: @7,5

• UCS in WCS coordinates — asterisk ( * ). When used in a user-defined coordinate
system, the * prefix forces coordinates to be interpreted relative to the world coordi-
nate system.

<Start of line>: *1,2,3

Point Filters

Finally, you can enter partial coordinates by using point filters. “Point” refers to the dot ( . )
that you first enter to alert progeCAD that you are entering a partial coordinate. “Filter” means
that the coordinates are being provided partially: first x, y, z, or some combination thereof, and
then the “missing” coordinate(s). The table below lists all possible combination of point filters:

Point Filter Specify... ...and then specify

.x Select x of Still need y, z

.y Select y of Still need x,z

.z Select z of Still need x,y

.xy Select x,y of Still need z

.xz Select x,z of Still need y

.yz Select x,y of Still need x

Well, not finally. Coordinate input can also be modified by entity snaps, as described later in
this chapter.

Direct Distance Entry

progeCAD has a “hidden” form of coordinate entry known as “direct distance entry.” Here you
move the cursor in a specific direction, and then type in the distance. This is an interactive
form of relative coordinates (@d<a).

Here’s how to use direct distance entry with the Line command:

Command: line

ENTER to use last point/Follow/<Start of line>: 1,2

Angle/Length/<End point>: (Move mouse/cursor in any direction, and then enter a distance.) 5

While you can move the cursor in any direction to indicate the angle, it’s more accurate to use
ortho mode or an esnap mode to assist you in specifying the angle.
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Units of Measurement

progeCAD accepts distance input in a variety of formats, including decimal (metric) and feet-
inches. Angles can be input in degrees, radians, grad, and surveyor’s units. Internally, how-
ever, progeCAD converts them to unitless scientific notation.

Note that you can enter distances and angles in any units format, even when it is different from
that displayed by the status bar. You can change the display of units at any time by right-
clicking the coordinate display on the status line.

Mouse Input

You can use the cursor to show progeCAD locations in drawings; the mouse (or digitizer) con-
trols the cursor. The problem with using the mouse is that it is not particularly accurate by
itself. You would find it difficult to draw, for example, a 31.01"-diameter circle using just the
mouse.

For this reason, progeCAD provides several aids for more accurately drawing with the mouse
and cursor.

Status Bar shows the distance (Length:) and angle (@ Angle:) from the last pick point. As
you draw, keep an eye on the status bar to see the size of the entity. (See figure below.) The
drawback is that watching the status bar is too slow for production use.

Snap specifies the cursor resolution. For instance, when you set the snap distance to 1", then
mouse movements in the drawing area are accurate to the nearest one inch. (The snap does not
affect the cursor outside of the drawing area.) Use the Snap command to specify the snap
distance.

The snap distance is invisible, however, so many users also turn on the grid to match the snap
distance. (In the figure above, the grid is just visible as an array of tiny dots.)

Entity Snap causes the cursor to snap to geometric features of entities, such as their end,
mid, and tangent points. This is useful when you want to draw from one geometric feature to
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another, such as drawing a line from the precise center of one circle to the precise tangency of
another, as illustrated below.

Use the Settings | Entity Snap | Entity Snap Settings command to toggle entity snap
modes. (Entity snaps are called “esnaps” for short.)

To further help you, progeCAD displays markers and tooltips that identify geometric features.
All of progeCAD’s entity snap features are listed later in this chapter.

Selecting Entities

When it comes to editing drawings, you need a way to select the entities to be edited. Selection
tells progeCAD which group of entities you need to modify. In most cases, you must use the
mouse to select entities; in a few cases, you use the keyboard instead.

There are two ways to select entities:

• Before starting an editing command (called “grips editing”).

• After starting the editing command (called “entity selection”).

You can use the method you find easier.

Grips Editing

Here’s how to perform grips editing: With no command active, select one or more entities by
picking them with the cursor. (To select all entities in a drawing, press Ctrl+A on the key-
board.)

Notice that the entities change to dashed lines and that green squares appear; this is how progeCAD
responds, letting you know which entity you picked.

The green squares are called “grips.” Move the cursor over a grip, and then drag the grip to
relocate it. This action changes (edits) the entity.
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Depending on the entity and which grip you move, you either change the entity’s size (stretch)
or move the entity’s position. Check the command line for a description of the grip action.
Examples include:

New end of line: (Changes length and angle of the line.)

New location for line: (Moves the line.)

New circle radius: (Changes the size of the circle.)

New basepoint for text: (Moves the text.)

To erase selected entities, press Del on the keyboard.

To see a list of additional editing commands, press the mouse’s right but-
ton. The resulting shortcut menu is illustrated at left, and lists the names
of dozens of editing commands that operate on selected entities. For ex-
ample, selecting Print from the menu plots only the selected entities.

To change the size and color of grips, use the Settings | Drawing Set-
tings | Display | Grips command.

Multiple Entity Selection

You select a single entity by picking it with the cursor. Ensure part of the
entity is within the cursor’s pickbox . To select additional entities, keep

picking them.

After a while, picking entities one-by-one becomes tedious, and so progeCAD provides ways to
pick groups of entities. One method is the selection rectangle. It selects entities within an area
specified by a rectangle, which is created like this:

1. Pick a blank point in the drawing (away from any entities).

2.  Form a rectangle by moving the cursor to the left or to the right.

• Moving the cursor right forms a windowed selection. progeCAD selects all
entities that fall entirely within the selection rectangle. Entities crossing the rectangle
and outside the rectangle are ignored.

1. Pick a point
away from any

entities.

Window Selection icon

2. Move
cursor to the

right.

Notice that progeCAD displays an iconic cursor to remind you of the type of selection rectangle
you are creating. For windowed selections, the cursor shows a circle entirely within a rect-
angle.
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• Moving the cursor to the left forms a crossing selection. progeCAD selects all
entities within and crossing the selection rectangle.

1. Pick a point
away from any

entities.

Crossing Selection icon

2. Move
cursor to the

right.

For crossing selections, the cursor shows a circle crossing the rectangle.

Selection Set Modes

But there are more selection modes! Selection areas need not be rectangles; they can also be circles,
polygons, and fences. Typically, editing commands asks you to select objects, as follows:

Command:  copy

Select entities to copy: cp

At the “Select entities” prompt, you can pick entities one at a time with the
mouse, or enter one of the following options. You enter the highlighted letters
only, or pick an option from the prompt box.

Select Comments

Add to set Adds one or more entities to the selection set (can also
press +).
Crossing circle Selects entities contained within or crossing the

boundary of a circular selection area.
Crossing polygon Selects entities contained within or crossing the

boundary of a polygon selection area.
Crossing window Selects entities contained within or crossing the

boundary of a rectangular selection area.
Fence Selects entities crossing a line or line segments.
Last entity in drawing Selects the entity most recently added to the

drawing.
Outside circle Selects entities falling completely outside a circular

selection area.
Outside polygon Selects entities falling completely outside a polygon

selection area.
Outside window Selects entities falling completely outside a

rectangular selection window.
Previous selection Selects entities included in the previous selection set.
Select all entities Selects all entities in the current drawing (Ctrl+A).
Subtract from set Removes one or more entities from the selection set ( - ).
Window inside Selects entities contained entirely within a rectangular

selection window.
Window circle Selects entities contained entirely within a circular selection window.
Window polygon Selects entities contained entirely within a polygon selection window.
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The list above contains selection modes lthat are best for selecting entities based their location
in the drawing.

A second method is to select them by their properties. Notice the Select by
Properties option in the prompt box above. The options are:

Color — selects all entities of the specified color.

Layer — selects all entities residing on the specified layer.

Linetype — selects all entities of the specified linetype.

Thickness — selects all entities of the specified thickness.

Width — selects all entities of the specified width.

Of the other options — Name, Type, and Value — their purpose is not documented, but I
suspect they allow programmers to select entities based on their internal name, entity type,
and property value.

Add to set and Subtract from set allow you to add more entities based on their properties.

The Location option returns you to the previous cursor menu. Selection Methods displays
the Drawing Settings dialog box. Cancel cancels the editing command in progress.

TIP You can mix keyboard and mouse entries. For instance, the prompts below show a
line drawn using point filters, esnap modes, mouse/cursor picks, and relative coordinates:

Command: line
ENTER to use last point/Follow/<Start of line>: .xy
Select x,y of: mid
of (Pick an entity with the mouse/cursor.)
Still need z: 3
Angle/Length/<End point>: @1<-45
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C • H • A • P • T • E • R 3

123+ Tips

the 123+ tips listed in this chapter are included in the icad.tip and icad.chm files that ac-
company progeCAD. Some have been updated or edited for clarity.

User Interface

1. You can right-click different areas on the
screen to bring up different cursor menus. Try
doing this on the status bar at the bottom of
the window.

Command Help

2. You can press F1 at any time to display
progeCAD Help. If you are using a command,
pressing F1 displays help for that command.

progeCAD provides:

• Online user’s guide.

• Online Help, which gives details about
commands, tools, aliases, and system
variables.

• Online developer references for
programmers.

3. You can learn about any command on menus
by highlighting the item, and then reading the
text in the status bar at the bottom of the main
window.

Screen

4. You can change the color of your screen
background: from the Tools menu, choose
Options, and then click the Display tab.
Under Graphics Screen Color, click Color,
and then choose the background color you
want.

5. You can maximize the drawing area on the
screen by hiding items you do not need at the
moment: toolbars, command bar, scroll bars,
and status bar. To hide or show elements of
the user interface, select or clear the item that
you want to hide or show in the View menu’s
Display submenu.
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6. You can display a reference grid, and snap
to regularly spaced points on the screen. To
see these options, go to the Tools menu,
choose Drawing Settings, and then click the
Coordinate Input tab. Choose the Snap
and Grid option.

7. The drawing crosshairs use a different color
for each axis. To select the colors you want, go
to the Tools menu and choose Options, then
click the Crosshairs tab.

8. You can show a cursor menu of commands
to modify specific entities. Select an entity, and
then right-click to see the cursor menu.

Command Bar

9. If you are accustomed to using the command
line in other CAD packages, such as AutoCAD,
you can type the same commands and use the
same options in progeCAD — even when you
do not see them on the screen. Simply type the
commands, and then watch the status bar.

When the command bar is not displayed, you
can see each step of an active command in the
status bar.

10. If you prefer to hide the command bar for
more screen space, double-click the status bar.

11. You can specify any word or symbol for that
progeCAD to indicate it is ready for your com-
mands, such as ‘Ready’ or ‘OK’. To change the
text appears in the command bar, enter
CmdLnText, and then enter the new word or
symbol.

12. You can dock the command bar at the top
or bottom of the progeCAD window or float it
anywhere you want.

13. You can change the number of lines dis-
played by the docked command bar by drag-
ging the separator line.

You can resize the floating command bar: drag
it to the middle of the window, change the size,
and position it where you want. To prevent the
command bar from docking, press and hold
the Ctrl key as you move it.

14. You can quickly hide and show the com-
mand bar by double-clicking in the text area
on the left side of the status bar.

15. You can display entity information in the
Prompt History window by typing List. Fol-
low the prompts to choose how you want in-
formation displayed.

16. progeCAD automatically tracks your com-
mand history. The default number of recorded
lines is 256, but you can change the number to
between 1 and 400. From the Tools menu,
choose Options, then click the Display tab.
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Enter the number of lines you want to track
next to Command lines to track.

17. Many commands can be “nested.” To start
a second command while one is in progress,
type an apostrophe ( ' ), and then enter the sec-
ond command. While the nested command is
active, an angle bracket ( > ) is displayed in
the command prompt.

Prompt Box

18. After you select a command, a prompt box
displays options. You can use the mouse to
select command options from the prompt
boxes.

19. You can turn the prompt boxes on and off.
From the Tools menu, choose Options, click
the Display tab, and then change the check
box for Display Prompt Boxes.

20. You specify command options by typing
the capital letter(s) shown in the command
bar. For example, to choose the Length op-
tion in the Line command, simply type L at
that prompt.

21. To change where prompt boxes appear on
the screen, move one to a different location.
Future prompt boxes will display in the new
position.

Menus

22. You can set progeCAD to show the tools
and menu items appropriate for your experi-
ence level. From the Tools menu, choose Op-
tions, click the General tab, and choose Be-
ginner, Intermediate, or Advanced from
the Experience Level droplist.

23. On menus, a check mark indicates that the
setting is in use.

24. You can save your arrangements of menus
(export) and you can read menus from
AutoCAD (import). To export and import
menus, go to the Tools menu, choose Cus-
tomize, and then click the Menus tab.

25. You can replace all your menus with new
sets or append a few new ones to existing
menus. Click the Append To Current Menu
check box, as appropriate.

Dialog Boxes

26. You can close dialog boxes by pressing the
Esc key.

Toolbars

27. You can move the toolbars and the com-
mand bar to any place on the screen by drag-
ging them away from the edge of the window.

28. You can make the tool icons larger to help
you recognize them more easily. To change to
large toolbars, go to the View menu and
choose Toolbars, and then select the Large
Buttons check box.

29. You can remove from your toolbars tools
that you rarely use. Hold down the Shift key
and drag the tool away from the toolbar. For
more toolbar customization options or to re-
place tools you have removed, go to the Tools
menu and then choose Customize.

30. Several toolbars include flyout toolbars
with related commands and options. Flyout
toolbars are indicated by a small, black triangle
in the lower right corner of the tool.
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31. You can display as many or as few of the
toolbars as you want. From the View menu,
choose Toolbars, and then click the check box
for the toolbars that you want to display.

32. To hide a toolbar, drag it away from the
edge of the window, and then click the X but-
ton.

33. You can display a cursor (shortcut) menu
of available toolbars by right-clicking any
toolbar.

Status Bar

34. You can change the units display method
by right-clicking the coordinates display in the
status bar. Choose a different set of units from
the cursor menu.

Dynamic Pan and Zoom

35. progeCAD provides dynamic pan and zoom
using the mouse:

• To pan dynamically, press
Ctrl+Shift and hold down the right
mouse button.

• To zoom dynamically, press
Ctrl+Shift and hold down the left
mouse button.

To stop panning or zooming, release the mouse
button.

36. You can pan horizontally and vertically us-
ing the scroll bars at the side and bottom of
the drawing window. The size of the scroll

boxes are proportional to the view size.

Drafting and Drawing

Creating Drawings

37. You can use any drawing you want as the
basis for future drawings; these are called
“templates.” Template can include borders,
title blocks, and your preferred settings.

38. To use the New Drawing wizard, go to the
File menu and select New.

To open a new drawing without the assistance
of the wizard, from the Standard toolbar, se-
lect New.

39. You can open multiple windows to view
your drawing in different ways at the same
time. Right-click a drawing tab, and then
choose New Window.

40. You can include progeCAD drawings in the
documents of other programs. Simply drag and
drop the progeCAD drawing onto the docu-
ment. To edit the drawing in-place, double-
click it.

41. Similarly, you can drag and drop docu-
ments from other programs into progeCAD
drawings. For example, you could add a Word
document or a Visio diagram.

Information from the Drawing

42. You can find distances, areas, and exact lo-
cations in your drawings using the tools on the
Inquiry toolbar.
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43. You can create drawings in any way con-
venient for you in model space (the default),
and then arrange it for printing in paper space.

Blocks

44. You can create blocks, which are combi-
nations of entities that you use repeatedly.

To create a block, draw something you want
to reuse. Go to the Draw menu, choose
Block, and then choose Make.

To use the block later, go to the Insert menu
and choose Insert Block, or select the block
in the progeCAD Explorer.

45. With the progeCAD Explorer, you can view
blocks before inserting them.

46. You can associate text (called “attributes”)
with your blocks when you define them. Each
time you insert the block, you enter the appro-
priate information for that instance, such as a
part number, price, or supplier.

47. The array of blocks inserted with the
DdInsert command’s Multiple Blocks op-
tion is itself a block.

48. You can insert blocks and hatches in ex-
ploded form so that they are placed as pieces
rather than as a single unit. To do this, pre-
cede the name of the block or hatch pattern
with an asterisk ( * ).

49. You can use block attribute information in
an external drawing database. To export data

from the attributes in your drawings, go to the
Tools menu and choose Extract Attributes.

50. You cannot explode blocks inserted with
the MInsert and Xref commands.

progeCAD Explorer

51. You can see and work with the layers,
linetypes, styles, and other elements of exter-
nal references (xrefs) in the progeCAD Ex-
plorer.

52. You can save a block to a separate drawing
file using the progeCAD Explorer. Select the
block to save in its own drawing, and then click
the Save Block tool.

53. In progeCAD Explorer, you can double-
click the name of an item to make it current.
For example, to set a layer as the current layer,
double-click the name of the layer.

54. You can copy anything in the progeCAD
Explorer from one drawing to another: layers,
linetypes, saved views, blocks, text styles, di-
mension styles, and user coordinate systems.

55. You can use the progeCAD Explorer to eas-
ily change your layers, linetypes, styles, coor-
dinate systems, views, blocks, and dimension
styles. From the Tools menu, choose
progeCAD Explorer. Right-click the item
you want to edit, and then choose Properties.

You can alter layer, color, linetype, and linetype
scale.
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56. To make information from external refer-
ences available in the progeCAD Explorer, re-
load the drawing using the External Reference
(XRef) command.

57. You can rename elements from within the
progeCAD Explorer.

Other Drafting Tips

58. You can constrain lines and other entities
to draw only vertically and horizontally. For
just a few lines, hold the Shift key down while
you draw. To work this way continually, click
the ORTHO button on the status bar.

59. You can place point entities or blocks at
regular intervals along an entity using the Di-
vide and Measure tools:

Divide marks the entity in a specified
number of segments.

Measure marks off segments of
specified length. Neither command
alters the original entity.

60. You can draw quickly and precisely by
snapping to points on existing entities, such
as the end of a line or center of a circle. To set
entity snaps and see their current states, use
the Entity Snaps toolbar.

61. Polylines are sets of line and arc segments
handled as a single entity. Polylines can have
qualities that ordinary lines cannot, such as
width. When you move a vertex of a polyline,
both adjacent segments move with it.

62. When drawing lines, arcs, and polylines,
you can use the Follow option to continue
drawing from the last point and in the same
direction.

63. A donut is a planar, circular entity that has
an inside and outside diameter, like a flat
washer. You can draw donuts by using either
the two-point, three-point, or tangent-radius
method.

64. When you create planar entities using the
Solid command (aka Plane), you can con-
strain the planes to squares, rectangles, and
equilateral triangles.

65. You can use the Rectangle command to
draw squares and rectangles at a specific angle.
You can also adjust the width of them.

66. Your drawing may contain blocks that you
no longer need. Use the Purge command to
clean out unused blocks.

67. You can use the Center entity snap to snap
to the center of any two-dimensional closed
polyline, including rectangles and polygons.

68. You can bisect lines, arcs, and polylines us-
ing the Ray command. Start the Ray com-
mand, select Bisect, and then select Entity.

69. You can create regular polygons such as
hexagons and pentagons using the Polygon
command. All polygons are created as closed
polylines.

70. Polylines have a direction. To reverse the
direction of a polyline, first select it, and then
from the Modify menu, choose Edit
Polyline, and then Reverse Direction.
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71. You can snap lines perpendicular or tan-
gent to existing entities. Simply select a point
on the entity, and progeCAD adjusts the point
so that the line you are drawing is perpendicu-
lar or tangent to the entity.

72. A drawing can contain a reference to an-
other drawing, called an “external reference,”
or xref. The display of the referenced drawing
updates each time the reference is reloaded
using the XRef command.

73. When drawing lines, you can specify the
angle or length first, and then adjust the other
parameter dynamically.

74. You can use the PEdit command to specify
whether linetypes are broken or continuous
across vertices. Select the entity, and from the
Modify menu, choose Edit Polyline, and
then choose Linetype Mode. From the
prompt box, choose Continuous On or Con-
tinuous Off.

75. You can join colinear lines and coplanar
arcs with the same center and radius using the
Join command.

76. If you are drawing in isometric planes and
the grid is on, the x axis grid spacing is auto-
matically adjusted to isometrically match the
y axis spacing.

77. To draw isometrically, from the Tools
menu, choose Drawing Settings. Click the
Coordinate Input tab, and in the Change
Settings For list, click Isometric Snap and
Grid.

78. When using the Polygon command, you
can change the line width of the polygon you
are drawing.

79. To close an arc, use the Arc option of the
Circle command.

80. You can set points to be displayed in any
of twenty different ways. From the Tools
menu, choose Drawing Settings, and then

click the Entity Creation tab. Change the
settings for points by choosing one of the dis-
played options.

81. You can make a layer current by selecting
an entity on that layer. From the Tools menu,
choose Set Layer By Entity. Select an entity
on the layer you want to make current.

82. The length of the last entity you specified
or drew before starting the Lengthen (aka
EditLen) command is displayed by the prompt.

83. To create a planar face with the Face com-
mand, position all points on the same plane.

84. When Fill is turned off, the program dis-
plays and plots filled drawing entities faster
on slower computers.

85. For more accurate tracking during the
Sketch (aka Freehand) command, specify
shorter segments. Doing this results in a
smoother freehand entity, but creates larger
drawing sizes.

86. Displaying objects as icons with the
InsertObj command is faster than display-
ing the objects themselves.

87. Right-clicking an object opens a menu of
commands you can use on the object.

88. To create a polygon mesh with the
RuleSurf command, select each entity at the
same end. To create a self-intersecting poly-
gon mesh, select each entity at opposite ends.

89. Entities that you preselect with the Select
command are placed into a previous selection
set. When you perform many progeCAD com-
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mands (such as Delete or Change), you can
choose Previous selection set.

90. The current layer name is displayed in the
Properties toolbar.

91. To continue text under the previous line,
start the Text command and then press En-
ter until it displays the ‘Text:’ prompt.

92. progeCAD provides three visual indicators
to show that an entity snap is turned on:

When any entity snap is turned on,
ESNAP appears in black on the status
line.

When the Entity Snaps toolbar is
displayed, the entity snap tool that is
on is displayed as recessed.

When drawing or editing, the cursor
displays icons indicating the current
entity snap.

93. The Flatten command allows you to move
sets of entities, such as three-dimensional
walls, to a new elevation. When you are in plan
view, this command has no visible effect.

94. When the grid spacing is 0, it is not turned
off. Rather, the grid is set to the same spacing
as the snap spacing.

95. Use the Style option of the Snap com-
mand to turn on isometric drawing mode. In
addition, turn on the grid to help you visualize
the isometric grid.

Draw isometric circles with the Isocircle op-
tion of the Ellipse command.

96. When the system variable LimCheck is
turned on, you are restricted from drawing en-
tities outside the rectangular area you define
when you use the Limits command:

To draw entities outside the drawing
limits, set the LimCheck variable to 0.

To restrict drawing to within the
drawing limits, set the LimCheck
variable to 1.

97. The Line command’s Follow option uses
the angle stored in the LastAngle system vari-
able.

98. Choosing the Batch option of the Purge
command purges all unused elements without
asking you to confirm each element.

99. There are two ways to chamfer entities: you
can specify the distances from the intersection
point of each entity, or you can specify the dis-
tance on the first entity and an angle for the
chamfer line.

The distance you specify for the Chamfer
command’s first chamfer distance is saved in
the ChamferA system variable. The distance
you specify for the second chamfer distance is
saved in the ChamferB system variable.

To draw rectangles with the Rectangle com-
mand with chamfered corners, set the cham-
fer distances with the Chamfer option.

100. The distance you specify for the Rect-
angle command’s fillet distance is used for all
subsequent rectangles you draw. To change the
fillet distance, choose Fillet again and enter a
new value.

101. progeCAD supports the standard Win-
dows ANSI character set. To enter an extended
character, press Alt plus the numeric equiva-
lent (be sure that Num Lock is turned on) on
the keyboard’s numeric keypad. For a list of
the ANSI characters supported and their nu-
meric equivalents, refer to the Character Map
utility included with Windows.

102. You cannot use the View command’s
Save and Restore options as a transparent
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command when you are in paper space, dur-
ing Viewpoint or DView, or when zooming
or panning the display.

Editing

103. You can apply the qualities of one entity,
including color, linetype, and thickness, di-
rectly to other entities. From the Standard
toolbar, choose the Copy Entity Formatting
tool.

104. If you press Enter to select all entities in
the drawing as boundaries during the Trim
command, the program immediately contin-
ues to the next prompt.

105. You can simultaneously modify the prop-
erties of any number of selected entities. From
the Modify menu, choose Properties, and
then make the changes that you want.

106. You cannot edit the length of a polyline
that has been splined or fitted.

107. To edit the attributes of more than one
block at a time, use the Tools | Edit At-
tribute command.

108. You can use the Explode command to
alter various properties of entities as they are
broken into their component pieces.

109. You can use the Copy and Move com-
mands between drawings. When prompted for
a displacement point, specify a point in the des-
tination drawing.

110. You can fillet or chamfer selected vertices
of a polyline. Select two points on the polyline,
and all vertices between the selected points will
be modified. The operation goes in the direc-
tion of the polyline, so on closed polylines the
order of point selection determines which ver-
tices are modified.

111. You can use the system variable MirrText
to specify whether you want text mirrored dur-
ing the Mirror command:

To change the text direction, set the
MirrText variable to 1.

To retain the text direction, set the
MirrText variable to 0.

112. The Fillet command fillets closed
polylines by two different methods, depend-
ing on how the polylines were closed:

If you used the Close option of the
Polyline command, then all vertices
are filleted.

If you specified the endpoint of the
last segment, the last vertex is not
filleted, even if you used entity snap
to place the endpoint.

113. You can change entities to make them the
same length. From the Modify menu, choose
Edit Length. From the prompt box, choose
Total. Enter the length you want, and then
select the entities you want to lengthen.

114. You can alter the way the Change com-
mand affects rays and infinite lines. First se-
lect the entities to change, and then use the
Change command. Choose the Entities op-
tion to select No Change, Change Angles,
or Change Definition Points.

115. You can fillet a polyline, even if the inter-
section lies on a curved segment of the polyline.

116. You can change the hatching style for
nested regions to hatch either the outer and
inner regions, only the outer region, or all re-
gions. To set this variable, from the Tools
menu, choose Drawing Settings. Click the
Entity Creation tab, and in the Change
Settings For list, click Hatches.

117. You can erase the ends of sketches you are
drawing using Sketch. In the prompt box, se-
lect Delete On and move the cursor to erase.
To continue drawing, go back to the prompt
box and select Delete Off.

118. You can straighten polyline segments.
From the Modify menu, choose Edit
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Polyline. Select the entity, and then from the
prompt box, choose Edit Vertices. To select
the vertex, choose Next Vertex or Previous
Vertex, and then choose Straighten.

119. You can also change the included angle of
individual polyline segments. From the
Modify menu, choose Edit Polyline. Select
the entity, and then from the prompt box,
choose Edit Vertices. Choose Next Vertex
or Previous Vertex to select the vertex, and
then choose Angle.

120. You can explode traces, planes, and 3D
faces into their component lines. From the
Modify menu, choose Explode, and then
select the entities to explode.

121. When editing a polyline, you can taper the
width of the polyline continuously from start
to end. All vertex widths are automatically cal-
culated. From the Modify menu, choose Edit
Polyline, and then choose Taper.

122. You can easily convert arcs into circles.
From the Draw menu, choose Circle. From
the prompt box, choose Turn Arc Into
Circle.

Selection Sets

123. You can create a selection set and add en-
tities to it by their properties, such as layer or
color. Type Select, and from the prompt box,
choose Select By Properties.

124. After you create a selection set for one
command, you can easily recall that same se-
lection set for the next command you use by
choosing Previous Selection or by typing P
at the ‘Select Entities’ prompt.

125. You can adjust the size of the cursor used
for selecting entities. To set the size, go to the
Tools menu and choose Drawing Settings.
Click the Coordinate Input tab, and in the
Change Settings For list, choose Entity
Selection.

126. You can select several entities and change
their properties simultaneously. Select the
entities, and then right-click to see the cursor
menu. Select Properties, and make the glo-
bal changes.

UCS and WCS

127. The World Coordinate System (WCS) is
the default and the foundation on which user
coordinate systems are built. You can define
your own coordinate systems to make specify-
ing points and reading entity information
easier: from the Tools menu, choose User
Coordinate Systems, or create a new UCS
in the progeCAD Explorer. You return to the
WCS at any time by entering UCS in the com-
mand bar and choosing the World option.

128. Defining a user coordinate system (UCS)
can involve anything from simply shifting the
origin (0,0,0) to reorienting the axis so you can
easily draw in a different plane. You can cre-
ate as many user coordinate systems as you
want, and then save and recall them as you
need them.

129. Coordinates displayed in the status bar
and through the List and Distance com-
mands are relative to the current coordinate
system, either a user coordinate system (UCS)
or the World Coordinate System (WCS).

130. You can use the Plan command to change
to the plan view for any user coordinate sys-
tem or the World Coordinate System. From the
View menu, choose Plan View.

Dimension Settings

131. There are hundreds of settings that affect
how dimensions are created and displayed. To
see how they work and to customize them, go
to the Tools menu and choose Dimension
Settings.
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Customizing and Programming

132. You can open a drawing, run a script, or
load a LISP program by dragging and drop-
ping the file on progeCAD.

Command Aliases

133. You can make aliases for any of the
progeCAD commands. For example, you may
prefer “guideline” over “infline.” To make an
alias, go to the Tools menu, select Custom-
ize, and then click the Aliases tab.

134. You can assign commands to any key on
your keyboard or change existing key assign-
ments. You can also use key combinations with
Shift, Alt, and Ctrl. From the Tools menu,
choose Customize, and then click the Key-
board tab.

Recording Scripts

135. You can record command bar entries and
mouse coordinate selections in a script file,
which you can play back later. Doing this is
handy for avoiding repetitive work. Scripts are
saved in files with the .scr extension. From the
Tools menu, choose Record Script.

When you have finished, choose Stop Re-
cording.

Customizing Menus

136. You can customize your menus, toolbars,
keyboard shortcuts, and aliases. From the
Tools menu, choose Customize, and then
make the changes you want.

To set them back to their original state, click
Reset.

LISP

137. LISP is an interpreted programming lan-
guage invented by John McCarthy in 1958 for
work in artificial intelligence. You can write
your own LISP programs for progeCAD to au-
tomate frequent or complex operations. See
the online progeCAD Developer Reference for
complete information.

You can enter a LISP expression in response
to a request from a LISP function for input.
For example:

Enter circumference: (* 2 3.14 5)

138. The Multiple command is not valid in
LISP. See the Developer Reference section of
Help for more information.

139. Any LISP function placed in the icad.lsp
file is automatically loaded each time you start
progeCAD.
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Other

140. You can email a drawing to someone else
while working in progeCAD. From the File
menu, choose Send Mail. Your current draw-
ing is sent as an attachment.

You cannot email drawing files using this com-
mand if your system is configured with a
Browser-based email system, such as any ver-
sion of Microsoft’s Internet Explorer older
than version 4.0. However, Internet Explorer
version 4.0 and higher includes Microsoft’s Ex-
change, making it compatible with the File |
Send Mail command.

Alternatively, use the eTransmit command
to package the drawing with all support files.

141. progeCAD automatically saves your work
at a time interval you specify. From the Tools
menu, choose Options, click the General tab,
and then set the Autosave time.
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progeCAD for
AutoCAD Users

autoCAD is popular, but it also continues to become more expensive. Over time, its price
has quadrupled from the original $1,000 price tag to today’s $4,000. And so we have a soft-
ware package, progeCAD, that provides some 90% of AutoCAD’s drafting capabilities for 15%
of the cost. (For many 2D drafters, the missing 10% are inconsequential.)

This chapter describes the similarities and the differences between progeCAD and AutoCAD.
Terminology between the two is virtually identical; the only significant difference is progeCAD’s
use of the words “esnaps” or “entity snaps” in place of AutoCAD’s “osnaps” and “object snaps.”
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AutoCAD 2009 (Legacy Workspace)

AutoCAD and progeCAD Share Similarities
Many aspects of AutoCAD and progeCAD are the same. The list includes commands, system
variables, the user interface, status bar, toolbars, menus, fonts, linetypes, hatch patterns, tool-
bar and menu macros, scripts, LISP and VBA programming, .dwg, .dxf, and .dwf file formats,
3D and ACIS, paper space and layouts, and UCSs.

For example, commands and system variables are entered identically. To draw a line in
progeCAD, you enter the Line command and press Enter — or enter the l alias, or click the
Line button on the Draw 2D toolbar — just as in AutoCAD.

Some aspects differ, and that’s what this chapter concentrates on.
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progeCAD 2009

User Interface Comparison

The user interfaces of both CAD programs are similar, and recent changes in progeCAD make
it look and act even more similarly to AutoCAD.

Comparison of Menu Bars

AutoCAD and progeCAD’s menu bars are similar, but not identical — as illustrated below.

Menu bar from AutoCAD 2009:

Menu bar from progeCAD 2009:

The menu bars, menus, and macros of both programs can be modified (customized). Thus, it is
possible to create a progeCAD menu that looks identical to that of AutoCAD.



60 part i: introducing progeCAD 6

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Comparison of Toolbars

The buttons on AutoCAD and progeCAD’s toolbars use icons that differ from each other. In the
figure below, compare the difference in New icon (top row, far left) between the two.

Some of the toolbars in AutoCAD 2009:

Some of the toolbars in progeCAD 2009:

The two programs sometimes place buttons in different toolbar groupings. The toolbars, icons,
and related macros of both programs can be customized. As with menus, it would be possible
to create exactly AutoCAD-like toolbars for progeCAD.

Comparison of Status Bars

AutoCAD and progeCAD’s status bars show similar information, although AutoCAD’s has many
more buttons. progeCAD displays help text together with the other information fields; in con-
trast, AutoCAD replaces the entire status bar with help text.

Status bar for AutoCAD 2009:

Status bar for progeCAD 2009:

Both use a single-click to change toggles (progeCAD no longer requires a double-click).
AutoCAD’s buttons turn blue when turned on; progeCAD’s look depressed.

progeCAD does not have AutoCAD’s “tray” found at the far right end of the status bar, but it
has a greater number of useful options for establishing the information displayed by the bar.

AutoCAD 2009 status bar options:            progeCAD 2009 status bar options:

Both programs can customize the status bar with the Diesel macro language.
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Comparison of Other User Interface Elements

AutoCAD and progeCAD share similar user interface elements with differences:

• Cursor — the size of the cursor can be changed in both programs. Both can display a
different color for each axes, something AutoCAD cloned from progeCAD.  The
cursors of both programs show the pickbox (entity selection area) and the aperture
(object snap search area).

AutoCAD 2009’s cursor and UCS icon:

progeCAD 2009’s cursor and UCS icon:

• UCS — both programs optionally display the UCS (user-defined coordinate system)
icon in the left hand corner. AutoCAD’s can be modified for style, size, and thickness;
progeCAD’s can be modified for the color of each axis.

• Scroll Bars — both programs optionally display scroll bars for panning the drawing
view.

• Layout Tabs — both programs have Model and Layout tabs at the bottom of the
drawing area. AutoCAD’s tabs have more options than do progeCAD’s; right-click a
tab to see either shortcut menu.

AutoCAD 2005 layout options: progeCAD 2009 layout tab options:
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Comparison of Right-click Menus

AutoCAD and progeCAD always show cursor (shortcut) menus when you press the right mouse
button, but sometimes they show different content from each other. It’s not possible to show
all of the menus here, so I’ll illustrates the differences with just a few examples.

Hold down the Shift key and then right-click. The resulting shortcut menu lists entity (object)
snap settings. The menus are similar, but different:

                  AutoCAD 2009 shortcut menu:                  progeCAD 2009 shortcut menu:

Similarly, right-clicking a selected entity shows shortcut menus with some editing commands
the same, and some different:

     AutoCAD 2009 shortcut menu: progeCAD 2009 shortcut menu:
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Commands and System Variables

This section describes some of the differences of commands and system variables between
AutoCAD and progeCAD. Because both programs are constantly updated, these lists are not
exhaustive.

Command Name Differences

Some progeCAD commands have names that differ from those in AutoCAD. Square brackets
indicate equivalent keystrokes, such as [Ctrl] and [F6].

progeCAD AutoCAD Action in progeCAD differing from AutoCAD

Cal Cal Displays Windows calculator.
Coordinate [Ctrl]+[D] or [F6] Changes display of coordinates on status line.
Customize Toolbar Displays Customize dialog box.

ESnap -Osnap Sets entity snaps at the command bar.
ExpBlocks AdCenter or Insert Displays Explorer - Blocks.
ExpDimstyles AdCenter or DimStyle Displays Explorer - Dimension Styles.
ExpFonts AdCenter or Style Displays Explorer - Styles.
ExpLayers AdCenter or Layer Displays Explorer - Layers.
Explorer AdCenter Displays Explorer.
ExpLTypes AdCenter or Linetype Displays Explorer - Linetypes.
ExpUcs DdUcs Displays Explorer - UCS.
ExpViews View Displays Explorer - Views.

NewWiz New Runs New Drawing wizard.

RtRot 3dOrbit Rotates view of entities.
RtRotX 3dOrbit Rotates view of entities about x-axis.
RtRotY 3dOrbit Rotates view of entities about y-axis.
RtRotZ 3dOrbit Rotates view of entities about z-axis.

SetESnap OSnap Displays Drawing Settings dialog box.
StopScript [Backspace] Stops running the script.

Additional progeCAD Commands

progeCAD includes additional commands not found in AutoCAD. Some of these include:

Command Action in progeCAD

CmdBar Positions the command window.
CopyEData Copies extended entity data from one entity to another.
DelEData Deletes extended entity data from an entity.
EditEData Edits extended entity data found in an entity.
Flatten Sets thickness to zero at user- specified elevation.
MoveEData Moves extended entity data from one entity to another.
QPrint Quickly prints the current viewport (window) with no options.
ReassocApp Re-associates extended entity data with an application.
RecScript Starts the Script Recorder.
TipOfDay Displays Tip of the Day dialog box.
SaveAll Saves all currently open drawings.
Scrollbar Toggles the scrollbars.
SelGrips Select objects to display grips.
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StatBar Toggles the status bar.
StopScript Stops recording the script.
VmlOut Exports drawings in VML format.

Additional progeCAD System variables

progeCAD includes additional system variables not found in AutoCAD. Some of these include:

Command Action in progeCAD

AutoMenuLoad Determines whether default menu or menu associated with drawing is loaded.

BaseFile Name of default prototype drawing used to create new drawings.

CmdLnText Specifies the command bar prompt.
ColorX Color of x axis in the cursor and UCS icon.
ColorY Color of y axis in the cursor and UCS icon.
ColorZ Color of z axis in the cursor and UCS icon.

ExplStBlk Column width of block settings in Explorer.
ExplStLay Column width of layer settings in Explorer.
ExplStLt Column width of linetype settings in Explorer..
ExplStTs Column width of text styles settings in Explorer.
ExplSstUcs Column width of UCS settings in Explorer.
ExplStVw Column width of named view settings in Explorer.

IcadVer Reports the progeCAD version number.

LastCmdPt Stores the last point entered relative to the current UCS.
LastPrompt Stores the last prompt string displayed by command bar.
LtSclWblk Specifies whether global linetype scale is applied to inserted blocks.

MacroRec Toggles macro recorder.
MacroTrace Toggles macro tracer.
MakeBak Renames drawing as .bak with each save.

NFileList Number of most recently used files in File menu.

ProgBar Toggles display of the progress bar.
PromptMenu Toggles display of the prompt menu.

SaveRoundtrip Determines whether unknown entities are saved R14 format.
ScrlHist Specifies number of command lines to track in command bar.
SrchPath Specifies the search path for support files.

TbColor Switches toolbar color between color and monochrome.
TbSize Switches toolbar size between small and large.
Tipofday Toggles Tip of the Day dialog box.

ViewAspect Aspect ratio of the view.

WndBtExp Specifies width of the list pane in Explorer.
WndLCmd Toggles command bar visibility.
WndLMain Toggles display of the main window.
WndLMdiW Controls display of MDI child window.
WndLStat Toggles display of the status bar.
WndLtExp Toggles display of the Explorer window.
WndLText Toggles display of the prompt history window.
WndPCmd Screen coordinates of the command bar when floating.
WndPMain Screen coordinates of drawing window position.
WndPPmenu Screen coordinates of the prompt menu.
WndPtExp Screen coordinates for Explorer window.
WndPText Screen coordinates for prompt history window.
WndSCmd Size of command bar, when floating.
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WndSMain Size of the drawing window.
WndStExp Size of the Explorer window.
WndSText Size of the prompt history window.

ZoomPercent Incremental zoom percentage.

Commands Enhanced in progeCAD

Some of progeCAD’s commands provide more options than in AutoCAD. Here is a selection of
them.

AutoCAD’s MSlide command saves the image in Autodesk’s proprietary SLD format. In
progeCAD, the command also saves the image in Microsoft’s WMF (windows meta file) or
EMF (enhanced meta file) formats.

AutoCAD’s Offset command copies to one side at a time. In progeCAD, the command’s
Bothsides option copies to both sides at once.

AutoCAD’s Solid command draws solid quadrilaterals and triangles. In progeCAD, the
command’s Rectangle option draws solid-filled rectangles; Plane Square draws solid-filled
squares; and Plane Triangle draws solid-filled equilateral triangles.

progeCAD’s Circle command’s Arc option converts arcs to circles. AutoCAD does this through its
Join command.

In progeCAD, the Line command’s Angle option specifies the angle, followed by a length;
similarly, the Length option specifies the length, followed by an angle.  AutoCAD can do this
only through direct distance entry.

progeCAD’s entity (object) snaps can be entered directly at the command prompt. AutoCAD’s
requires that its -OSnap command be employed.

progeCAD’s Select command has additional selection options not found in AutoCAD:

Select Meaning

CC Crossing Circle All entities within and crossing a circular area.
O Outside Window Selects all entities outside a rectangular window.
OC Outside Circle Selects all entities outside a circular area.
OP Outside Polygon Selects all entities outside a polygonal area.
PRO Properties Selects all entities with specific properties.
WC Window Circle Selects all entities within a circular area.

As well, the + and - keys can be used to add and remove objects from selection sets.

AutoCAD Commands Missing from progeCAD

Each release of AutoCAD adds more commands, some of which progeCAD also adds, but some
of these new ones are not added. In addition, there are two versions of progeCAD: Standard
and Professional; the Professional edition has commands not found in the Standard version.
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Reading and Writing DWG Files

progeCAD reads and writes drawings created by AutoCAD through to 2009. Because progeCAD
does not support everything in AutoCAD, some objects are difficult to handle. Tables, for in-
stance, are displayed but as anonymous blocks and cannot be edited in progeCAD.

The addition of ObjectARx to AutoCAD Release 13 enabled Autodesk and third-party develop-
ers to create “custom objects” that can be created and edited only when the associated ObjectARx
programming code is present. When the code is missing, then a proxy object is displayed in-
stead. Autodesk provides object enablers that provide sufficient code to edit custom objects.
progeCAD converts proxy entities into blocks using their exclusive proxy conversion technol-
ogy built into the software.

progeCAD-AutoCAD Dictionary

This brief progeCAD-AutoCAD dictionary explains some progeCAD jargon:

progeCAD Term AutoCAD Equivalent

command bar command prompt area

edit length lengthen
entity object
entity snap object snap
entity snap precision aperture
edata xdata

fixed attribute constant attribute
follow continue
freehand sketch

hidden attribute invisible attribute

infinite line XLine
insert draw

orthogonal ortho

parallel offset
plane solid (2D)
point snap node snap
predefined attribute preset attribute
prompt box context menu
prompt history window text screen

reference grid grid

snapshot slide

validate attribute verify attribute

Customizing and Programming progeCAD

progeCAD works with most of the support files used by AutoCAD, including .lin, .pat, .mnu,
.fmp, .unt, .dcl, .lsp,  .shx, and .sld files.

progeCAD mimics AutoCAD in writing menu and toolbar macros, scripts, DCL (dialog control
language), LISP routines, i-drop, and VBA applications (visual basic for applications).
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Unlike present-day AutoCAD, progeCAD can work with programs that use the SDS API (solu-
tions development system applications programming interface), called “ADS” in AutoCAD un-
til it was removed with Release 13.

AutoCAD’s rarely-used side-screen menu is not included in progeCAD; prompt menus replace
some of the functions provided by the side-screen menu.

progeCAD also works with Diesel.
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to help you learn progeCAD, this tutorial walks you through a
fictional condominium design project called “The Boardwalk on
18th Avenue.” For this project, you are to produce the floor plans
for one-bedroom condo units.

The design project goes through the following stages:

1. Draw the exterior walls; these enclose the unit.

2. Define the interior spaces; these include the living room, bedroom, and closets.

3. Determine the access points and views, such as doors and windows.

4. Specify the fixed amenities, such as bathroom fixtures, kitchen arrangement, and
fireplace. Also specify the non-fixed amenities, such as living room seating, dining
table, and bed.

5. Label important areas with text.

6. Add border and title block.

7. Apply dimensions to show sizes.

8. Create a printout of the floor plan drawing.

The following chapters describe how to work on the drawings for each stage using progeCAD.

C • H • A • P • T • E • R 5

Introducing the
Boardwalk
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About The Condominium Project

The Boardwalk on 18th Avenue is a low-rent, one-story condominium development consisting
entirely of one-bedroom apartments. (A condominium is an apartment or flat that is purchased,
and not rented or leased.) The development takes up half a city block, and so is surrounded on
three sides by streets.

Development on the site is limited by the city’s bylaws, which define the building lines and
parking requirements. No part of the structure can be beyond the building lines; a pair of units
are positioned in the illustration below. (P/L indicates the property lines.)

Each unit is the same: 32 feet deep by 24 feet wide (768 square feet). Inside the unit, the layout
is open plan, meaning the kitchen, dining room, and living room are open to one other, with no
full walls between.

Each unit consists of the following items:

• Kitchen.

• Dining room.

• Living room with fireplace.

• Three-piece bathroom with sink, toilet, and bathtub.

• Bedroom with closet and ensuite bathroom. (An ensuite has a sink and toilet, and is
accessed only from the bedroom.)

• Hallway with coat closet and laundry closet (stores the hot water tank).
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Residents access their units from an outside door or from the central hallway. Outside the
living room is a 10' x 14' concrete slab patio.

A rough sketch of the layout of a unit is illustrated below.

Every other unit is a mirror image of this one, so that similar facilities adjoin each other: bath-
rooms with their plumbing needs are adjacent; (quieter) bedrooms have common walls, as do
the (nosier) living rooms and kitchens.

As the drafter for this project, your task is to draw the 2D floor plan of one unit. You use layers
to segregate information, and blocks to place common objects, such as doors and chairs. You
must place dimensions to show the size of important parts of the drawing, and add text to
explain functions. You plot the drawings to scale so that your client can review them.
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The completed progeCAD drawing should look something like this:
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before drawing even one line, you must first prepare new drawing files with suitable set-
tings. For this tutorial, you are creating a medium-size architectural drawing, and so in this
chapter you prepare the new drawing file for architectural drafting.

To help you prepare the drawing, you use two sets of tools:

• New Drawing Wizard sets up some parameters.

• Additional commands set up the remaining parameters.

C • H • A • P • T • E • R 6

Setting Up New
Drawings
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In This Chapter

• New Drawing Wizard • Naming (and Saving) Drawings
• Setting Limits • Specifying Snap & Grid Spacing
• Toggling Ortho Mode • Selecting Entity Snap Modes
• Calculating Scale Factors • Alternative Method: Settings Dialog Boxes
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New Drawing Wizard
To set up new drawings, you can use the New Drawing wizard, as follows:

1. Start progeCAD. Notice that it opens with a blank, new drawing.

2. To set up the drawing for architectural drafting with the New Drawing wizard.  From
the File menu, select New.

(Alternatively, you can enter NewWiz at the command prompt.)

3. Wizards are multi-page dialog boxes that take you through a complex process step by
step. The New Drawing Wizard takes you through the steps to specify settings for
new drawings. It presents a variety of options.

The wizard does not, unfortunately, provide all the settings needed for this tutorial,
so you set additional options later.
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In the first page asks about the basis for the new drawing. You have two choices:

Use a template drawing — the new drawing is based on an existing draw-
ing known as a “template.” progeCAD copies all the settings from the tem-
plate file. This option is a good pick when your office has already created .dwt
template files.

(If you were to choose this option, the wizard’s next page would ask you to
select the name of the template file.)

Create an entirely new drawing — the new drawing is based on icad.dwt,
a blank drawing that contains progeCAD default settings.

Select the “entirely new drawing” option, and then click Next twice in a row.

4. progeCAD lets you work with five types of linear measurement units. “Linear” refers
to distances, as opposed to angles.

Scientific – displays scientific notation, such as 5.739E+02.

Decimal – displays unitless decimals, such as 573.9. This is also used for
drawings created in metric units.

Engineering – displays feet and decimal inches, such as 5'-7.39".
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Architectural – displays feet and fractional inches, such as 5'-7 3/4".

Fractional – displays fractional inches (no feet), such as 67 1/4".

Select Architectural units, and then click Next.

5. progeCAD lets you work with five kinds of angular measurement units.

Decimal degrees – displays degrees and decimals, such as 5.739º.

Degrees/Minutes/Seconds – displays degrees with minutes, seconds, and
decimals of seconds, such as 5º 73' 29.33".

Grads – displays grad and decimals, such as 234.55g. There are 400 grads in
a circle; grads are used in Germany.

Radians – displays radians and decimals, such as 57.34r. There are 2*pi
radians (approximately 6.282) in a circle; radians are used by scientists and
programmers.

Surveyor’s Units – displays angles relative to North, such as 67 1/4".

Select Decimal degrees, and then click Next.

6. The next step is to decide whether you want to used named style tables.

These allow you superb control over the plotted look of every entity in the drawing.
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For our drawings, however, the older, color-dependent style tables are just fine.

Named style tables (.stb files) – controls the look of every entity, such as
thickness, grayscale, line ends, and more; applies named styles to entities and
layers.

Color-dependent  style tables (.ctb files) — only the color of entities can
be used to affect the plotted output.

Both files — .stb (short for “style table”) and .ctb (“color table”) — store settings; both
are compatible with AutoCAD.

Select Color-dependent style tables, and then click Next.

7. The final page of the wizard calls itself “entity creation,” but deals with more than just
that.

The meaning of the options are:

Entity Linetype specifies how entities are assigned linetypes. This is an odd
question to ask when defining a drawing globally, in my opinion. In any case,
always select ByLayer from the options in the droplist:

• ByLayer means that layers define the linetype for all entities residing
on that layer.

• ByBlock means that blocks define the linetype for all entities in the
block.

• Continuous means that entities are defined on a by-entity basis. In
this case, the default is continuous (unbroken) lines.

Grid on displays the grid, a matrix of dots that help you visualize relative
sizes in drawings. Turn this option on.

Snap on turns on the cursor increment, the distance the cursor jumps.
Instead of moving freely, the cursor can be made to move in increments of
one inch, a foot, a quarter-inch, whatever. Turn this option on.

UCS Icon displays the UCS (user-defined coordinate system) in the drawing.
This is useful for determining your 3D position in space, but is pointless for
2D drawings. Turn this option off.
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Alternative Method: Settings Dialog Box

For setting up new drawings, there is an alternative method to the New Drawing wizard or
using commands. You can use the Settings dialog box to adjust many settings. From the Tools
menu, select Drawing Settings. (Alternatively, enter the Settings command.)

Drawing Units Tab

The Drawing Units tab specifies settings for linear and angular units, and user-defined coordi-
nate systems. Select categories from the Change Settings For droplist.

Coordinate Input Tab

The Coordinate Input tab specifies settings for snap and grid, limits, entity snaps, and entity
selection.
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Marker Blips displays small + marks each time you click a point in the drawing.
These blips can be helpful to determining where you clicked, but after a while clutter
the drawing with otherwise-useless markers. (You clean the blips off drawings with
the Redraw command.) Turn this option off.

Entity Color specifies the default color for entities in the drawing. As with linetypes,
I find this an odd question; the best option is ByLayer. If you want, however, you
can click the Select Color button and pick a default color. You have these two
options:

• ByLayer means that layers define the color for all entities residing on that
layer.

• ByBlock means that blocks define the color for all entities in the block.

8.  Click Finish. progeCAD applies the settings you selected to the drawing.

Notice that the grid is turned on and that the UCS icon is missing. On the status line, the SNAP
and GRID settings are in black, meaning they are turned on. (If you cannot see the grid, use the
Zoom Extents command, as follows:

: zoom

In/Out/All/Center/Extents/Left/Previous/Right/Window/Dynamic/<Scale (nX/nXP)>: e

There are more settings that every new drawing needs that are missing from the wizard. They
include a scale factor, limits, ortho, snap and grid spacing, and the file name for the drawing.
We’ll tackle them after we save and name this drawing.
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Naming (and Saving) Drawings
At this point, the drawing is devoid of entities, but still contains
data. It is crucial that you save your work so that you don’t lose
fruits of your labor when Windows crashes your computer. In addi-
tion to you manually saving your work, progeCAD automatically
saves your drawing every 60 minutes.

The first time you save a drawing, progeCAD asks you to give it a
name. After that, the drawing is saved by the same name until you
chose to change it.

Use the Save command to save drawings and give them a name.

1. From the File menu, select Save.

(Alternatively, enter the Save command at command
prompt.)

2. The Save Drawing As dialog box presents numerous options:

1. Select drive
and folder

6. Save the
drawing2. Enter file name

for drawing

3. Choose type
of format

4. Turn on
Preview

5. Decide on
password

Save in specifies the name of the drive and folder in which drawings are to be saved.
You can also access networked drives, which are drives on computers connected to
yours through a network. Click the Save In droplist, and then select a drive and
folder for this drawing.

File name identifies drawings by names  of up to 255 characters. Firms often have
standards for naming drawings logically; for this tutorial, use the generic name
“apartment.”

Save as type specifies the format in which to save the drawing. progeCAD supports
the following AutoCAD-compatible formats:

• DWG (standard drawings).

SAVE COMMAND

Saves drawings by name.

Command: save

Alias: sa

Menu: File | Save As

Options: Save in

Save as type

Use Preview

Password Protect

ALTERNATIVES

QSave saves without prompts.

Exports saves in other formats.
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• DXF binary.

• DXF ASCII.

• DWT (template drawings).

• Formats compatible with older releases of AutoCAD and progeCAD.

Unless you understand the reason for using another format, select “AutoCAD 2005
2006 Binary (dwg).”

Use Preview creates a preview image of the drawing. This is useful when
browsing through drawings, in deciding which one to load. Turn this option on.

Password Protect prompts you to specify a password. Later, when opening the
drawing again, you are asked for the password before it will be displayed. If you
forget the password, you lose access to the drawing. Turn this option off.

3. Click the Save button to save the drawing, giving it the new name. You should see
the new file name on progeCAD’s title bar.

TIP progeCAD automatically backs up (saves) your drawings every 60 minutes. This
isn’t frequent enough, because you can do — and lose — a lot of work in an hour. To
change the frequency of automatic backups, follow these steps:

1. From the Tools menu, select Options.
2. In the Options dialog box, select the General tab.

3. In the AutoSave section, change the minutes setting to 10 or 15.
4. Click OK.
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Setting Limits

Limits define the extents of the drawing: how big is the drawing
horizontally and vertically? In practice, limits don’t matter, because
progeCAD can create drawings larger than our solar system. (Print-
ing a drawing of that size might be a problem.)

Limits are useful for a different reason: they define the limits of
the grid and the zoom-all display. This provides you with an idea
of the working area.

For the tutorial drawing, the limits are the size of the condominium
apartment, plus some extra space around the edges. The apart-
ment is 32' x 24', so make the limits 40' x 30'.  Limits are set with
the Limits command.

1. From the Tools menu, select Drawing Limits.

(Alternatively, enter the Limits command.)

2. In the command bar, progeCAD asks you for the coordinates of the lower left corner.
They are at 0",0" so just press Enter to accept the default values:

Command: limits

Limits are off:  ON/<Lower left corner> <0",0">:  (Press Enter.)

0',0'

40',30'

Limits of the Drawing

LIMITS COMMAND

Sets grid and zoom-all limits.

Command: limits

Menu: Tools | Drawing Limits

Options: On or Off

Lower left corner

Upper right corner
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3. The upper right corner uses the coordinates specified earlier. Remember to include the
apostrophe ( ' ) after each dimension, otherwise progeCAD thinks you are entering
inches.

Upper right corner <0'-12",0'-9">: 40',30'

4. Again, use the Zoom Extents command to “see” the limits of the drawing.
progeCAD most likely complains, “The grid spacing is too small to display in this
view.” You fix the problem in the next section.

Specifying Snap and Grid Spacing

The New Drawing wizard had preset the spacing between snap
points and grid dots to 1/2". When you zoom out to the full extents
of the drawing, progeCAD displays some 350,000 grid dots. That
many is too many, making the screen look black.

When the grid becomes too dense, progeCAD refuses to display it;
instead it displays a warning message in the command bar: “The
grid spacing is too small to display in this view.” There are two
ways to deal with the warning message: ignore it, or change the
grid spacing to larger values.

With the Grid command, change the grid spacing to 1', as follows.

1. From the Tools menu, select Reference Grid.

(Alternatively, enter the Grid command, or else right-
click GRID on the status bar, and then select Settings.)

2. In the command bar, enter the spacing:
Grid is on:  OFF/Snap/Aspect/<Grid spacing (x and y = 0 1/
2")>: 1'

Notice that progeCAD displays the grid dot inside of the
limits. Each dot is one foot from its neighbor.

3. The snap spacing determines how far the cursor moves.
You can think of it as cursor resolution. When you draw
the floor plan of this apartment, you will probably draw
entities to the nearest 1/2" or so. By setting snap to 1/2",
you make it easier to pick points with the cursor.

Snap spacing is related to grid spacing. In fact, the two
can share the same value. In practice, I find that the grid
should have a larger value (like 1 foot or 1 meter), and the
snap a smaller on, like 1/2" or 1 mm.

The snap spacing had been set to 1/2" by the New Draw-
ing Wizard. If you wish to confirm this, use the Snap
command.

GRID COMMAND

Controls the grid display.

Command: grid

Alias: g

Menu: Tools| Reference Grid

Toolbar: Tools | Reference Grid

Shortcut: F7

Status Bar: GRID

Options: On or Off

Snap

Aspect

Grid spacing

ALTERNATIVE

DdRModes specifies grid set-
tings via dialog box.

SNAP COMMAND

Controls the snap increment.

Command: snap

Alias: sn

Menu: Tools| Snap

Toolbar: Settings | Snap

Shortcut: F9

Status Bar: SNAP

Options: On or Off

Rotate

Style

Aspect

Snap spacing

ALTERNATIVE

DdRModes specifies snap set-
tings via dialog box.
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Toggling Ortho Mode

The drawing of the apartment is rectilinear, which means it con-
sists mostly of straight lines drawn at right angles. progeCAD helps
you draw straight lines at right angles with ortho mode, which is
short for “orthographic” — another way of saying rectilinear.

To turn on ortho mode, use the Ortho command.

1. From the Tools menu, select Draw Orthogonal. Notice that
the ORTHO button turns on the status line, and that progeCAD
confirms the change in the command box.

ORTHOMODE is currently off:  ON/Toggle/<Off>: _T

Ortho mode is called a “toggle,” because it only has two settings: on
and off — just like a light switch. Because it is common to toggle
ortho mode while drafting, there are several ways to turn it on and
off:

• Press function key F8.

• Click ORTHO on the status bar.

• Hold down the Shift key.

You can use the shortcuts to toggle ortho mode at any time, includ-
ing during any command.

Selecting Entity Snap Modes

Entity snaps are among the most powerful tools in the progeCAD
toolbox. Esnaps snap the cursor to geometric features, such as to
the middle or ends of lines and arcs. They can snap to the center of
circles and arcs, to the intersection of two entities, and to many more
features.

Like ortho mode, you sometimes want entity snaps on, and some-
times off. You can toggle ensaps during commands by using these
shortcuts:

• Press function key F3.

• Click ESNAP on the status bar.

For turning on individual entity snap modes, I find the dialog box
easier than the command line.

ORTHO COMMAND

Controls the snap increment.

Command: ortho

Alias:   sn

Menu:   Tools | Draw Orthogonal

Toolbar: Settings | Draw Orthogonal

Shortcut: F8

Status Bar: ORTHO

Options: On or Off

ALTERNATIVE

DdRModes specifies the ortho
setting via dialog box.

ESNAP COMMAND

Specifies entity snap modes.

Command: esnap

Aliases: -os, osnap, -osnap

AutoCAD: -osnap

Menu: Tools | Entity Snap

Toolbar: Entity Snaps

Shortcut: F3 (toggle)

Status Bar: ESNAP

Mouse: Shift+right click

Options: On, Off NEArest,
ENDpoint, MIDpoint, CENter,
PERpendicular, TANgent,
QUAdrant, INSertion, POInt,
INTersection,  PLAnview

ALTERNATIVE

DdRModes specifies the esnap
setting via dialog box.
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1. From the Tools menu, select Entity Snap, and then select Entity Snap Settings.

(Alternatively, you can enter the ESnap command, or else right-click ESNAP on the
status bar, and then select Settings.)

2. In the Settings dialog box,  click Clear to turn off all esnap modes. (“Esnap” is short
for entity snaps.)

3. Now select the entity snaps that work best with rectilinear drawings, like our apart-
ment floor plan:

Endpoint — snaps to the ends of lines, polylines, and arcs.

Perpendicular — snaps at right angles to lines and circles.

Midpoint — snaps to the midpoint of lines, polyline segments, and arcs.

Intersection — snaps to the intersection of two lines, circles, arcs, other
entities, and combinations thereof.

4. Click OK to exit the dialog box.

Calculating Scale Factors

One issue with CAD is that there are two kinds of scale factors. Normally, you draw everything
“full size” in progeCAD. If a wall is 24 feet long, you draw it 24'-long in the drawing.

When it comes time to plot, the drawing must be scaled down to fit the paper. That 24-foot wall
might be plotted just 8 inches long. The scale of the drawing is 24'=8", or 36:1. (That’s 24' x 12
inches/foot = 8", or 288:8 = 36:1.) When plotted, everything in the drawing is 36 times smaller.
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There is a problem, however. Some aspects of the CAD drawing cannot be 36x smaller. These
include text, linetypes, hatch patterns, dimension text, and arrowheads. These items should be
“full size” when plotted. That means they must be 36x larger when drawn in CAD, in order to
turn out 1x on the printed page.

Text, for instance, is typically 1/4" tall in paper drawings. That means it should be  9" tall in the
CAD drawing (1/4" x 36, the scale factor).

To set the scale factor in progeCAD, use the commands and system variables for each type of
scale-sensitive entity, as illustrated by the table below.

Entity Command or System Variable

Linetypes LtScale sets the linetype scale factor.
Hatch Patterns HpScale sets the hatch scale factor.
Dimensions DimScale sets the dimension scale factor.
Text Style or Text set the height in plotted inches.

For this drawing, set the scale factors, as follows:

1. Use the LtScale system variable to preset the scale factor for linetypes:
: ltscale

New current value for LTSCALE (greater than zero) <1.0>: 36

2. Use the HpScale system variable to preset the scale factor for dimensions:
: hpscale

New current value for HPSCALE (greater than zero) <0'-1">: 36

3. Use the DimScale system variable to set the scale factor for dimensions:
: dimscale

New current value for DIMSCALE (0 or greater) <1.0>: 36

Text aren’t scaled until later in this tutorial when you use the Style and MText commands

Save As Template Drawing

You start to see the benefit of template drawings, where all settings are already established. By
saving the current drawing as a template, you can later reuse it as the start for similar draw-
ings.

Templates are saved with the SaveAs command.

1. From the File menu, select Save As.

2. In the Save Drawing As dialog box, change the extension of the file name from .dwg
to .dwt.

File name: apartment.dwt
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3. Click Save, and the drawing is saved as a template. The next time, you can use the
Open command’s “Drawing Template (dwt)” file type to access it.

4. There is a problem: notice the title bar reads “apartment.dwt”. We want to work with
a drawing, not a template.

Use the SaveAs command again, saving the drawing as “apartment.dwg.”
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the exterior walls enclose the unit. Everything inside the apartment must fit between four walls.
Two of the exterior walls (top and bottom) are 6" thick to provide extra insulation; the other two
walls (left and side) are 4" thick, because they adjoin other units. In this chapter, you draw the
exterior walls with the Line and other commands, and then save your work.
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Drawing Exterior
Walls
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In This Chapter

• Line command. • Offset command. • Trim command.
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Drawing Lines
The Line command draws line segments. You use it to draw the
outline of the apartment’s four exterior walls. The location of the
lines are specified with absolute x, y coordinates (Cartesian coordi-
nates); in later tutorials, you learn about other methods for input-
ting coordinates.

To use the Line command, you need to know the starting and end-
ing x,y coordinates of each line segment. From the sketch of the ex-
terior walls on the previous page, we can see that two walls are 24'
long, and that two are 32'. Starting the apartment in the lower left
corner at 0,0 (aka origin), I’ve noted the coordinates of each
segment’s endpoints in the figure below.

1. If necessary, use the Open command to open the apartment.dwg saved in the previ-
ous chapter.

2. Start the Line command.
Command: line

3. Specify where the first line segment should be drawn, starting at the origin (0,0)...
Start of line: 0,0

4. ...and where the line segment ends, 24' to the right.
Angle/Length/<End point>: 24’,0

5. The second segment is 32' tall:
Angle/Length/Follow/Undo/<End point>: 24',32'

0,0
(x,y)

24',0

24',32'0,32'

x axisy axis

6. Draw the next segment is 24' to the left.
Angle/Length/Follow/Close/Undo/<End point>: 0,32'

OPEN COMMAND

Opens drawings.

Command: open

Aliases: o, imp, import

Toolbar: Standard | Open

Menu: File | Open

Shortcut: Ctrl+O

Options: Files of type

Read-only

Use preview
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7. To close the rectangle, you could enter the final coordi-
nates (0,0), or you could use the Close option to have
progeCAD draw the final segment for you.

Angle/Length/Follow/Close/Undo/<End point>: c

At this point, the  drawing consists of a rectangle. If you do not see
it all, use the Zoom Extents command.

Offsetting Lines
The exterior walls are 4" and 6" thick. To show the thickness, you
draw a second set of lines inside the large rectangle. You could use
the Line command again, but there is an easier method. The Off-
set command makes copies by offsetting the original lines.

To use the Offset command, you need to know the following:

• The entities to be copied.

• The offset distance.

• The side(s) on which to create the copy.

1. Start the Offset command.
Command: offset

2. Specify the offset distance of 4".
Parallel: ENTER for Through point/<Distance>: 4

3. Select the entity to copy.
Select entity: (Pick one of the vertical lines.)

4. Pick a point inside the rectangle. progeCAD will make
the copy through that point.

Both sides/<Side for parallel copy>: (Pick inside the rect-
angle.)

5. The command repeats itself so that you can create
parallel copies of additional entities. Pick the other
vertical line.

Select entity: (Pick other vertical line.)

Both sides/<Side for parallel copy>: (Pick inside the rect-
angle.)

6. Press Enter to exit the command.
Select entity: (Press Enter.)

OFFSET COMMAND

Makes parallel copies.

Command: offset

Aliases: o, parallel

Toolbar: Modify | Offset

Menu: Modify | Offset

Options: Distance

Through point

Side

Both sides

ALTERNATIVES

Copy makes copies.

Mirror makes mirrored copies.

Array makes multiple copies.

LINE COMMAND

Draws line segments.

Command: line

Aliases: l, 3dline

Toolbar: Draw 2D | Line

Menu: Insert | Line

Options: Follow

Angle

Length

Undo

Done

Close

ALTERNATIVES

PLine draws connected lines.

Ray draws semi-infinite lines.

XLine draws infinite lines.

Arc draws curved lines.

Spline draws Bezier splines.

Rectangle draws rectangles.
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TIP Some command repeat themselves, like Offset. This allows you to repeat the
editing or drawing operation without having to restart the command.

To end a repeating command, press Enter or Esc on the keyboard. As an alterna-
tive, you can select Cancel from the prompt menu, or right-click until the command ends.

At this point, your drawing consists of a rectangle with two extra vertical lines, as illustrated
below.

Repeat the Offset command to add the 6" offset lines.

Command: offset

Parallel:  Through point/<Distance> <0'-4">: 6"

Select entity: (Pick one of the horizontal lines.)

Both sides/<Side for parallel copy>: (Pick inside the rectangle.)

Select entity: (Pick the other horizontal line.)

Both sides/<Side for parallel copy>: (Pick inside the rectangle.)

Select entity: (Press Enter to end the command.)

The result should look like the figure illustrated below.



chapter 7: drawing exterior walls 91

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Trimming Lines
Creating the parallel copies resulted in messy intersections where
the lines overlap. You use the Trim command to clean up intersec-
tions.

Trim works by shortening entities back to a cutting entity. Because
the four inner lines overlap each other, you can use them simulta-
neously as cutting entities and the entities to be trimmed.

To use the Trim command, you need to know:

• The cutting entities.

• The entities to be trimmed.

Cutting EntityEntity to be
Trimmed

Portion to
be Removed

1. Start the Trim command.
Command: trim

2. Select all the entities in the drawing by pressing Enter.
Select cutting entities for trim <ENTER to select all>: (Press Enter.)

Using all entities as trim boundary.

3. Pick a line to trim. This can be tricky: pick the portion of the line you want removed;
do not pick the portion you want to retain.

Edge mode/Fence/Projection/<Select entity to trim>: (Pick the end of a line.)

Pick here to trim
this segment

After
Trimming

Before
Trimming

TRIM COMMAND

Trims entities to a boundary.

Command: trim

Aliases: tr

Toolbar: Modify | Trim

Menu: Modify | Trim

Options: Edge mode

Fence

Projection

Undo

ALTERNATIVES

Break cuts entities.

EditLen and Change change
lengths of open entities.

Fillet and Chamfer trim inter-
sections.
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4. Repeat seven more times to trim the ends of all four inner lines.
Edge mode/Fence/Projection/Undo/<Select entity to trim>: (Pick another segment.)

5. When done, press Enter to end the command.
Edge mode/Fence/Projection/Undo/<Select entity to trim>: (Press Enter.)

At this point, your drawing should look like the double-line rectangle below.

Be sure so save your drawing! Use the QSave command, or press
Ctrl+S.QSAVE COMMAND

Saves drawings.

Command: qsave

Menu: File | Save

Toolbar: Standard | Save

Shortcut: Ctrl+S

ALTERNATIVES

Save prompts for file name.

Exports saves in other formats.
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the interior spaces contain the living room, kitchen, a single bedroom, the closets, and so on.
They are constrained by the exterior walls, and each other: give one area more space and it
takes away space from other areas. In general, the kitchen and bathroom receive less space,
while major living areas — dining, living, and bedroom — receive more space.
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Defining Interior
Spaces
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In This Chapter

• ExpLayers command • Erase command • Redraw command
• Move command • Lenthen command • Fillet command
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For this project, each unit is subdivided into four major areas:

• Living and dining room.

• Kitchen; the kitchen shares space with the entrance hall.

• Bathroom; the bathroom shares space with the coat closet.

• Bedroom; the bedroom is further subdivided into three spaces:

Bedroom closet.

Ensuite bathroom.

Hotwater tank closet.

All interior walls are 4" thick.

Creating Layers
Once drawings consist of more than just a few lines, it becomes important to segregate infor-
mation. For instance, external walls are different from internal walls, and so they should be
segregated. Similarly, the content of rooms (furniture, appliances) should be segregated from
the content of walls (doors, window). And so on.

There are two ways to segregate information in CAD drawings: through layers (discussed in
this chapter) or through externally-referenced drawings. (Externally-referenced drawings keep
entire drawings separate from each other, yet display them as one drawing. Here we concern
ourselves with layers only.)

About Layers

Layers are like transparent sheets of paper; on each sheet you draw different parts of the draw-
ing, such as walls, electrical, and furnishings. You overlay the sheets to see the entire drawing.
For instance, an electrician is interested in the walls and electrical, so he doesn’t need the
furnishings layer. That layer can be turned off for him.

Entities are assigned to layers. (If you don’t assign layers, then all entities end up on a single
layer, named “0”).

Layers have properties that determine the way that entities appear. The properties include
color, linetype, and visibility. This aspect of layers is powerful, because it means that all enti-
ties of a layer can have their properties changed at once. For instance

• Change a layer’s color from black to red: all entities assigned to that layer also change
from black to red.

• Change the layer’s linetype from continuous to hidden: the entities’ linetype change
to hidden.

• Turn off a layer, and its entities disappear from the screen; turn on the layer, and the
entities reappear.
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There is no limit to the number of entities that can be assigned to a layer. There is no limit to
the number of layers that can be created in a drawing.

Layer Standards

It is common for architectural and engineering firms to establish layer standards. These specify
the names and properties of layers, and other aspects of drawings.

Standards are usually specific to disciplines; for example, the layers used for an architectural
drawing are not suitable for mechanical drawings.

Standards are sometimes dictated by clients or by industry associations. Examples include the
US Coast Guard and the Architectural Institute of America.

TIPS It is good practice to create template drawings containing standard layer names.

To copy layers from one drawing to another, use the Explorer window’s Copy and Paste
commands.

Properties of Layers

Layers can have the following properties:

Name — any combination of letters, numbers, and spaces up to 255 characters long. The
name cannot contain these symbols / ? : > " < | and \ . You can use descriptive
names (‘Walls’, ‘Electrical’, ‘Furnishings’) and prescriptive names (‘A-WALLS’, ‘E-
LIGHTS’).

Current (Set) — only one layer can be current at a time. This is the working layer;
when new entities are drawn, they are assigned to the current layer.

Color — layers can be assigned any of progeCAD’s colors. The default color is black.

Linetype — layers can be assigned any linetype loaded into the drawing. The default
linetype is Continuous.

Lineweight — layers can be assigned any of progeCAD’s 24 lineweights, from 0 mm to
2.11mm. The default lineweight is called “Default,” and is determined by the setting in
the Drawing Settings | Display | Lineweights dialog box.

On and Off — layers can be on (visible and editable) or off (not visible). The default is
on.

Plot — layers can be plotted or not plotted. The default is to be plotted.

Freeze and Thaw — layers can be frozen (not visible and ignored) or thawed (visible).
The default is thawed.

Lock and Unlock — layers can be locked (visible but not editable) or unlocked (visible
and editable). The default is unlocked.

(Plot Styles names can be specified only when the drawing uses named plot styles; otherwise
they are grayed out.)
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Frozen Layers

The difference between off and freeze is subtle. When a layer is turned off, its entities are no
longer visible, but they are taken into account when the extents of the drawing are calculated,
such as during the Regen, Zoom, and Plot commands. As well, you can continue to draw on
layers turned off, but the entities remain invisible until the layers are turned on.

When a layer is frozen, the extents of its entities are ignored, and you cannot draw on it.

In addition, frozen layers occur in two different ways: in current viewports and in and new
ones. (These are the viewports found in paperspace or layout mode.) By freezing layers in
individual viewports, you create different kinds of views of drawings. The “New Viewports”
option determines whether layers are frozen when new viewports are created.

ByLayer and ByBlock

You may have seen colors or linetypes called “BYLAYER.” This  special name means that enti-
ties take on the color, linetype, and other properties specified by their layer — sort of like an
automatic color and linetype.

Similarly, “BYBLOCK” colors and linetypes mean that entities take
on the color and other properties specified by the block of which
it is a part.

Local Overrides

I have described the preferred method of controlling the proper-
ties of entities: by layers. This can be overridden, a practice that
some CAD instructors frown upon. For instance, you can assign
the color green to an entity whose layer is red. This is called a
“local override.”

Local overrides can be applied with the Color and Linetype com-
mands, or with the Entity Properties toolbar: select the entity,
and then change its color or linetype.

Layer Command
You create layers with the Layer  commands. (Alternatively, you
can also use the ExpLayers command, but Layer is more like
AutocAD’s.)

If you had problems completing the previous tutorial, the exterior
walls drawing is available as 1ExteriorWalls.dwg.

In this tutorial, you create layers to segregate details. As I noted
earlier, layers can have any name — so what names should you
use? Spend a moment thinking about the content of the apart-
ment design.

LAYER COMMAND

Creates and controls layers.

Command: layer

Aliases: la, ddlmodes

AutoCAD: layer

Menu: Settings | Explore Layers

Toolbar: Entity Properties |
Explore Layers

Options: Layer name

New

Make

Current (Set)

Color

Linetype

Lineweight

On and Off

Plot

Plot Style

Freeze and Thaw

Lock and Unlock

ALTERNATIVES

ExpLayer makes and controls
layers at the Explorer.

SetLayer sets current layer
from selected entity.
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Exploring the Explorer Window

progeCAD’s Explorer provides a detailed view into the elements that make up drawings — just
about everything except for entities and system variables. Explorer lists the names of open
drawings, the states of layers, linetypes, text styles, UCSs (named coordinate systems), named
views, user-defined blocks, and dimension styles. (AutoCAD’s DesignCenter is similar to the
Explorer.)

Explorer is used to inspect the status of elements, to create new ones, and to change their
properties. Perhaps the most powerful feature of Explorer is the ability to copy elements among
drawings.

Layer PropertiesLayer Names

Elements Pane

Explorer
Toolbar

The window is opened by the Explorer command. Related commands open the window with
the specified element showing:

• ExpBlocks — blocks stored in drawings.

• ExpDimstyles — dimension styles defined in drawings.

• ExpFonts — text styles names.

• ExpLayers — layers and settings.

• ExpLtypes — linetypes loaded into drawings.

• ExpUcs — user-defined coordinate systems.

• ExpViews — named views stored in drawings.

Toolbars

You can manipulate elements in a variety of ways, as indicated by the toolbar:

New Item — creates a new element with a generic name and default properties.

Current — makes the selected element current, such as the working layer or view.

Cut — copies selected elements to the Clipboard, and then erases them from the drawing.

continued...
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Copy — copies selected elements to the Clipboard.

Paste — pastes elements from the Clipboard into the drawing, and adds them to the Explorer.

Delete — removes the element from the drawing; certain elements cannot be deleted. progeCAD
warns you before removing the element.

Properties — displays a non-modal dialog box showing property settings. “Non-modal” means
that the dialog box can stay on-screen, and does not need to be dismissed in order to continue
editing. Click the x to dismiss the dialog box.

World (Coordinate Systems only) — returns a UCS to the WCS view.

Purge — removes unused elements from the drawing; certain elements cannot be purged.

Regen — forces the drawing to update to reflect changes made in the Explorer window.

On/Off Regen — toggles automatic regeneration.

Layer elements have three additional toolbar buttons:

Layer on/off — turns selected layer(s) on and off.

Freeze/thaw — freezes and thaws selected layer(s).

Lock/unlock — locks and unlocks selected layer(s).
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The block elements have six toolbar buttons of their own:

Images — shows blocks as preview images.

Details — lists blocks by name and details, such as number of insertions and insertion points.

Insert — inserts the selected block in the drawing.

Insert external file blocks — displays Insert Block dialog box to insert any drawing as a block.

Save blocks — runs the WBlock command to export blocks as .dwg files.

Attach drawing — runs the XRef command to attach drawings as external references.

Curiously, the Rename option is not on the toolbar, perhaps because elements can be renamed
directly. Click on a name twice, and then edit it.

Shortcut Keystrokes

Within the Explorer window, you can use the following shortcut keystrokes:

Ctrl+A — selects all elements

Ctrl+C — copies selected elements.

Ctrl+V — pastes elements.

Ctrl+X — cuts selected elements.

Del — deletes selected elements.

F1 — displays help window.

Mouse Actions

To select an element, click on it.

To select a range of elements, hold down the Shift key, and then select the first and last
elements in the range.

To select random elements, hold down the Ctrl key, and then select each element.

You can right-click elements to display a shortcut menu of options.

The Explorer cannot be customized.
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It consists of these elements:

- walls
- doors and windows
- fixed assets
- nonfixed assets

A “real” drawing would also have plumbing, electrical and communications, alarm system,
heating and ventilating, and many other details — and hence many more layers.

For this tutorial, use the above phrases as the layer names. To create layers, follow these steps:

1. Start the Layer command. Notice the Layer Properties Manager dialog box.

2. In the toolbar, click the New Layer  button.  Notice that progeCAD creates a new
layer with the same properties as the current layer: white color, continuous linetype,
and so on.

3. progeCAD names the new layer “Layer1.” Change its name to “Walls”.

4. Add the names of other layers, which you use later:

Doors and Windows
Assets-Fixed
Assets-Nonfixed

There is a reason for using names with reversed words — such as “Assets - Fixed”,
instead of “Fixed Assets.” progeCAD lists layer names in alphabetical order, and not
in the order in which layers are created. By reversing the parts of the names, all Asset
layers are listed together.
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5. Now select Walls, and then click the Current  button. This makes the layer
current (i.e., the working layer), because the next lines you draw will be the interior
walls.

When done, the dialog box should look like the figure below.

6. Close the dialog box by clicking the OK button.

7. On the Entity Properties toolbar, notice that the Layer Control displays “Walls.”

Assigning Entities to Different Layers

Currently, all the lines, which represent exterior walls, are on layer 0. They really should be on
layer ‘Walls’. Follow these steps to assign entities to different layers.

1. Press Ctrl+A to select all entities in the drawing. Notice that they are highlighted by
dashed lines and green grips.

2. From the Layer Control, select “Walls.”

And you’re done. Ja, it’s that easy.

Adding Interior Lines

With the layers set up, you can now draw the interior walls. The technique is the same as for
the exterior walls: draw one side of the wall with the Line command, and then draw the other
side with the Offset command. Finally, clean up intersections with the Trim command.
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You can make the rooms any size you like to fit the exterior walls. Or, you  can follow the
dimensions illustrated below (width' x depth').

Bedroom
9'x16'

(including two closets and
ensuite bathroom)

Entrance
4'x9'8"

(including closet)

Living Room
14'x21'

(including dining area)

Kitchen
10'x9'8"

Bathroom
9'x9'8"

If you were to add up the dimensions, don’t forget the wall thicknesses; otherwise, it may seem
that the totals are incorrect. Across the top, for example, the living room + bedroom are 14' + 9'
= 23' wide. Yet the apartment unit is 24' wide. Where did the missing foot go? The answer is in
the thickness of the walls: the two outside walls and one inner wall are each 4" thick. That’s 3 x
4" = 12" = 1'.

Here are some design hints:

• Interior walls are 4" thick.

• You don’t need to create openings for doors or windows, because those will be indi-
cated later when you insert the door and window symbols.

• The fireplace is roughly 4' x 2'.

• Read the alternate strategies described later in this chapter.

Starting Offset Lines

At this stage, the most difficult drafting task is starting a line at some point along an existing
line.  For instance, the wall that separates the kitchen from the dining/living room starts at
9'8" along the y axis.
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9
' 
8

"Kitchen
10'x9'8"

How do you
determine where
this line starts?

0,0

Drawing lines that start at the end of existing lines is pretty easy: use the ENDpoint entity
snap. But how do you draw a line that starts 9'8" from the end of another line? That’s not quite
as easy. I’ll show you several ways to do it; try each one to see which works best for you.

Brute Force Method

The brute force method draws a construction line to specify the distance, draws the wanted
line, and then erases the construction line.

9
' 
8

"

2. "Construction"
line is 9'8" long.

1. Use INTersection
entity snap at this
corner.

10'

3. "Wall" line is
10' long.

4. Erase
construction line.

1. Ensure ortho mode is turned on. If necessary, double-click ORTHO on the status bar
so that the word is shown in black, not gray.

2. Use the Line command to draw the construction line, followed by the wall line, as
follows:

Command: line

Start of line: int

Snap to intersection of: (Pick intersection of lines at 1, as illustrated above.)

Angle/Length/<End point>: (Move cursor upwards in the y direction) 9'8"

Angle/Length/Follow/Undo/<End point>: (Move cursor to the right in the x direction) 10'

Angle/Length/Follow/Close/Undo/<End point>: (Press Enter to end the command.)
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3. Use the Erase command to remove the construction line,
as follows:

Command: erase

Select entities to delete: (Pick the construction line.)

Entities in set: 1

Select entities to delete: (Press Enter to end the command.)

4. The line is erased. If necessary, use the Redraw com-
mand to clean up the display.

Command: r

TIP The Line command doesn’t always require a pair of coordi-
nates. Above, you entered a single value, 9'8", for the coordinate.
How does progeCAD know if you mean x or y?

When you turned on ortho mode, progeCAD restricted cursor
movement in the x (horizontal) and y (vertical) directions.

When you move the mouse (cursor) up, progeCAD under-
stood you meant the y direction.

And when you entered the distance of 9'8", progeCAD
understood that to mean y=9'8".

Construction Line Method

The construction line method creates a layer for construction lines,
and then uses the InfLine command to place a grid of construction
lines. Following that, you switch back to the interior-walls layer,
and trace over the construction lines with the Line command.

Calculated Coordinates Method

The calculated coordinates method works out the x,y-coordinate of
the line’s start point.

y
 =

 9
' 
8

"

x = 0'4"
y = 0'4"

10'

2. "Wall" line is
10' long.

1. Determine
starting
coordinates of
"wall" line.

x = 0'4"
y = 0'4" + 9'8"
   = 10'0"

ERASE COMMAND

Deletes selected entities.

Command: erase

Aliases:    e, delete

Keyboard: Del

Menu:    Edit| Delete

ALTERNATIVES

CutClip copies selected
entities to the Clipboard, and
then erases them from the
drawing.

Oops returns the last erased
entity(ies).

U undoes this command.

REDRAW COMMAND

Cleans up the current viewport.

Command: redraw

Alias: r

Menu: View | Redraw

Toolbar: View | Redraw

ALTERNATIVES

RedrawAll cleans up all
viewports.

Regen regenerates the view
from the drawing database.
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The figure above illustrates the math. The x coordinate stays the same, but the y coordinate
changes, as follows:

y = 0'-4" + 9' 8"

= 10' 0"

(Having to add up feet and inches just about makes you pine for the metric system, eh?) You
now draw the line using the coordinates you worked out:

Command: line

Start of line: 4",10'

Angle/Length/<End point>: (Move cursor to the right in the x direction) 10'

Angle/Length/Follow/Undo/<End point>: (Press Enter to end the command.)

Moved Entity Method

The moved entity method draws the line, and then uses the Move command to move it by 9'8".

9
' 
8

"

10'

2. ... and then move
by 9'8" to here.

1. Draw "wall"
line here...

Point #1

1. Draw the 10'-long line over the existing line, as
illustrated above:

Command: line

Start of line: int

Snap to endpoint of: (Pick intersection at 1.)

Angle/Length/<End point>: (Move cursor to the right in
the x direction) 10'

Angle/Length/Follow/Undo/<End point>: (Press Enter to
end the command.)

2. With the Move command, move the line up by 9'8",
as follows:

Command: m

Select entities to move: l

Entities in set: 1

Select entities to move: (Press Enter to end entity
selection.)

MOVE COMMAND

Moves entities linearly.

Command: move

Alias: m

Menu: Modify | Move

Toolbar: Modify |Move

Options: Vector

Base point

Displacement

ALTERNATIVES

Grips editing moves entities.

Stretch move entities within
the selection window.

Rotate moves entities through
an angle.
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Vector/<Base point>: end

Snap to endpoint of: (Pick end of line at 1.)

Displacement point: 0,9'8"

TIP Notice the use of “l” in the ‘Select entities to move’ prompt, above. It is short for
“last” and tells progeCAD to select the last-created (or most-recently created) entity in
the drawing.

There are numerous selection options, but the few that I use the most include:
a Selects all entities in the drawing
c Prompts me to create a selection rectangle that includes all entities

crossing and within the rectangle.
l Selects the last-drawn entity.
p Selects the previously-selected entities.
w Prompts me to create a selection rectangle that includes all entities within

the rectangle.

Offset-Lengthen Method

The offset method uses the Offset command to offset an existing line, and then uses the
Lengthen command to correct its length.

Length = 10'

2. And then
shorten to 10'.

1. Offset this
line by 9'8".

O
ff

se
t 

=
 9

' 
8

"

Pick point 1

Pick point 2
(offset side)

Pick point 3

1. Use the Offset command to create an offset copy of an existing line, as follows:
Command: offset

Offset:  Through point/<Distance> <0'-1">: 9'8"

Select entity: (Pick line at 1.)

Both sides/<Side for parallel copy>: (Pick above line, at 2.)

Select entity: Press Enter to end the command.)

2. Use Lengthen command to shorten the line to ten feet, as follows:
Command: lengthen

Edit length:  DYnamic/Increment/Percent/Total/<Select entity to list length>: t

Angle/<Enter total length (0'-1")>: 10'

Mode/<Select entity to change>: (Pick line at 3.)

Mode/Undo/<Select entity to change>: (Press Enter to end the command.)
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TIPS The Lengthen command applies only to open entities, such
as lines, arcs, and polylines.

Your pick point at the ‘Select entity to change’ prompt
determines from which end the entity is lengthened or shortened.
The endpoint closest to the pick point is the end that changes; the
other end point remains in place.

The “t” option specifies the total, new length of the line. The
command’s options include:

Lengthen Meaning

DYnamic Interactively changes the length as you move
the cursor.

Increment Adds to the entity’s length by this amount;
a negative value subtracts from the length.

Percent Changes length by a percentage:
Less than 100 = entity is shorter
100 = no change
More than 100 = entity is longer

Total Specifies the absolute length, longer or shorter.

Alternate Trim Strategy

The different approaches described above show the flexibility of
progeCAD; it usually provides more than one way to perform op-
erations.

Earlier, I suggested you draw the interior walls the same way as the
exterior walls: place lines, make offsets, and trim the excess. Here is
an alternative method to trimming.

The obvious way to trim intersections is with the Trim command to
cut off unwanted portions of lines. Less obvious is the Fillet com-
mand; in fact, Fillet is preferred over Trim by most CAD operators.

1. Start the Fillet command, and then enter “s” for the Set-
tings option, as follows:

Command: fillet

Fillet (radius=7'-10"):  Settings/Polyline/<Select first entity>: s

2. progeCAD displays the Drawing Settings dialog box opened
to the Entity Modification | Chamfer/Fillet tab. Here you
set the fillet radius.

FILLET COMMAND

Rounds off intersections.

Command: fillet

Aliases: f, fi

Menu: Modify | Fillet

Toolbar: Modify |Fillet

Options: Settings

Polyline

ALTERNATIVES

Chamfer angles off intersec-
tions.

Trim shortens open entities to
a boundary.

LENGTHEN COMMAND

Changes the length of open
objects.

Command: lengthen

Aliases: len, editlen

AutoCAD: lengthen

Menu: Modify | Edit Length

Toolbar: Modify |Edit Length

Options: DYnamic

Increment

Percent

Total

List length

ALTERNATIVES

Stretch lengthens or shortens
the portion of open and
closed entities outside the
selection window.

Extend lengthens open
entities to a boundary.

Trim shortens open entities to
a bdounary.
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To trim lines with fillets:

a. Set the radius to 0". In the Fillet Radius area, change Radius to 0,

b. Leave the Corners option set to “Remove Corners.”

c. Click OK to exit the dialog box.

3. progeCAD returns to prompting you in the command bar. Notice that the radius is
now set to 0". Pick the first line:

Fillet (radius=0"):  Settings/Polyline/<Select first entity>: (Select a line.)

Important: Pick the part of the line you wish to keep, as illustrated below.

1. Pick one line.

2. And pick an
intersecting line.

4. And then select the second line:
Select second entity: (Select an intersecting line.)

progeCAD appears to trim the intersection by cutting back both lines to where they intersect.

Lines trimmed by
Fillet command.
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At this point, your drawing should look similar to the floorplan shown below.

 (If you had problems completing the previous tutorial, the apartment drawing is available as
2InteriorWalls.dwg.)
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In This Chapter

• QPrint command • Print command • Headers and footers
• Preview command • Export command • Mail command

at this point, your drawing should be looking good on your screen, but it would be great to
see it on paper. Let’s print the drawing now. Drawings are plotted with the Print or QPrint
commands.

(If you had problems completing the previous tutorial, the apartment drawing is available as
2InteriorWalls.dwg.)

Plotting vs. Printing
In the past, plotting and printing had different meanings:

• Plotting meant sending drawings to vector devices such as pen plotters. Ten to
twenty years ago, plotting produced much higher quality output than did printing,
because raster devices created cruder plots than did vector devices.

• Printing used to mean outputting drawings to raster devices such as dot-matrix
printers. In the last ten years, raster technology has been refined to the point that
nearly all CAD drawings are output on raster devices — either ink jet printers or laser
printers. The quality is as good as the pen plotters of yore, but the speed is much
faster.
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Common today is electronic plotting, where drawings are saved in file formats suitable for
sending by email or displaying at Web sites. The most common “eplot” formats are Acrobat
PDF and DWF, both of which can be created by progeCAD.

Because they now mean the same thing, I use the words “plot” and “print” interchangeably In
this chapter.

Plotting, Basically (Print)
To control the plotting process, you use the Print command. It dis-
plays the Print dialog box with its many options. For most plots, you
do not need to worry about most options, and so this part of the
chapter describes only the basic options.

(A complete description of the Print dialog box comes later in this
chapter under the “Advanced Options” heading.)

1. To print a drawing, enter the Print command:
Command: print

(Alternatively, select Print from the File menu, or press
Ctrl+P. The print button on the toolbar executes the
QPrint command, as discussed later.)

Notice that progeCAD displays the Print dialog box.

2. For now ensure that the most important options are set, as
listed below. In the Device tab, choose the printer from the
Printer droplist.

PRINT COMMAND

Displays dialog box to control
plotting of drawings.

Command: print

Alias: plot

Shortcut: Ctrl+P

AutoCAD: plot

Menu: File | Print

ALTERNATIVES

QPrint prints the current
drawing using the default
printer settings.

Export saves the drawing in
file formats that can be read
and printed by other programs.
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3. In the Scale/View tab, choose the following options:

Print Area: Extents

Print Scale: Scale to Fit

Paper Size: Inches

4. Before plotting, always, always, always perform a preview. It takes but a few seconds
and ensures the plot will turn out as you expect. Trust me, plotting has so many
options that there are bound to be one or more that are set incorrectly.

Preview lets you catch the mistakes before committing time, paper, and ink.

Click the Print Preview button. progeCAD immediately shows the floor plan as it
will appear on the printed page.
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5. If it looks satisfactory to you, click Print. progeCAD sends the drawing to the printer.
Wait a few moments for it to appear.

If you don’t like the arrangement or size, click Print Settings to return to the Print dialog box.

Quick Prints (QPrint)

For quick plots, enter the QPrint command (short for “quick
print”), or else click the Print button on the Standard tool bar.

Command: qprint

progeCAD immediately sends the drawing to the printer or plot-
ter.

The printing isn’t accomplished any quicker than with the Print
command; the difference is that you don’t have access to the op-
tions: there is no Print dialog box and no print preview.

When you enter the QPrint command, progeCAD reads the set-
tings of the Print dialog box and the default Windows system
printer. Then it prints the current viewport according to those set-
tings. (The very earliest releases of AutoCAD had a similar QPlot command, but it was re-
moved with v2.0.)

You can get a similar effect with the Preview command: after progeCAD displays the preview
window, click the Print button. progeCAD uses the stored print settings to control the plot.
(This is identical to the operation in Word: click the printer icon on the toolbar, and Word
sends the document to the printer using the default settings; select the Print item from the File
menu, and Word displays the Print dialog box.)

TIPS To adjust settings before using QPrint:
1. Enter the Print command.
2. Make changes to the Print dialog box.
3. Click the Apply button to force progeCAD to remember the changes.
4. Click Cancel to exit the dialog box, and then use the QPrint command.

To preview the plot, use the Preview command, and then click the Print button.

To select a different printer or plotter:
1. Use the PSetup command to display Windows’ Print Setup dialog box.
2. Make changes.
3. Click OK, and then use the QPrint command.

QPRINT COMMAND

Plots the current drawing us-
ing default values and printer.

Command: qprint

Toolbar: Standard | Print

ALTERNATIVE

Print displays dialog boxes for
controlling the plotting
process.
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Preview Prints (Preview)

As noted above, the Preview command lets you see what the plot
will look like before committing to printing it. It operates simi-
larly to the print preview feature in word processors and other
software.

1. From the File menu, select Print Preview.

(Alternatively, click the Print Preview button on the
toolbar, or else enter the Preview command.)

Command: preview

2. progeCAD displays the drawing in the preview window.
Along the top of the window are buttons for controlling
the preview:

Zoom In enlarges the drawing. Alternatively, you can click the cursor on the drawing.

Zoom Out makes the drawing smaller, and see more of it. After the drawing is fully zoomed
out, you can click the cursor twice more to make the drawing smaller again.

Print Settings closes the preview window, and then displays the Print dialog box.

Print closes the preview window, and then prints the drawing.

Cancel closes the preview window, and returns to the drawing editor.

? — displays on-line help.

TIP The PSetup command no longer exists. It has become the Device tab of the
Printer dialog box, as described below.

Advanced Options
Let’s return to the tabbed Print dialog box and examine the purpose of its options. First, the
options common to all three tabs.

Layout Name

The name of the current layout tells you which layout will be plotted. MODEL means model
space; LAYOUT means one of the layouts. You have to select a layout tab before starting the
Print command. (Layouts are discussed later in Chapter 11.)

PREVIEW COMMAND

Previews drawings before they
are plotted.

Command: preview

Aliases: pre, makepreview,
ppreview

Menu: File | Print Preview

Toolbar: Standard | Print
Preview
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Use Settings

You can save different plot settings for each layout. That allows you to set up layouts for differ-
ent printers, such as color and monochrome.

Settings allows you to copy settings from another layout.

Save Changes to Layout saves the settings to the layout on a layout-by-layout
basis. Here “layout” also refers to the Model tab.

Common Buttons

The bottom of the dialog box contains a row of buttons common to all tabs:

? displays online help.

Apply to Layout saves the options to the current layout; the next time you print
this layout, the options are restored.

Print Preview switches to the preview window; see Preview command.

Reset changes all options to their default values.

Print prints the drawings.

Exit closes the dialog box.

Device Tab

The Device Tab selects the printer or electronic format for the plot.

Printer

The Printer droplist specifies the printer. The list includes:

• Any printer set up for  your Windows computer.

• Printers connected over networks.

• Non-printer drivers, such as for fax software and Adobe PDF.

• Non-printers specific to Windows Vista, such as XPS Document Writer.

• Additional file formats, such as JPG or DWF.
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The Properties button displays the Properties dialog box specific to the printer. This is the
same dialog box you see in any other program.

Paper

The Format droplist lists all the sizes of media supported by the selected printer. This means
that the sizes listed vary, depending on which printer is chosen. The most common size is
Letter (aka A-size).

The Paper Orientation and Drawing Orientation radio buttons switch between Portrait
(upright) and Landscape (sideways). This does not change the paper going through the printer;
instead, this option rotates the drawing during printing, so that it fits the paper better.

Print to File

The Print to File check box determines whether the drawing is sent to the printer, or saved in
the printer’s data format in a file. (When you choose a format like JPG as the printer, then this
option is turned on by default.

Copies

The Copies text entry box specifies the number of copies to print of the drawing.
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Scale/View Tab

The Scale/View tab controls how much of the drawing is plotted, and at what size.

Print Area

The Print Area section tells how much of the drawing to plot. In most cases, you’ll select the
Extents option.

The options are:

Current view plots only as much of the drawing as is visible in the current view-
port.  That’s exactly the view at the time you entered the Plot command. If the
drawing is zoomed in, then only the zoomed-in portion is plotted.

Saved view plots named views defined by the View command. Select a view name
from the droplist; when no views are defined, this option is not available. By defining
views ahead of time, you can print selected areas of the drawing, such as a title block or a
detail view.
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Extents plots the entire drawing. This is the most commonly-used print area option,
because it ensures everything is plotted. Everything, that is, except entities on frozen
layers. Sometimes, drawings are printed really, really small, and you wonder why.
Usually, it’s because there are some entities way far, far away from the primary
drawing. You can check by performing a Zoom Extents before printing.

Limits plots the portion of the drawing within the limits defined by the Limits
command. The usefulness of this option is not clear to me, because limits are so
rarely used.

Window plots a rectangular area. You enter either the x, y coordinates of the lower left
and upper right corners of the area, or else click the Select Print Area button and then
pick two points to define the rectangle. This option is useful for printing a portion of the
drawing.

The Print only area within specified window check box prints just the entities within the
rectangular area you specified. Why might there be entities outside the area? Because the rect-
angle you select usually does not have the same aspect ratio as the paper on which it is printed.

On — only the entities (and parts of entities) within the selection rectangle are plotted.

Off — entities outside the selection rectangle are plotted, if they fit the page.

In the figure below, the large white rectangle represents the paper, while the inner rectangle is
the windowed plot area (designated by the first and second corner points).

Entities to Print

The Entities to Print area allows you to print just selected entities. Problem is, you need to
select the entities before you start the Plot command; then the second option becomes avail-
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able. Otherwise, it is grayed out:

All entities within the print area prints every non-frozen entity.

Selected entities within the print area prints only the entities you selected prior
to starting the Plot command.

In most cases, you’ll select “All entities within the print area.”

TIPS Both options have this disclaimer, “within the print area.” This means that this
option is subject to the option you selected under the Print Area section. For example, if
you previously selected the Window option, then only the entities within the window are
plotted.

Alternatively, you can select entities in the drawing, right-click, and then select
Print from the cursor menu.

Print to Scale

The Print Scale area lets you size the drawing.

You have two choices: have progeCAD automatically scale the drawing to fit the paper, or else
specify the scale factor that progeCAD must use. Click the droplist, and then select scale option:

Scale to Fit automatically adjusts the scale to squeeze the entire drawing to the
paper. No matter how big or small the drawing, progeCAD resizes it to fit the paper.
progeCAD reports the scale under Drawing units, such as 9'5".

1:1, etc specifies the scale factor for the drawing. Many disciplines work with specific
scales, such as 1:50 or 1"=250'.

Printed Units — the first number is the length on the paper (1"),

Drawing Units — the second number is the length in the drawing.
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All drawings are plotted in inches or millimeters, depending on the units of the paper and the
drawing:

Inches — uses inches (Imperial or British) units for the paper size. This allows you
to plot metric drawings on imperial paper, as is common in Canada.

Millimeters — uses millimeters (metric) units for the paper size.

TIPS The Paper size is set by the printer driver, which is accessed through the Device
tab Properties button.

The units of drawings are set with the Units command. Use decimal units for metric
drawings.

Advanced Tab

Don’t let the name of the Advanced tab intimidate you. It contains useful items, like plot centering
and footers for labelling plots.

Print Style Table (Pen Assignments)

The Print Style Table section assigns plot properties to entities, such as width, screening, and
lineweight. Don’t worry if you see the “none-device (missing)” name. It means that a plot style
has not yet been applied to the drawing.

Just as dimension styles affect the look of dimensions, plot styles affect the look of plotted
drawings. They allow you to make the look of drawings seen on the screen independent of their
look on paper. As noted earlier, there are two ways to assign plot styles: by colors and by enti-
ties.
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Color-based styles map entity colors to plotter parameters. In the old days, back when the
CAD universe was ruled by $20,000-pen plotters, this was the only way to do it: colors of
entities were not meant to identify them in drawings, but to specify how they would be plotted.

Pen plotters typically had eight pens, usually black and of varying widths, so drafters would
work with eight colors in their drawings. When it came time to plot, drafters specified which
entity colors would be plotted by which pens. Weird? Yah.

Today’s ink jet printers are capable of faking millions of colors and dozens of widths, so pen
mapping just isn’t needed anymore. But if you need to, here’s how: the drafter might decide
that all red entities should be plotted with the plotter’s pen #1. Pen #1 could be red, but more
often it would be black and a specific width. Once colors were mapped between entities and
plotter pens, the settings can be saved to .ctb (color table) files for later reuse.

Today, drafters don’t worry about matching pens; red entities are plotted red, and wide enti-
ties are plotted wide.

Entity-based styles map entities or layers to plotter parameters. When plot styles are en-
abled, the Explorer-Layer window displays an extra column so that you can assign plot styles.
Settings are saved to .stb (style table) files.

TIP Drawings must be switched between color and entity plot styles. Drawings cannot
have both styles at the same time. The plot style can be applied to new drawings only.

To switch between them, follow these steps:
1. From the Tools menu, choose Options.
2. In the Options dialog box, select the Printing tab.
3. In the  Default Plot Style Behavior section, choose either of:

• Use color-dependent print styles (.ctb files).
• Use named print styles (.stb files).

4. From the droplists, choose a .ctb or .stb file.

About Plot Style Tables

When drafters want fine control over plots, they use plot style tables.

To see a sample plot style, select icad.ctb from the Name droplist, and then click Edit.
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In the Print Style Table Editor dialog box, choose the Properties tab.

On the left are progeCAD’s standard 255 colors, under Print Styles. On the right are the
properties that can be assigned each color.

When a drawing is set up to use plot style tables, the dialog box looks very similar. The differ-
ence is that you see the names of plot styles, instead of the 255 entity colors. Each table can
contain one or more styles, as illustrated below.
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Color overrides the entity color with another color. To plot with the drawing’s own colors,
select “Use object color.” The “True color” option is not yet supported.

Pen # specifies which pen should plot the entity; range is 1 to 32. To let the printer determine
the pen number, choose “Automatic.”

Virtual Pen # specifies a virtual pen number. Laser printers support the concepts of virtual
pens, because they don’t actually have pens. Range is 1 to 255.

Screening specifies the amount of ink used for drawing objects. When set to a value less than
100%, the plotter uses many fine dots to print objects, instead of printing them in solid color.

Linetype overrides the entity linetype with another linetype. For example, you may want to
plot the entire drawing using dashed linetypes. To plot with the drawing’s own linetypes, select
“Use entity linetype.”

Adaptive determines whether linetypes are adapted to the length of entities. When this op-
tion is turned on, linetypes are forced to fit evenly between endpoints.

Lineweight overrides the entity line weight with another line weight. For example, you may
want to plot the entire drawing using a single line weight. To plot with the drawing’s own line
weight, select “Use object lineweight.”
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End Line Style specifies how the ends of lines (and other open objects) are plotted.

Line Join Style specifies how the corners of lines are plotted.

Fill Style specifies the fill pattern for objects. This options can be used in place of the Hatch
command.

Configuration File

You can save plot settings to .pcp files. This is useful for sharing the settings with other progeCAD
and AutoCAD users.

Open prompts you to select a .pcp (plotter control parameters) file to open.

Save saves the plotters settings in .pcp files.

Print Offset

progeCAD normally places the drawing in the lower left corner of the page. The Print Offset
area allows you to change this position.

Center on page centers the drawing on the page, when on. When off, the drawing is
placed in the lower left corner. Frankly, I don’t know why this option isn’t turned on
by default — centered plots look nicer.
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X, Y allow you to specify an offset distance. When you plot drawings on preprinted sheets,
you sometimes need to offset the drawing from the lower right corner of the page.

Print Options

Finally, a few last options:

Prints upside-down — turn on this option when you use preprinted paper and it is
inserted the wrong way in the printer.

TIP To produce mirrored plots, first mirror the entire drawing by pressing Ctrl+A
followed by Mirror. Plot the drawing, and then use the U command to un-mirror the
drawing.

Use Lineweight — when on, tells progeCAD to send the printer wider lines, as defined
by linetypes widths in the drawing. Generally, this option should be turned on.

Scale Lineweight — changes the lineweight appropriate for the scale of the plot.

Header and Footer

The header and footer options are useful printing identifying text along the top (header) and
bottom (footer) of plots. The header and footer  information can be anything useful, such as
the date of the plot or the file name. Simply type text in the text fields.

To specify headers and footers, use the Options command: From the Tools menu, select Op-
tions, and then choose the Printing tab.

Header specifies the text to place along top of the plot.

Footer specifies the text to place along bottom of the plot.

progeCAD includes some preset text, such as today’s date, the name and company of the regis-
tered user, and the word “Confidential.” Click the droplist to access the preset text.
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To see what the header and footer will look like in your plotted drawing, enter the Print Pre-
view command.

Electronic Plotting (Export)
Drawings can be plotted “electronically” with the Plot and Export commands. These saves
drawing files in formats suitable for display in Web pages and delivery by email, such as DWF
and PDF.

Export to DWF Format

DWF (design Web format) was developed by Autodesk in the late 1990s as a way to efficiently
transmit drawings by email. The format strips out all unnecessary information and greatly
compresses what remains to create replicas of drawings that are as much as 100x smaller.

For greater control over creating DWF files than provided by progeCAD, download the free
DWF Writer software from progeSOFT’s Web site at www.progesoft.com/?page=extras (scroll
to the bottom of the page). Install it like a printer driver, and then select it with the Plot com-
mand. To access its options, click the Properties button, and then the Advanced button.

progeCAD can read and write DWF files. While AutoCAD can write DWF files, it cannot read
them — ironically enough. To create DWF files of drawings, follow these steps:
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1. From the File menu, select Export.

(Alternatively, enter the export command.)
Command: export

2. In the Export Drawing As dialog box, click the Save as type droplist, and then
choose one of the following DWF dialects:

• Design Web Format (.dwf) — meant for 2D drawings.

• 3D DWF (.dwf) — meant for 3D drawings.

3. If necessary, use Save In to select a different folder and/or drive in which to save the
file.

4. Click Save. Notice the dialog box. It lets you control the format of the DWF file.

5. Choose the following options:

• DWF File Version — Version 6. (Only use an older version if recipients cannot
      read the .dwf files you send them.)

• DWF File Format — Compressed Binary File produces the smallest file format.

• Layout to Export — choose Export Current Layout or Export All Layouts,
depending on how much you want to include with the file. Note that “layout”
refers to both model tab and to layout tabs.

6. Click OK.

7. In the command bar, progeCAD asks which entities to export. Enter all to export the
entire drawing.

Select entities to export: all

Select entities to export: (Press Enter to continue.)
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progeCAD exports the drawing; look for it in the folder specified by the Look In droplist. The
files can be sent by email, added to a Web page, or viewed with viewing software. To view .dwf
files, download the free DWF Viewer software from : www.autodesk.com/dwf. The package
includes a stand-alone viewer and a plug-in for Internet Explorer.

TIP To import DWF files, follow these steps:
1. Enter the Import command.
2. Select “Drawing Web Format (dwf)” as the file type.

Plot to PDF Format

PDF is short for “portable document format,” a format created by Adobe for viewing docu-
ments. In recent years, it has also become popular for viewing and transmitting CAD drawings.
To view .pdf files, you need the free Acrobat viewer software, available from www.adobe.com/
acrobat.

To export drawings in PDF format, follow these steps:

1. Start the Plot command.

2. In the Print dialog box’s Print tab, click the Printer droplist, and then choose
“ProgeSoft PDF Wizard.”

3. Change other options in the dialog box, as required.

4. Click Print. Notice the dialog box.

5. Enter a file name. If necessary, change the folder and drive in which to store the PDF
file.

6. Click Save. progeCAD generates the PDF file, and then asks if you wish to see it.

7. Click Yes, and the file is opened in Acrobat Reader.
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Import PDF to DXF

progeCAD can read 2D and 3D PDF files, but in an indirect manner: the Pdf2Cad command
converts the PDFs to DXF format. Vector data in PDF files are converted to vectors; images in
the PDF files are attached as JPEGs. (DXF was invented by Autodesk in the mid 1980s as a way
to exchange drawings; it is short for “drawing interchange format.”)

To import PDF files, follow these steps:

1. From the File menu, choose Convert PDF to DXF.

2. In the Pdf2CAD dialog box, enter the name of the PDF file; click Browse if you need
help locating it.

3. You can leave all of the options as they are. Here’s what they mean:

Minimum line width — specifies the lineweight of imported entities.

Dashed/Dotted lines a segment — dashed lines are broken into segments.

Fill attribute of object — specifies how to handle filled areas:

• Keep fills keeps filled areas as they are.

• Outline all fills removes all filled areas.

• Remove white fills removes only fills that are colored white.

4. Click Convert.

The PDF file is converted, and then attached to the drawing; non-vector entities are
attached as a JPEG image.

Other Formats

progeCAD can export drawings in other electronic formats, all defined by Microsoft:

• BMP is a raster bitmap format.

• EMF is the enhanced metafile format, an improvement over WMF.

• WMF is the Windows metafile format, a kind of vector format.

• SVG is scalable vector graphics format.

SVG is the approved standard for displaying vector images (i.e., CAD drawings) on the Internet.
Although it is an official standard, it isn’t used much, although progeCAD can export it throuigh
the Export command. Once created, you can view the files with Internet Explorer, provided the
appropriate plug-in is installed.
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Learn more about SVG at www.w3.org/Graphics/SVG.

Sending Drawing Packages (eTransmit)

With the help of  the eTransmit command, you can send a drawing and all of its related support
files in a single package for transmission over the Internet or on a CD.

When sending drawing files to other users , it is can be necessary to attach dependent files,
such as xrefs, images, and fonts. If these files are missing, then it becomes impossible for the
recipient to view and edit the drawings correctly.

The eTransmit automatically includes dependent files in a transmission package, reducing er-
rors down the road. If you wish, you can manually add other files to the package, such as docu-
ments, spreadsheets, and other drawings. You can also remove files from the package that
eTransmit automatically added, such as those that might be restricted due to reasons of copy-
right or confidentiality.

TIP If you want to send only a .dwg file, use the Send command from the File menu,
as described below.

To create a group of files for transmission, follow these steps:

1. From the File menu, select eTransmit. (Alternatively, enter the eTransmit com-
mand.)

2. Notice that the Create Transmittal dialog box lists the name of the current drawing
file (5Dimensionsl.dwg, in the figure below) and names of dependent files
(icad.fmp).

The Create Transmission dialog box contains two two tabs that let you view and
change the files to be added to the transmission package:

Files Tree lists files in order of dependency. You can expand each drawing file to
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view the related dependent files that progeCAD adds automatically to the transmis-
sion package. To remove dependent files that you don’t want to include in the trans-
mission package, click the check boxes to remove the check mark.

Files Table lists files in alphabetical order. This is a summary table that presents the
names files, the paths of relative folders, and file details. You can select and deselect
each file by clicking the check boxes.

3. To add files, click the Add File button. progeCAD displays the Add File to Transmit-
tal dialog box. Choose a file, and then click Open.  Repeat to add additional files.

4. Enter notes to include with this transmittal package. The notes are for the persons
who receive the transmission package. (Later, eTransmit will generate a report file
automatically that contains the list of the files present in the transmission package.)
The contents of this report are displayed when you click the View Report button.

5. You can further fine-tune the transmittal with the Transmittal Setups options.

Transmittal Setups

Transmittal setups allow you to change settings of transmission packages.

If you need to send transmission packages several times within one project, it is better to save
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it as a transmittal setups. The default setup is Standard. The Create Transmittal dialog box
shows you a list of saved setups from which you can choose each time when you transmit a
group of files.

To create new transmittal setups, follow these steps:

1. Click Transmittal Setups.

2. Notice the Transmittal Setups dialog box. It lists the names of saved setups, and lets
you rename, modify, or delete them. (You cannot rename or delete the default setup,
named “Standard.”)

3. Click New to create a new setup.

4. Notice the New Transmittal Setup dialog box. Enter a name that describes the new
setup.

For this tutorial, enter “Boardwalk,” and then click Continue.

5. Notice the Modify Transmittal Setup dialog box. The settings in the dialog box allow
to you to specify the following options:

• Compress the transmission package in a ZIP file or in a folder that is copied to
a specified location.

• Specify if the folder structure of the transmission files should be organized
according to a logical hierarchy, inserted in a single folder, or copied to the
addressee’s computer as-is. If a FTP or HTTP destination is specified, the
transmission package uses the single folder option.

• Include .shx fonts used in the drawing, add password protection to the trans-
mission package, set the default printer to “None,” and send an email auto-
matically after the transmission package creation is completed.
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After creating the transmission package, you can make it available through the Internet or you
can send it to other users as an email attachment. If you send the transmission package via
email, there is an option in the Modify Transmittal Setups dialog box that launches the default
system email application automatically, and attaches the transmission report file.

TIP Full (absolute) paths of dependent files are converted to relative paths or "no
path" to ensure that the drawing file can identify the dependent files.

6. Change options, and then click OK.

7. Notice that the Transmittal Setups dialog box now contains the new setup.

Click Close.

8. In the Create Transmittal dialog box, choose Boardwalk, and then click OK.
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(If you chose the “Ask for name” option in the transmittal setup, then progeCAD
prompts  you for the file name and folder at this point.

If you chose the “Send email with transmittal” option, then progeCAD creates a new
message with your default email software, and adds the transmittal package as an
attachment.)

Emailing Drawing Files (Send)

progeCAD can send the current drawing as an attachment to email messages. From the File
menu, select the Send command.

progeCAD creates a new message in your computer’s default email software, and adds the
current drawing as an attachment.
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with the walls in place, it’s time to populate the interior of the apartment. You need to
add doors and windows, as well as furnishings. In this chapter, you create a door and
a window from scratch, and then turn them into blocks (symbols), which are placed

into walls. Later in this chapter, you learn how to insert ready-made symbols
of furnishings and how to access symbol libraries on the Internet.

The fixed amenities include the bathroom fixtures, kitchen arrangement,
and the fireplace. These remain part of the unit when it is purchased and
sold.

Non-fixed amenities are provided by the purchaser; they are shown only
to give an idea of how parts fit in the living spaces. These include the
living room furniture, dining table and chairs, and bed.

C • H • A • P • T • E • R 10

Creating Symbols
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In This Chapter

• Rectangle command • Arc command • Block command
• Insert command • DdInsert command • ExpBlocks command
• WBlock command • ALE block librarian
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Create Door and Window Symbols
When you need to draw the same kind of thing over and over, it makes sense to use blocks.
Blocks are symbols. Floor plans, for instance, use lots of doors. Looking at our floor plan, it
looks like about eight doors are needed.

Instead of drawing eight doors, it makes sense to draw one style of door, and then make copies
of it. You could use the Copy command, but doors are made of several lines and arcs, and it can
be tricky copying groups of lines. It’s better to turn the group of entities into a single entity.
You do this with the Block command.

To plan the doors, I printed out the drawing, and then sketched in the doors that are needed.

Looking closely, there are at least two kinds of doors: regular doors for entering rooms, and bi-
fold doors for closets. Among entrance doors, exterior doors are usually larger (36") to make it
easier to move furniture in and out, while interior doors are usually smaller (32") so that they
take up less space. In summary, the following types of door are needed:

Type of Door       Number Needed

36"-wide exterior door 2
32"-wide interior door 4
Bi-fold door 2
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That means you need three blocks, one for each type of door. Creating and placing symbols
takes these steps:

1. Draw the symbol with the Line, Arc, and other drawing commands. (In this book, I
use the term symbol for entities before they are turned into blocks.)

2. Convert the symbol into a block with the Block command.

3. Insert the block into the drawing with the Insert command.

(If you had problems completing the previous tutorial, the exterior walls drawing is available
as 2InteriorWalls.dwg.)

Step 1: Draw Door Symbols (Rectangle, Arc)

Door symbols consist of thin rectangles that represents doors, and arcs that show the swing of
doors. Doors are usually shown open at 45 degrees. Symbols are often simplified representa-
tions of physical objects, so the door lacks details, such as hinges and knobs.

Here’s is how to draw the first door, the 36" -wide, 2"-thick exterior door symbol.

1. In progeCAD, press Ctrl+N to start a new drawing. (If
you are prompted for a template drawing, press Enter
or respond with none.)

2. Turn on SNAP, GRID, and LWT modes by double-
clicking the words on the status bar.

3. To draw the 36" x 2" door rotated at 45 degrees, use the
Rectangle command, as follows.

a. From the Draw menu, select Rectangle.

(Alternatively, enter rectangle at the command
prompt, or select the Rectangle button from the
Draw 2D toolbar.)
Command: rectangle

b. Specify the rotation option, “r”. progeCAD will ask
later for the angle, after you specify the rectangle’s size.

Chamfer/Elevation/Fillet/Rotated/Square/Thickness/Width/
<Select first corner of rectangle>: r

RECTANGLE COMMAND

Draws rectangles.

Command: rectangle

Aliases: rectang, rect, rec

Menu: Insert| Rectangle

Toolbar: Draw 2D | Rectangle

Options: Chamfer

Elevation

Fillet

Square

Thickness

Width

ALTERNATIVES

Polygon draws regular
polygons.

Line draws lines.
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c. Indicate the two opposite corners of the rectangle:
Chamfer/Elevation/Fillet/Square/Thickness/Width/<Select first corner of rectangle>: 0,0

Other corner of rectangle: 36,2

d. And then specify the angle of 45 degrees:
Rotation angle for rectangle <0.0000>: 45

(If you cannot see the entire rectangle, use the Zoom Extents command:
Command: zoom

Zoom: In/Out/All/Center/Extents/Left/Previous/Right/Window/<Scale (nX/nXP)>: e

2. Other corner:
(36,2)

1. Start of rectangle:
Origin (0,0)

3. Rotation angle:
45 degrees

4. Indicate the door swing with the Arc command:

a. This arc is defined by its starting point, center point, and angle of rotation:
Command: arc

b. Use entity snap modes to start the arc at the end of
the rectangle, as follows:

Start of arc: end

Snap to endpoint of: (Pick point 1.)

c. The center of the arc is the origin of the door, (0,0).
Use the Center option, and

then specify the origin, as follows:
Angle/Center/Direction/End/Radius/<Second point>: c

Center of arc: 0,0

d. The end of the arc is defined by the angle. progeCAD
measures angles

counterclockwise, so you need to specify a negative
angle of 45 degrees:

Angle/Length of chord/<End point>: a

Included angle for arc: -45

ARC COMMAND

Draws arcs.

Command: arc

Alias: a

Menu: insert| Arc

Toolbar: Draw 2D | Arc

Options: Start

Center

Angle

Direction

Radius

End

Follow

Length of Chord

ALTERNATIVES

Polyline draws polylines and
polyarcs.

Ellipse draws elliptical arcs.
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Eighteen Ways to Draw an Arc

Arcs are one of the hardest entities to draw with CAD, because it can be difficult to determine
ahead of time how they will turn out. And, because there are 18 ways to draw an arc! In
general, progeCAD works with any 3 of the eight parameters illustrated by the figure below:

Direction

Start

Center

End

Angle

Len
g
th

 o
f C

h
o
rd

Radius

Second
point

Arc Drawing Methods

The Arc command initially prompts you for the location of the arc’s center or start points. After
that, it prompts you for two other parameters, as listed by the table below. After you draw one
arc, progeCAD has two more prompts that connect the new arc to the previous one: Use last
point and Follow.

Initial Prompt Second Prompt Third Prompt

Center Start Angle
Length of chord
End point

Start of arc Angle Center
End point

Center Angle
Length of chord
End point

Direction End point

End Angle
Direction
Radius
Center point

Radius Angle
End point

Second point End point

Use last point End of arc

Follow End of arc
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1. Start of arc:
ENDpoint snap

2. Center of arc:
Origin (0,0)

3. Angle of arc:
-45 degrees

With the symbol drawn, it should look like this:

Door Swing

36" Door

Location
of Hinge

The next step is to turn the symbol into a block, so that it can be reused in this and other
drawings.

Step 2: Convert to Blocks (Block)

The Block command converts collections of entities into a single entity, called a “block.” Here’s
how to do it.

1. From the Draw menu, select Block, and then choose Make.

(Alternatively, enter the block command, or click the Create Block button on the
Tools toolbar.)

Command: block

Notice the Block Definition dialog box. To create a block, progeCAD needs to know
three things: (1) a name for the block; (2) its base point; and (3) the objects that make
up the block.
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2. Blocks are known by their names. To help sort large
collections of blocks, it makes sense to name blocks
logically.

For instance, I’ve named this block “door-36-exterior”
— a name goes from the general (“door”) to the specific
(width and type). In this way, all the door blocks are
listed together.

Name: door-36-exterior

3. When you later place the block in the drawing, the point
you pick is called the “insertion point.” You need to tell
progeCAD where that insertion point needs to be.

Most often, you would click the Pick Point button, and
then pick a point that makes sense, like one corner or
the center of the symbol.

For this door, pick the location of the hinge, which just
happens to be at the origin:

X: 0

Y: 0

Z: 0

4. Now you get to select the entities, i.e., the rectangle and the arc.

a. Click the Select Entities button.

b. Notice that the dialog box disappears (temporarily), and that progeCAD is
      prompting you in the command bar:

Select entities: all

Select entities: (Press Enter to return to the dialog box.)

Back in the dialog box, progeCAD reports the number of entities it found:
2 objects selected

5. The last step is to decide on the fate of the symbol:

• Retain — creates the block definition, and retains the symbol in the drawing.

• Convert to block — creates the block definition, and inserts it into the drawing.

• Delete — creates the block definition, and erases the symbol.

BLOCK COMMAND

Creates blocks from entities.

Command: block

Alias: -b

Menu: Tools | Create Block

Toolbar: Tools | Create Block

Options: Name

Insertion Point

ALTERNATIVES

Group groups entities
together.

WBLock exports blocks and
drawings to .dwg files.
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Choose the Convert to Block radio button.

6. Click OK to end the command.

7. Save the drawing with the SaveAs command, using the name “Door-Exterior-
36.dwg.”

Sharing Blocks (ExplBlocks)

You created the block in one drawing, but need to use it in another. Sharing blocks between
drawings is a easy as copy’n paste. (If you had difficulty creating the 36" exterior door block,
you can access it from the door-exterior-36.dwg file.)

1. Open the Explorer to the blocks section with the b alias, a shortcut for the ExpBlocks
command.

2. In Explorer, select the “door-36-exterior” block, and then press Ctrl+C. This copies
the block to the Clipboard.

2. In Explorer’s Elements pane, select  to the 2InteriorWalls.dwg file.

3. Select Blocks, and then press Ctrl+V. (Or, right-click and then choose Paste.)



chapter 10: creating symbols 143

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

The block definition is added to the drawing, and appears in Explorer.

Step 3: Insert Blocks (Insert)

You now place the door block in the floor plan drawing. Technically, you insert the block defi-
nition to create block instances. There are two ways to place blocks in drawings:

• With the Explorer.

• With the Insert command.

We’ll use both methods, one for each block insertion.

1. First, change the working layer to “Assets-Fixed.”

2. The first door to be inserted is the entrance from the hallway, the door at the bottom
of the floor plan. It’s helpful to zoom to it, so use the Zoom Window command:

Command:  z

Zoom:  In/Out/All/Center/Extents/Left/Previous/Right/Window/<Scale (nX/nXP)>: w

First corner: (Pick a point.)

Opposite corner: (Pick a point.)

3. On the Explorer’s toolbar, click the Insert button.

4. On the command bar, progeCAD prompts you:
Command: _insert

? to list blocks in drawing/BROWSE/EXPLORE/<Block to insert> <DOOR-36-EXTERIOR>:
DOOR-36-EXTERIOR
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Notice that progeCAD runs the Insert command and fills in the name of the block for
you.

5. Use the NEArest entity snap to help you insert the block accurately:
Multiple blocks/<Insertion point for block>: nea

Snap to nearest of: (Pick a point on the wall.)

6. You have the option of scaling and rotating blocks during insertion, but this time you
don’t do this. Press Enter at each of the following prompts:

Corner/XYZ/X scale factor <1.000000>: (Press Enter to accept the default value.)

Y scale factor: < Equal to X scale (1.000000)>: (Press Enter to accept the default value.)

Rotation angle for block <0>: (Press Enter to accept the default value.)

7. The door block is inserted. But there is the matter of the door frame: it doesn’t exist.
Draw the door frame as a pair of lines, using the appropriate entity snaps:

Command:  line

Start of line: int

Snap to intersection of: (Pick at the door’s hinge point.)

Angle/Length/<End point>: per

Snap to perpendicular of: (Pick a point on the opposite wall line.)

Angle/Length/Follow/Undo/<End point>: (Press Enter to end the command.)

INTersection
at swing arc

PERpendicular
to wall line

INTersection
at door hinge

PERpendicular
to wall line
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8. Draw the line for other side of the frame:
Command:  line

Start of line: int

Snap to intersection of: (Pick at the door’s swing arc.)

Angle/Length/<End point>: per

Snap to perpendicular of: (Pick a point on the opposite wall line.)

Angle/Length/Follow/Undo/<End point>: (Press Enter to end the command.)

9. Use the Trim command to cut away the unneeded portion of the wall.
Command:  trim

Select cutting entities for trim <ENTER to select all>: (Pick one door line.)

Entities in set: 1

Select cutting entities for trim <ENTER to select all>: (Pick other door line.)

Entities in set: 2

Select cutting entities for trim <ENTER to select all>:  (Press Enter to end selection.)

Cutting Entity 2

Entity to trim 1

Cutting Entity 1

Entity to trim 2

Edge mode/Fence/Projection/<Select entity to trim>: (Pick one wall line.)

Edge mode/Fence/Projection/Undo/<Select entity to trim>: (Pick other wall line.)

Edge mode/Fence/Projection/Undo/<Select entity to trim>: (Press Enter to end command.)

Don’t forget to create and insert blocks of the interior doors (32" x 2") and the bi-fold closet
doors (24" x 1"). They are both available as Door-Interior-32.dwg and Door-Bifold-48.dwg.
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Inserting Blocks Upsidedown

Now insert the same block, but at the other end of the apartment: the door to the patio. This
door swings in, so that when open, the door is against the living room wall. This time, use the
Insert command, as follows:

1. Start the Insert command.

(Alternatively, from the Insert menu, select Insert
Block, or from the Draw 2D toolbar, select Insert Block.)

Command: insert

2. progeCAD prompts you for the name of the block. Be-
cause this is the same block as before, you can press
Enter to accept the default name.

Command:  insert

? to list blocks in drawing/BROWSE/EXPLORE/<Block to insert>
<DOOR-36-EXTERIOR>:  (Press Enter to accept default.)

3. Use NEArest entity snap to locate the insertion point on
the inner wall line.

Multiple blocks/<Insertion point for block>: nea

Snap to nearest of: (Pick a point on the inner wall line.)

Notice that progeCAD ghosts an image of the block. That allows you to see where the
block will end up.

4. The block is not, however, positioned correctly. The block needs to be flipped hori-
zontally and vertically. progeCAD does this when you specify negative scale factors,
as follows:

Corner/XYZ/X scale factor <1.000000>: -1

Y scale factor:  < Equal to X scale (-1.000000)>: -1

5. Specify zero for the rotation angle:

Rotation angle for block <0>: 0

INSERT COMMAND

Inserts blocks with prompts in
the command bar.

Command: insert

Options: Name

Scale Factors

Rotation Angle

ALTERNATIVES

DdInsert inserts block via
dialog box.

Xref inserts drawing files.

XBind converts xrefs into
blocks.
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6. Use the Line and Trim commands to cut out the door opening, and then save the drawing.

Add Window Blocks (Unit Blocks)

The apartment needs windows. The sketch shows their location and length.

Window symbols typically look like this:

Pane

1"

6
"

Insertion Point

The center line represents the window pane; the other lines are the outline of the window
frame.

The symbol is 6" tall, because this window fits the 6" exterior walls. But why is it just 1" wide?

Because it is a unit block. Unlike the door block, whose size does not change, unit blocks change
their size upon insertion. For example, the windows you need are 72" and 48" long.

By drawing the block 1" long, the scale factor determines the inserted length. Need a 72" win-
dow? Specify 72 as the x-scale factor. It’s that easy.
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Follow these general steps to create the window block and insert it in the drawing:

1. Start a new drawing.

2. Draw the 1 x 6 window symbol with the Line command.

3. Convert to a block, naming it “Windows-Exterior.” Use the lower left corner as the
insertion point.

4. Save the drawing as “Window-Exterior.”

5. Using Explorer, copy and paste the block to the floor plan drawing.

6. This time, use the DdInsert command to place the window blocks. The command
displays a dialog box for specifying the insertion parameters.

1. Select
block name

3. Select block
insertion point

4. Specify
scale factor

5. Click
Insert

2. Turn off
option

From the Block name droplist, select the name of the block, “Window-Exterior.”

Turn off the Position block when inserting option. When on, you specify the
position in the drawing; when off, you specify parameters in the dialog box.

7. Click the Select button. In the command bar, progeCAD prompts you to pick the
insertion point. Use the NEArest entity snap to aid you:

Select insertion point: nea

Snap to nearest of: (Pick a point on the inner wall line.)

8. Change the Scale Factor: X to 72. This stretches the block to 72".

9. Click Insert. The window appears in the drawing at the correct location and width.

10. Repeat for the bedroom window.  The final result should look similar to the figure
below.

11. Save the drawing.



chapter 10: creating symbols 149

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567
12345678901234567890123456789012123456789012345678901234567

ALE Block Librarian

progeCAD includes a sophisticated block libriarian for managing symbols on your computer.
ALE lets you work with categorized blocks, previews them, and lets you preset the scale factor
and rotation angle.

To access ALE, enter the ale command at the ‘Command:’ prompt.

Insert Blocks from Disc

The power behind blocks is that you don’t need to create them from scratch. Instead, you can
use libraries of blocks created by others. For example, the following blocks are stored in draw-
ing files found in the \PlumbingBlocks folder provided with this book:

Follow these steps to insert blocks stored in drawings on disc:

1. Use the i alias to open the Insert Blocks dialog box.

2. In the Insert section, select From File.

3. Click Browse, and then go to the \PlumbingBlocks folder.
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3. Select the Tub-Topview.dwg file. Notice the preview window lets you see the block in
the drawing.

4. Click Open, and then place the block in the bathroom  by clicking Insert.

Finish the drawing with the fixed assets in the kitchen and bathroom. (Kitchen
counters are often 30" deep.) When you are done, the floor plan should be something
like the figure below.
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TIPS Any progeCAD .dwg drawing file can be used as a block in drawings; it doesn’t just
need to be drawings of symbols.

Just as you can open drawings from disc, you can also save blocks to disc. Use the
WBlock command to save

• Selected entities.
• A specific block.
• Two or more blocks.
• The entire drawing.

Obtain Blocks from the Internet
Numerous companies and government agencies provide pre-drawn symbols free from the In-
ternet. Companies often provide symbols free in the hope that you will specify their products,
boosting sales. Government agencies provide them free to encourage standardization.

You can find CAD symbols on the Internet by searching Google with terms like “CAD symbols
free” and “DXF blocks free.” See the boxed text for sources of symbols.
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Symbol Sources on the Internet

Ceco.net has a set of three thousand symbols for sale, but also a selection of free blocks from
www.ceco.net. Click on Free Blocks of the Month.

Kohler has 2D and 3D symbols in DXF, DWG, and i-drop formats freely available from
www.us.kohler.com/tech/cadsymbol/cadsymbol.jsp. The company specialized in residential and
commercial fixtures for bathrooms.

You can download groups of symbols, or all of them. All 2D symbols is a 6MB download from
www.us.kohler.com/tech/dxffile/All2d_dwg.exe. For plan views, use the drawing files that have
“pln” in their name. Illustrated below is 1157pln.dwg:
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To figure out which file you need, refer to Kohler’s “View Symbol List” at www.us.kohler.com/
tech/cadsymbol/symbols.jsp?module=All. For example, model numbers up to K-1600 are bath-
tubs; K-4000 series are bidets; K-1000 series are body spas; K-5000 are drinking fountains;
and so on.

Kit3D Models has 50 free furniture models available at www.kit3dmodels.com. Click on Free
Download. The 3D symbols from this Spanish Web site are of modern furniture.

Thomas Register has millions of CAD drawings from thousands of manufacturers at
www.thomasregister.com. The symbols are specific to manufacturing products, such as air
conditioning units, braking systems, and electronic controls. You have to register with the site
before being able to access symbols.

SteelCase provides a difficult-to-access software catalog of their office furnishings at
www.steelcase.com/na/furniture_symbol_library_FSL.aspx?f=25196 . It requires that you reg-
ister your mailing address with SteelCase, download a large software program, which runs in
AutoCAD or MicroStation.

Human Figure Library at www.sum-cd.com has DXF files of people, cars,
trees, and so on. A selection of 20 people files is available free. The text at the
Web site is mostly Japanese (I think) but there was enough English for me to
navigate around.

DesignCenter Online is Autodesk’s free Web-based collection of blocks of
architecture, mechanical, and electronics. Symbols are provided by CAD Easy
<www.cadeasy.com> and are saved in DWG format, or dragged directly into
drawings using i-drop. It seems to me that you can only access this site if you
use AutoCAD’s ADCenter command’s DC Online feature, illustrated below.
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SteamCad is a collection of American steam locomotives drawn in AutoCAD at
steamcad.railfan.net. All are free. Included in the collection is my favorite steam locomotive,
the Shay. Site is slow loading and downloading.
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with the drawing of the walls and blocks largely complete, you need to add text to provide
explanations of the apartment’s features. This chapter describes how to place and edit text. It
also shows how to add drawing borders and title blocks.

Important parts of drawings are labeled. Typical labels for floor plans include identification of
the rooms and other areas. The figure below illustrates text to be added to the drawing.

C • H • A • P • T • E • R 11

Placing Text
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In This Chapter

• Text command • Style command • DText command
• MText command • DdEdit command • MView command
• MSpace command • PSpace command
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Placing Text (Text)
Begin by labeling the living room with the Text command.

1. Use the Layer command to create a new layer, “Text.”
Ensure the layer is current.

2. Start the Text command: from the Draw menu, select
Text, and then choose Single Line Text.

(Alternatively, click the Text button on the 2D Draw
toolbar, or enter the text command in the command bar.)

Command: text

3. Don’t let the command’s many options concern you. For
now, just click anywhere along the left edge of the living
room area.

Text: Style/Align/Fit/Center/Middle/Right/Justify/<Start point>:
(Pick a point.)

4. Next, progeCAD wants to know the height of the text.
Height of text <0">: 12

TIP Q: How tall should text be? A: Tall enough to be legible when plotted.

The standard for text in drawings is 1/4", while headings are a bit taller at 3/8". If you
were to use those numbers for text in this drawing, however, the text would be too small.

Instead, you need to make the text bigger, so that it appears 1/4" tall when printed out.
How much bigger?

Recall that the Print command’s dialog box reports the scale factor (see Chapter 9).
progeCAD scales the drawing smaller so that it fits the page. For this drawing, the scale
factor reported by the Print command is 1" = 4' or 48x smaller.

For 1/4"-tall text to be legible, it has to be 48x larger, or 48 x 0.25" = 12" tall.

5. Text can be placed at any angle. This text is horizontal, 0 degrees.
Rotation angle of text <0>: (Press Enter to accept default value.)

6. Finally, you get to enter the text:
Text: Living Room

TEXT COMMAND

Places lines of text.

Command: text

Aliases: -t, tx

Menu: Insert | Text

Toolbar: Draw 2D| Text

Options: Style

Justification

Height

Rotation

ALTERNATIVES

MText places paragraphs of
text.

DText repeats the ‘Text:’
prompt.

Leader places text with
leader lines and arrows.
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progeCAD places the text. But it looks kinda rough, as the figure below illustrates.  The font,
called “Txt,” was designed in the early 1980s, when computers were slow. To make the display
of text fast, all letters were made of straight lines; there are no rounded parts. For instance, the
letter “o” is made of eight short lines.

To get nicer looking text, use a different font. progeCAD can use any font that works with
Windows. (These are called “TrueType” fonts, and have an file extension of .ttf.) As well,
progeCAD can use any font that come with AutoCAD, with the file extension of .shx.

Creating Styles (Style)

To use a different font in drawings, you use the Style command.

You may have noticed that the Text command lacked a “Font”
option for specifying the font name. That’s because fonts are se-
lected with the Style command. You may be familiar with styles
in documents: styles define fonts and their properties for head-
ings, paragraphs, and so on — bold, underlined, superscript, and
so on. progeCAD also uses styles to define the look of text.

To change the font used for the “Living Room” text, follow these
steps:

1. In the command bar, enter style:
Command: style

Notice that progeCAD displays the Text Style dialog box.

2. In the Text Font area, click the Name droplist.

Select the “Arial” font, because this font is available on every computer. And it looks
better than the Txt font.

3. Click OK. Notice that the “Living Room” text instantly changes to Arial font.

STYLE COMMAND

Creates and modifies text
styles.

Command: style

Aliases: st, font

ALTERNATIVES

-Style creates styles at the
command prompt.

ExpStyles displays the
Explorer Styles window.
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Controlling Text Styles

progeCAD provides three ways to create and change text styles:

• Style command displays a dialog box.

• -Style command prompts in the command bar; it is meant primarily for use in
macros and LISP.)

• ExplStyles command displays the Explorer-Text Styles window.

All three do the same job; they just have different user interfaces. Try each out to see which
you prefer. Here is what Explorer-Text Styles looks like:

The options have the following meaning:

Height specifies the height of the text. When set to 0, the Text command prompts you for a
height.

Width Factor makes characters wider (values over 1.0) or narrower (less than 1.0). Using a
value of 0.85 allows you to squeeze in 15% more text per line, while keeping text legible.

Oblique Angle slants the characters forward (positive angles) or backward (negative). The old
way of creating italic-looking text before italics became common in fonts.

Font name selects the font file from those available on your computer.

Backwards draws text backwards; used for printed circuit board drawings.

Upside down same as specifying 180 degrees for the rotation angle.

The following options are available only for those fonts that support the feature:

Vertically draws text vertically, one character below the next.

Style selects normal, bold, italic, or bold italic.

Language selects the language type.

Bigfont used for .shx fonts with Chinese and Japanese characters.
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4. The closet labels are at right angles. Specify a rotation angle of 90 degrees, as follows:
Command: text

Text: Style/Align/Fit/Center/Middle/Right/Justify/<Start point>: (Pick inside closet.)

Height of text <1'-0">: (Press Enter to accept default height.)

Rotation angle of text <0>: 90

Text: Closet

TIPS Text is just like other entities: you can use the Move and Copy commands to
reposition text.

Not all editing commands work on text; for example, you cannot use the Stretch
or Explode commands.

Label Drawings (DText)

Repeatedly providing the options that don’t change — height and
rotation angle — gets annoying after a while. progeCAD has a sec-
ond text command, called DText (short for “dynamic text”), that
asks for them once, and then lets you repeatedly pick the insertion
point to place the text. This command is excellent for placing la-
bels in drawings.

1. To place the remaining room labels, enter the DText
command in the command bar:

Command: dtext

2. The following prompts are identical to that of the Text
command:

Text: Style/Align/Fit/Center/Middle/Right/Justify/<Start point>:
(Pick a point in the drawing.)

Height of text <1'-0">: (Press Enter.)

Rotation angle of text <0>:  (Press Enter.)

Text: (Enter a room label, such as Kitchen.)

Notice that the text appears, letter by letter, as you type. When you press Enter, the
command does not end. Instead, the ‘Text:’ prompt repeats itself.

3. Position the cursor in another room, and then click. This indicates the new insertion
point. Enter the room label.

Text: (Move the cursor, and then click. Enter another room label, such as Bedroom.)

DTEXT COMMAND

Places lines of text, repeating
the ‘Text:’ prompt.

Command: dtext

Alias: dt

Options: Style

Justification

Height

Rotation

ALTERNATIVES

MText places paragraphs of
text.

Text places lines of text.

Leader places text with
leader lines and arrows.
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4. Finish labeling the floor plan: add text to the dining room, and so on.

5. When done, press Enter at the ‘Text:’ prompt to exit the command.
Text: (Press Enter.)

When done, the drawing should look similar to the figure below. Save your drawing.

Editing Text (DdEdit)
Did you notice that “Ensuit” was misspelled? The DdEdit command allows you to change the
wording of text, and correct mistakes. (DdEdit is short for “dynamic dialog editor.”) You  double-
click misspelled words to correct mistakes.
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Understanding Text Justification Modes

If you have difficulty placing text, it could be a problem with insertion points and justification.

Text entities have an insertion point, just like blocks. For text, the insertion point is where the
text starts. To see the insertion point of text, select it: the green grip is located at the insertion
point. You can use the INSertion entity snap with text.

But the insertion point can move around, depending on the justification. Justification tells
progeCAD where to start the text. There are 15 justification modes, of which you use three
most often:

Left — the default, a.k.a. “Start point.”

Right — for right-justified text.

Center — for center-justified text.

Living RoomMiddle
RightStart Text

(Left)

The others are Align, Fit, Middle, TL, TC, TR, ML, MC, MR, BL, BC, and BR, as illustrated below.

Align (text keeps its width factor) and Fit (text keeps its height) justification modes:

Living Room
Align

Align

Living Room
FitFit

And the many two-letter justification modes:

Living Room
TR
(Top Right)

MC
(Middle Center)

BC
(Bottom Center)

BR
(Bottom Right)

TC
(Top Center)

BL
(Bottom Left)

TL
(Top Left)

MR
(Middle Right)

ML
(Middle Left)
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TIP It is also possible to do spell checking of any text, including single-line text,
multiline text, text in block attributes, and in external references.

To run the spell checker, enter the Spell command, or else choose Tools | Spell Check
from the menu.

1. To edit the word, select it, and then double-click. Notice the Edit Text dialog box.

2. In the text box, change Ensuit to “Ensuite” and then click OK. Notice that the word is
corrected in the drawing.

TIP To change the spelling of words and change other properties at the same time,
right-click the text, and then choose Properties from the shortcut menu.

Borders and Title Blocks
Drawings are often drawn with borders. Borders are useful for identifying drawing areas —
and give drawings a professional, finished look. Engineering and architectural firms some-
times have their own drawing border standards; other times clients require the use of their
borders. In addition, standards organizations such as ANSI (United States), DIN (Germany),
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ISO (international), and JIS (Japan) specify the design of drawing borders.

For instance, the figure below illustrates the ANSI standard border for A-size portrait drawings.

Revision
List

Fold
Mark

Title
Block

Drawing
Border

Drawing Border shows the limits of the drawing.

Revision List provides a record of changes made to the drawing.

Fold Mark indicates where to fold the paper in halves.

Title Block records information about the drawing, such as its title, the date it was drawn,
and the name of the drafter.
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MVIEW COMMAND

Creates viewports in layouts to
reveal model space entities.

Command: mview

Alias: mv

Menu: View | Layout
Viewports

Toolbar: View | Layout
Viewports

Options: ON, OFF

Fit

2, 3, 4

Borders are available in a range of standard sizes. The smallest is called “A”, which you may recog-
nize as the 8-1/2 x 11" letter-size paper used in many offices. Each larger size doubles in area:

Size Dimensions

A 8.5 x 11" (landscape) and 11 x 8.5" (portrait)
B 11 x 17" (landscape only)
C 17 x 22"
D 22 x 34"
E 34 x 44"

The equivalents in metric ranges from A4 (smaller) through A0 (larger).

Layout Drawings (MView)

You could draw the border around the drawing, but that leads to scale issues. As with text, the
border has to be scaled to fit the size of paper. Unlike text, the border changes, depending on
the size of paper the drawing is printed on.

progeCAD provides a second way of looking at drawings, called
“layout mode.” Until now, you have been drawing in model
mode. At the bottom of the drawing area are three tabs: Model,
Layout1, and Layout2.

As their names suggest, Model mode is for creating and edit-
ing the model (drawing), while Layout mode is for laying out
the drawing in preparation for plotting. The number “1” next
to Layout (Layout1) is an indication that models can have
numerous layouts. (Layouts are the new name for “paper
space.”)

You can create layouts for different sizes of drawing and types of
plotters. For example, you might want one layout for plotting to
your A-size laser printer, and a second for plotting to your E-size color inkjet plotter. Here’s how to
use layouts:

1. Switch to layout mode by clicking the Layout1 tab.

The drawing goes blank, but don’t worry: the drawing is not missing; rather, it is
“hidden” in model space until you chose to reveal it by creating a viewport into model
space.

2. Draw a border and title block using the dimensions illustrated below. Draw as much
or as little of the border as you wish.
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Or, use the DdInsert command to place the ANSI A Portrait.dwg file as a block. Use
the default settings to insert the block: insertion point 0,0; scale factors = 1; rotation
= 0.

3. The next step is to create a viewport in this layout to reveal the model. But first, use
the la alias (for the layer command) to create a new layer called “Viewport.”

4. Use the MView command (short for “Make viewport”). From the View menu, select
Layout Viewports.

Alternatively, select the Layout Viewports button from the View toolbar, or enter
mview in the command bar.

Command: mview

5. progeCAD prompts you to pick two corners of a rectangle that  forms the viewport.
ON/OFF/Fit/2/3/4/<First corner>: (Pick a point.)

Opposite corner: (Pick another point.)

For an idea of where to pick the points, see the figure illustrated on the next page.
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First
corner:

Opposite
corner:

Viewport

As soon as you pick the second corner, a magical event occurs: the floor plan reap-
pears!

Border and
Title Block
(paper space)

Floor Plan
Drawing
(Model space)Viewport

(paper space)

You are looking at two “overlapping” drawings. One is the floor plan in model space; the other
is the border and title block in paper space (a.k.a. layout). The two spaces are independent of
each other, linked by the viewport.
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Paper Space Exercises (MSpace, PSpace)

Paper space (layout mode) can be confusing to new CAD users, so here are some exercises to
help you understand the differences.

1. Select the floor plan. Move the cursor over any part of the floor plan and click. Notice
that progeCAD doesn’t find any entities.

Lesson: when in layout mode, model space entities are inaccessible. You can see, but
you can’t touch.

2. Select the border or title block. Notice that you can select them.

Lesson: when in layout mode, paper space entities can be selected and edited.

3. Select the viewport rectangle. Notice that square green grips appear. Drag one of the
grips so that the viewport changes its size. (See figure below.)

Lesson: viewports are editable entities. You can move, copy, stretch, and erase them
— as well as apply properties, such as color, linetype, and lineweight.

Use the U command to revert the viewport to its original shape.

5. Use the la alias to freeze the “Viewport” layer. Notice that the viewport rectangle
disappears, but that the floor plan drawing remains.

Lesson: The viewport’s properties are independent of the viewport content (the
model space drawing).

6. Use the Zoom Window command to zoom into the title block. Notice that the floor
plan model zooms along. Use the Zoom Extents command to revert the view.

Lesson: You can zoom and pan in layout mode just as in model mode.

7. A button on the status bar lets you switch between the two spaces, model and paper.
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Click PAPER; notice that it changes to MODEL. (This action executes the MSpace
command.)

8. Repeat the actions you used above:

a. Select an entity in the floor plan: this time it is highlighted, because it is in model
space.

b. Select the border: this time progeCAD cannot find it, because the border is in
paper space.

c. Zoom into a part of the floor plan: this time the floor plan (in model space)
becomes larger, but the border and title block remain unchanged (in paper space).

Border and
Title Block
(paper space)

Zoomed-in
Floor Plan
Drawing
(Model space)

d. Use the Zoom Extents command to return the view to normal.

9. Click MODEL on the status bar to return to paper space. (This executes the PSpace
command.)
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Place Paragraphs of Text (MText)

After learning about the Text and DText commands, you might be
surprised to learn that progeCAD hosts yet another command for
placing text.

MText (short for “multi-line text”) is designed for placing para-
graphs of text, such as notes. But it is especially useful for text that
must contain a variety of text effects, such as multiple fonts, bold-
face, superscripted characters, and several colors.

1. To place notes in the drawing, start the MText com-
mand. From the Draw menu, select Text, and then
choose Multiline Text.

(Alternatively, click the Multiline Text button on the 2D
Draw toolbar, or enter mtext in the command bar.)

Command: mtext

2. progeCAD prompts you to pick two points. These form
the rectangle within which the paragraphs of text are
fitted.

Multiline Text:  First corner for block of text: (Pick a point.)

Justification/Rotation/Style/Height/Direction/Width/<Opposite corner for block of text>: (Pick
another point.)

First corner
for block of
text:

Opposite
corner for
block of text:

MTEXT COMMAND

Places paragraphs of text.

Command: mtext

Aliases: t, mt

Menu: Insert | Multiline Text

Toolbar: Draw 2D | Multiline
Text

Options: Justification

Rotation

Style

Height

Direction

Width

ALTERNATIVES

Text and DText place lines of
text in drawings.
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3. After you pick the second point, progeCAD displays the Multiline Text dialog box. It
is here that you enter and format text.

4. Enter text, such as the notes illustrated by the figure below.

5. Click OK to dismiss the dialog box, and place the text in the drawing.

6. Click the Print Preview button on the toolbar, or enter the Preview command.
You see a different version of the drawing, depending on the mode in which you enter
preview:

PAPER – in paper space, both model and paper space (floor plan and bor-
der) are printed.

MODEL — in model space, only the model (floor plan) is printed.

7. Print the drawing, if you wish.

TIPS To format a selection of mtext, highlight it (drag the cursor over the text), and
then select the formatting option.

You can copy text from another source, such as a Word document, and then use Ctrl+V
to paste the text in the mtext editor.

After mtext is placed in the drawing, you can edit it by double-click the mtext; in the
Entity Properties dialog box, select Full Editor.

Text Tab

The options available in the Text tab are:
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Font droplist select fonts. You can chose from any TrueType and AutoCAD font installed on
your computer.

Height specifies the height of the text in inches. The droplist contains the default height of 0.2
units, as well as any recently-used heights.

Bold, Italic, Underline adds bolding, italics, and underlining to text.

Remember that the above options work only when you first highlight some or all of the text. If
you forget to highlight it, it fails to change its font, height, or other effects.

Undo undoes the last action in the dialog box.

Zoom droplist enlarges and reduces the size of the text in the dialog box; does not affect the
size of the multiline text placed in the drawing.

Properties Tab

Click the Properties tab for additional options:

Style droplist selects a text style defined by the Style command. The properties set by the Text
tab override the properties specified by the style.

Justification droplist specifies how the paragraphs of text fit within the mtext rectangle.

Width changes the width of the text block; enter another width, or select No Wrap (text is
not constrained to the mtext rectangle).

Rotation rotates the entire block of text; select one of the preset angles, or enter a specific angle.
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the floor plan drawing is almost complete. All that’s missing are dimensions, which indicate
lengths and distances. progeCAD supports a number of different kind of dimensions.

Linear dimensions measure the distance between two points. Most are horizontal
or vertical, but some might be rotated (measured at an angle) or aligned (measured
along entities).

Radial dimensions measure the radius or diameter or curved entities, like arcs and
circles.

Angular dimensions measure the angle between vertices.

Leaders are used to point text to entities.

C • H • A • P • T • E • R 12

Adding Dimensions
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In This Chapter

• DimLinear command • DimScale command • DimStyle command
• Dist command • List command • Area command
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Linear dimensions consist of four parts:

Dimension Line

2 1/8"

Dimension Text

Extension Line

Arrowhead

• Dimension line indicates the distance between the two points being measured.

• Dimension text spells out the distance and its modifiers (if any).

• Extension lines link the dimension line with the points being measured.

• Arrowheads traditionally point to the ends of the dimension line.

Hence, you typically pick three points for each linear dimension: one pick for the starting point
of each extension line, plus one pick that simultaneously locates the dimension line and the
text. progeCAD figures out everything else: drawing the lines and arrowheads, and then mea-
sures the distance to generate the text.

Dimensions have styles like text, which let you define the look and placement of every dimen-
sion element.

Linear Dimensions (DimLinear)
You place linear dimensions like this:

1. Open the floor plan drawing in progeCAD.

(If you were unable to complete the drawing to this point,
open the 4Text.dwg file.)

2. Click the Model tab to return to model space.

(If necessary, create some breathing space around the
drawing with the Zoom 0.8x command.)

3. Change to the “Dimensions” layer using one of these meth-
ods:

• From the Entity Properties toolbar, click the Layer
Control drop list, and then select “Dimensions.”

COMMAND SUMMARY

Dimensions linear distances.

: dimlinear

Aliases: dli, dimlin

Menu: Insert | Dimensions |
Linear

Toolbar: Dimensions |
Linear

Options: Angle

Text

Orientation

ALTERNATIVE

DimAligned dimensions along
entities.
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Dimensioning Drawings

progeCAD provides a number of commands for dimensioning entities.

Drawing Dimensions

DimAligned places dimensions aligned to entities.

DimAngular places dimensions that measure angles.

DimBaseline continues from a previous linear, angular, or ordinate dimension; the first exten-
sion line is the start of the baseline dimension.

DimCenter places center markers at the center of circles, arcs, and polyline arcs.

DimContinue continues from a previous dimension; the final extension line of the last dimen-
sion is the start of the continued dimension.

DimDiameter measures the diameters of circles, arcs, or polyline arcs.

DimLeader draws leaders.

DimLinear places horizontal and vertical dimensions.

DimOrdinate places ordinate dimensions.

DimRadius dimensions the radii of circles, arcs, and polyline arcs.

Editing Dimensions

DimEdit changes, rotates, and restore text, and obliques extension lines.

DimOverride overrides the style settings for selected dimensions.

DimTEdit changes the position and angle of dimension text.

In addition to the above commands, dimensions can also be edited using grips.

Handling Dimension Styles

DimStyle displays the Dimension Settings dialog box.

-DimStyle creates, changes, and saves dimension styles in the command bar.

Quick Dimensioning

To create and modify a series of dimensions quickly, you can use the QDim command. It is
particularly useful for creating a series of baseline or continued dimensions, or for dimension-
ing a series of circles and arcs.

To start quick dimensioning, enter the QDim command, or choose Dimension | Quick Di-
mension from the menu. You are prompted to select objects for dimensioning; specify the
position of the dimension line, or else choose from the options:

[Continuous/Staggered/Baseline/Ordinate/Radius/Diameter/datumPoint/Edit]:
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• Enter the la alias. When the Layer Properties Manager dialog box appears, select

“Dimensions”, and then click the Current  button. Click OK.

• Use the -Layer command’s Set option to change the working layer to
“Dimensions,” as follows:
Command: -layer

Layer:  ? to list/New/Make/Set/Color/Ltype/LWeight/ON/OFF/Plot/Freeze/Thaw/LOck/Unlock: s

Layer to set as current <0>: dimensions

Layer:  ? to list/New/Make/Set/Color/Ltype/LWeight/ON/OFF/Plot/Freeze/Thaw/LOck/Unlock:
(Press Enter to exit the command.)

4. Use the DimLinear command to dimension the outside wall on the left. From the
Dimension menu, select Linear.

(Alternatively, click the Linear button on the Dimensioning toolbar, or type
dimlinear in the command bar.)

Command: dimlinear

TIP The DimLinear command creates horizontal,
vertical, or rotated dimensions — based on the order of
your pick points.

progeCAD creates linear dimensions using two
methods: by measuring the entity, or by measuring the
distance between two pick points.

5. progeCAD prompts you to:

• Select an entity; or

• Pick the location of the first extension line.

For this dimension, select the first option:
ENTER to select entity/<Origin of first extension
line>:  (Press Enter.)

6. progeCAD asks which entity to dimension:
Select entity to dimension: (Pick the line.)

7. Finally, you need to tell progeCAD where to locate the dimension line:

Step 2:
Position
dimension line.

Step 1:
Select entity to
dimension.
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Angle/Text/Orientation of dimension line:  Horizontal/Vertical/Rotated: (Move cursor away from
line, and then pick a point.)

progeCAD draws the dimension, but look closely: can you see what’s wrong? The arrowheads
and dimension text appear to be missing. The problem is corrected with the DimScale di-
mension variable.

Dimension Scale (DimScale)

The problem is that dimensions need to be scaled, just like text. Scaling is performed with the
DimScale dimension variable.

1. Use the U command to remove the dimension.

2. Enter the DimScale command, and use the same scale factor you used for text in the
previous chapter.

Command: dimscale

New current value for DIMSCALE (0 or greater) <1>: 48

3. Repeat the DimLinear command, and redimension the line. This time the text and
arrowheads are visible.

But the dimension text is annoying: it is in decimal units and has four decimal places. For this
architectural drawing, it should be in architectural units — feet and fractional inches. This
problem is corrected with the DimStyle command.

Dimension Styles (DimStyle)

The look of dimensions is set with the DimStyle command. Change the style so that dimen-
sion text is shown in feet and fractional inches.

1. Start the DimSytle command. From the Dimension
menu, select Dimension Style.

(Alternatively, select Dimension Settings from the Set-
tings toolbar, or enter dimstyle in the command bar.)

Command: dimstyle

Notice the Dimension Settings dialog box.

DIMSTYLE SUMMARY

Creates and edits dimension
styles.

Command: dimstyle

Aliases: d, ddim, setdim

Menu: Settings | Dimension
Settings

Toolbar: Settings | Dimension
Settings

ALTERNATIVES

-DimStyle controls dimension
styles at the command line.

ExpDimstyles displays the
Explorer Dimension Styles
window.
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2. The enormous preview window lets you see the effect of changing the dimension
style. Take a quick tour by clicking on each tab: Arrows, Format, Lines, and so on. This
may well be the most imposing of all dialog boxes, but fortunately you need change only
a few items.

(If necessary, select “Standard” from the Dimension Style droplist; ignore the
warning.)

3. Click the Units tab.

Units
format

Preview window

Scale Factor

Fractional
accuracy
(decimal
places)

6. First, change the dimension scale factor back to 48, so that you can see the preview
window in action: in the Scaling section, change Comprehensive Scale Factor to 48.

TIP The Linear dimensioning scale factor allows you to switch between Imperial
(inches) and metric measurement systems.

For example, this drawing is in feet-and-inches. If you were to change this scale
factor to 25.4, all dimensions would change to millimeters.



178 part ii: the tutorial projects

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

7. In the Linear Dimension section, click on the Format drop list, and
then select “Architectural.”

8. Reduce Decimal Places to 1. That means that fractional inches are
dimensioned to the nearest 1/2-inch.

9. Click Save. This forces the changes to be applied to the dimension
style.

10. Click OK.  Notice that dimension changes from 384.0000 to 32'.

Dimensioning Between Two Points

Let’s continue dimensioning the drawing:

1. Repeat the DimLinear command. This time dimension the top of the
floor plan. Use INTersection entity snap to ensure the dimension is
placed between the two corners.

Command: dimlinear

ENTER to select entity/<Origin of first extension line>: int

Snap to intersection of: (Pick point 1.)

Origin of second extension line: int

Snap to intersection of: (Pick point 2.)

Angle/Text/Orientation of dimension line:  Horizontal/Vertical/Rotated: (Pick point
3.)

Step 1:
Locate First
Extension Line
(INTersection
entity snap)

Step 2:
Locate Second
Extension Line
(INTersection
entity snap)

Step 3:
Position Text.

Continue Dimensions (DimContinue)

The right side of the floor plan has four rooms, and would use four
dimensions. Here is where the DimContinue command comes
in handy: it continues from the previous dimension, placing the
first extension line at the previous one, and locating the dimension
line with the previous one. Try it now:

1. Dimension the bedroom with the DimLin alias. (Re-
member to keep INTersection entity snap turned on.)

2. Start the DimContinue command. From the Dimension
menu, select Continue.

DIMCONTINUE COMMAND

Adds dimensions from the pre-
vious extension line.

Command: dimcontinue

Aliases: dco, dimcont

Menu: Insert | Dimensions |
Continue

Toolbar: Dimensions |
Continue

ALTERNATIVE

DimBaseline adds dimensions
from the same starting point.
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(Alternatively, click the Continue button on the Dimensions toolbar, or type
dimcontinue in the command bar.)

Command: dimcontinue

3. Pick the location of the next extension line:
Continue:  ENTER to select starting dimension/<Origin of next extension line>: (Pick a point.)

4. Continue until the end of the wall:
Continue:  ENTER to select starting dimension/<Origin of next extension line>: (Pick another
point.)

Continue:  ENTER to select starting dimension/<Origin of next extension line>: (Press Esc to exit
the command.)

5. Dimension the lower wall. When you are done, the drawing should look something
like the figure illustrated below.

6. Save your work with the QSave command.
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Other Methods of Measuring Drawings
The dimensioning commands are holdovers from the days when drawings were hand-drafted
with pencils, straight edges, scale rulers, and erasers. Back then, drawings were mostly drafted
to scale. Dimensions helped others read the drawing without needing to reach for scale rulers.
(“Rulers” in plural, because multiple rulers were needed for different disciplines, such as ar-
chitecture and engineering.)

Strictly speaking, dimensions are not needed in CAD drawings, because everything is drawn
full-size. That 32'-wall truly is thirty-two feet long. Scaling occurs only when it comes time to
print the drawing.

progeCAD includes commands for measuring distances, angles, and areas directly from draw-
ings. Let’s see how they work.

Measuring Distances and Angles (Dist)

The Dist command (short for “distance”) measures distances and
angles between two points.  Use it to measure the length of the
wall between the kitchen and dining area.

1. Start the Dist command. From the Tools | Inquiry
menu, select Distance.

(Alternatively, click the Distance button on the Inquiry
toolbar, or type the dist command.)

Command: dist

2. As with dimensions, it’s a good idea to use entity snaps
to ensure the measurements are 100% accurate. (If
necessary, turn on ENDpoint entity snap.)

progeCAD prompts you for two points:
Starting point for distance: (Pick one end of the wall.)

End point: (Pick other end of the wall.)

3. Notice that progeCAD reports back the following information.
Distance = 10'-0",  Angle in XY Plane = 0,  Angle from XY Plane = 0

Delta X = 10'-0",  Delta Y = 0",  Delta Z = 0"

The wall is ten feet long.  (If you cannot see all the text in the command bar, press F2
to display the text window.)

4. To see how angles work, find the diagonal distance from one corner of the apartment
to the opposite corner. The result I got was (your result may differ):

Command: dist

Starting point for distance: (Pick one corner.)

End point: (Pick other corner.)

Distance = 38'-10",  Angle in XY Plane = 233,  Angle from XY Plane = 0

Delta X = -23'-4",  Delta Y = -31'-0",  Delta Z = 0"

DIST COMMAND

Determines the distance and
angle between two points.

Command: dist

Alias: di

Menu: Tools | Inquiry |
Distance

Toolbar: Inquiry |Distance

ALTERNATIVES

Area reports the area and
perimeter of closed entities.

List reports the length and
other data of entities.
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The meaning of the various distances are illustrated by the following figure:

Delta Y = -31'-0"

Distance = 38'-10"

  Angle in XY Plane = 233

Starting point
for distance:

Delta X = -23'-4"

End point:

“Delta” means difference, or the net distance between the two points. Delta Z and Angle
from XY Plane are used only in 3D space.

Measuring Entities (List)

The List command reports information about selected entities. It
returns everything progeCAD knows about the entities; much of
that information isn’t terribly useful to everyday drafting; still, this
command is handy when you can’t figure out what’s happening with
some entity or another.

In the context of this chapter, List returns length, perimeter, cir-
cumference, and area data — the data varies, depending on the en-
tity. Try out the command on several entities.

1. Start the List command. From the Tools | Inquiry
menu, select List Entity Info.

(Alternatively, click the List Entity Info button on the
Inquiry toolbar, or type the list command in the com-
mand bar.)

Command: list

2. Select a line.
SCroll/SOrt/Tracking/<Select entities to list>: (Pick a line.)

LIST COMMAND

Reports everything progeCAD
knows about entities.

Command: list

Aliases: li, ls

Menu: Tools | Inquiry | List
Entity Info

Toolbar: Inquiry | List
Entity Info

Options: Scroll

Sort

Tracking

ALTERNATIVES

Area reports the area and
perimeter of closed entities.

Dist measures the distance
between two points.
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3. progeCAD displays its report in the text window, because the listing is longish:
---------- Line ---------------------------------------------------

Handle: 55

Current space: Model

Layer: Walls

Color: 256 (BYLAYER)

Linetype: ByLayer

Lineweight: 30

From point: X=   2'-6"  Y=   27'-0"  Z=   0"

To point: X=   2'-6"  Y=   23'-0"  Z=   0"

Length: 4'-0"

Angle in UCS XY plane: 270

Delta values:X=   0"  Y=   -4'-0"  Z=   0"

Highlighted is the length, four feet.

4. Select a block:
---------- Insert of Block ----------------------------------------

Handle: 212

Current space: Model

Layer: Assets-Fixed

Color: 256 (BYLAYER)

Linetype: ByLayer

Lineweight: 30

Block name: Tub-Topview

Insertion point: X=   23'-7"  Y=   3'-4"  Z=   0"

X scale factor: 1

Y scale factor: 1

Z scale factor: 1

Rotation angle: 90

5. And select a piece of text:
 ---------- Text ---------------------------------------------------

Handle: 6C1

Current space: Model

Layer: BORDER

Color: 256 (BYLAYER)

Linetype: ByLayer

Lineweight: 0

Color: 256 (BYLAYER)

Linetype: ByLayer

Lineweight: 0

Text style:Standard

Insertion point: X=   1'-11"  Y=   13'-7"  Z=   0"

Text height: 1'-0"

Text value: Dining Area

Rotation angle: 0

Generation: Normal

Vertical alignment: Baseline

Horizontal alignment: Left



chapter 12: adding dimensions 183

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Measuring Areas (Area)

The Area command finds the areas of entities and spaces. Here’s
how to find the area of any room.

1. Start the Area command. From the Tools | Inquiry
menu, select Area.

(Alternatively, click the Area button on the Inquiry
toolbar, or type the area command in the command bar.)

Command: area

2. With the assistance of INTersection entity snap, pick each
corner of the Ensuite bathroom.

Entity/Add/Subtract/<First point>: (Pick one corner.)

<Next point>: (Pick another corner.)

<Next point>: (Pick the third corner.)

<Next point>: (Pick the last corner.)

1: First point

4: Next point

2: Second point

3: Next point

3. Press Enter to end the measurements. progeCAD reports the results:
<Next point>: (Press Enter to exit the command.)

Area = 3920" sq. (27' sq.), Perimeter = 21'-0"

The bathroom has an area of twenty-seven square feet. This tells the subcontractor the amount
of floor tile to order. And the perimeter of twenty-one linear feet is the length of baseboard
material that will be needed.

TIP The Area command’s Add and Subtract options allow you to add other areas and
remove “holes” to find a grand total.

The command’s Entity option reports the area and perimeter of closed entities:
circles, ellipses, polylines, polygons, traces, and planes. In the case of polylines, Area
“closes” the start and end points to find the area.

It also works with open entities, but in then only the length is reported: lines, arcs,
and splines.

AREA COMMAND

Measures the area and perim-
eter of entities and spaces.

Command: area

Alias: aa

Menu: Tools | Inquiry | Area

Toolbar: Inquiry | Area

Options: Entity

Add

Subtract

ALTERNATIVES

List reports the area and
other data of entities.

Dist measures the distance
between two points.
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with progreCAD, you can publish 2D drawings or 3D models to Google Earth. To do so,
you first need know the position of the drawing on the earth's surface.

The method I consider the easiest is to first import a Google Earth area into progeCAD. The
area is imported from the current Google Earth view  into progeCAD as raster image. You use
the raster image as a background for the drawing. More importantly, the image gives the  geo-
graphical reference (longitude and latitude) of your drawing’s position on the surface of the
earth.

Starting Google Earth
Here are the steps involved:

1. Start Google Earth. (If necessary, download and install Google
Earth from earth.google.com/download-earth.html.)

2. Maximize the Google Earth window. Do not minimize or close
the Google Earth application at any time during this tutorial.

3. Zoom to the location on the earth's surface in which you want to
put your drawing. Zoom in to capture enough detail of the
location area. See explanation of Google Earth controls at right.

4. Be sure you are looking down perpendicularly to the earth’s
surface (the view has no rotation.)

C • H • A • P • T • E • R 13

Interacting with
Google Earth
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In This Chapter

• Setting up Google Earth • Adjusting the image and drawing
• Exporting to Google Earth

Zoom In

Tilt

Pan



chapter 13: interacting with google earth 185

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

 At this point, you might be seeing something like the figure shown below.

Importing Images to progeCAD

With Google Earth running and ready, it is time to copy the satellite view to your drawing in
progeCAD. Follow these steps:

1. Start progeCAD, and then open your drawing. If it is a 3D model, then ensure it is in
plan view.

2. Click the ImportGEimage button progeCAD’s Google Earth toolbar. Alternatively,
enter  ImportGEImage in the command bar.

3. Set the drawing units in order to scale the image correctly.

4. Click OK.
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COMMAND SUMMARY

Inserts images from Google
Earth.

: ImportgeImage

Aliases: none

Menu: Add-on| Google Earth
| ImportGEimage

Toolbar: Google Earth
| ImportGEimage

After a few seconds, the current Google Earth view is imported and placed at the origin (0,0) of
the drawing. Notice that the image is black and white; this is a current limitation imposed by
Google Earth.

If you cannot see anything, use Zoom Extents to include all objects of the drawing.

Working With Google Earth Images

When working with images from Google Earth, the following sug-
gestions may help.

Once the image is placed, you can use progeCAD’s Move and
Rotate commands to refine the drawings’s position relative to the
image. Do not adjust the position of the Google Earth’s image!

The image displayed in the drawing is a JPG file and it is stored in
the same directory as the DWG file.

Use the DrawOrder command to visually place the image un-
derneath the drawing, like this:

1. From the Tools menu, choose Draw Order. (Alternatively, enter the DrawOrder
command.)

2. Select the entity you wish to reorder, and then press Enter. If you are reordering
above or under, select the entity you want the first entity to be above or below, and
then press Enter.

3. Specify the new drawing order, and then press Enter.
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Publishing Drawings to Google Earth

To publish drawings to Google Earth, follow these steps:

1. Click the PublishKML button on progeCAD’s Google Earth toolbar, or enter the
PublishKML command.

2. In the dialog box, click the Get Georeference Data
from Picture.

3. Select the Google Earth image that you previously
inserted. This picks up the coordinates.

4. If the position and rotation of a model relative to the
image are correct, there’s no need to modify the orienta-
tion of the Y axis to North. The output file name is taken
automatically from the DWG file name and directory.

5. Click OK.

The KMZ file generated by export has the same name and it is
stored in the same folder as the DWG file. (KMZ is short for “keyhole model compressed.”
Keyhole is the name of the company from which Google purchased Earth.)

TIP Colors of published entities in Google Earth match progeCAD’s object colors.

COMMAND SUMMARY

Exports drawings to Google
Earth.

: publishkml

Aliases: none

Menu: Add-on| Google Earth
| Publish KML

Toolbar: Google Earth
| PublishKML
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Toolbars, Menus,
Command Shortcuts,
Aliases & Buttons

this appendix illustrates the toolbars and menus included with progeCAD. It lists the default
list of keyboard shortcuts and command aliases in alphabetical order. And it provides a list
describing actions of mouse buttons.

Note that these interface items are specific to progeCAD.
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In This Appendix

• Toolbars • Menus • Keyboard Shortcuts
• Command Aliases • Mouse Buttons
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Toolbars
Toolbars consist of groups of buttons that exectute commands and macros. Toolbars, macros,
and help text are created and changed with the Tools | Customize | Toolbar command. The
icons cannot be changed.

Dimensions

Draw 2D

DrawOrder

Entity Properties

Entity Snaps

Express Tools

Express Tools - Layers
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Google Earth

Groups

Inquiry

Insert

Layouts

Modify

Modify II

Redlining
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RefEdit

Reference

Render

Shade

Solids

Solids Editing

Standard

Style
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Surfaces

Text

UCS

View

Viewports

Zoom

3dOrbit
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Menus
The menu bar, menu items, macros, and help text are created and changed with the Tools |
Customize | Menu command. The “experience level” is selected with the Tools | Options |
General command: advanced, intermediate, and beginner. Shown below are advanced menus.

File Edit

View  Insert
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Format  Tools

Draw Dimensions
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Modify Image Add-On

Express Window Help
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Shortcut Meaning Command Executed

Function Keys
F1a Display on-line help. HELP
F2a Display Prompt History window. PMTHIST
F3a Toggle object snap mode. ESNAP T
F4a Toggle tablet mode. TABLET T
F5a Switch to next isoplane. ISOPLANE
F6a Toggle coordinate display. COORDINATE T
F7a Toggle display of the grid. GRID T
F8a Toggle ortho mode. ORTHOGONAL T
F9a Toggle snap mode. SNAP T
F10 Toggle status bar. STATBAR T

Control Keys
Ctrl+Aa Select all entities in drawing. SELGRIPS ALL
Ctrl+Ca Copy selected entities to Clipboard. COPYCLIP
Ctrl+Shift+C Copies entities with a basepoint. COPYBASE
Ctrl+D Copies large numbers of entities. COPYQUICK
Ctrl+Shift+D Copies with basepoint. COPYBASEQUICK
Ctrl+Ea Switch to next isoplane. ISOPLANE
Ctrl+Na Start a new drawing. NEW
Ctrl+Oa Open a drawing file. OPEN
Ctrl+Pa Print the drawing. PRINT
Ctrl+Sa Save the drawing. QSAVE
Ctrl+Ta Toggle tablet mode. TABLET T
Ctrl+Va Paste from Clipboard into drawing. PASTECLIP
Ctrl+Xa Cut selected entities to Clipboard. CUTCLIP
Ctrl+Ya Redo the last undo. REDO
Ctrl+Za Undo the last command. U

Ctrl+1a Toggles the Properties palette. PROPERTIES
Ctrl+2a Displays the Explorer dialog box. EXPLAYERS

Other Keys
Dela Deletes selected entities . DELETE
Left Arrow Pans left. PAN L
Right Arrow Pans right. PAN R
Down Arrow Pans down. PAN D
Up Arrow Pans up. PAN U
Shift+Left Arrow Pans left by a pagefull. PAN PGL
Shift+Right Arrow Pans right by a pagefull. PAN PGR
Shift+Down Arrow Pans down by a pagefull. PAN PGD
Shift+Up Arrow Pans up by a pagefull. PAN PGU
Page Down Pans down by a pagefull. PAN PGD
Page Up Pans up by a pagefull. PAN PGU

a Shortcut key compatible with AutoCAD.  Shortcut key standard in Windows.

Keyboard Shortcuts
Keyboard shortcuts are abbreviations for commands. They consist of function keys, or holding
down the Ctrl and Shift keys in conjunction with other keys. Keyboard shortcuts are created
and changed with the Tools | Customize | Keyboard command.
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Command Alias(es)

A
Align al
Aperture ap
Arc a
Area aa
Array ar
AttDef -at
AttDisp ad
AttEdit -ate
AttExt ax

B
Backgrounds background
Base ba
BHatch bh
Blipmode bm
Block -b
Boundary bo, bpoly
-Boundary -bo
Break br
Bsr_Stru toolbar

C
Chamfer cha
Change -ch
Circle c
Config options, rconfig, preferenc, pr
Copy cp, co
Copylink cl

D
DdAttDef at
DdAttE ate
DdChProp ch
DdEdit ed
DdGrips gr
DdInsert i
DdRename ren
DdRModes rm
DdSelect se
DdUnits un

Command Alias(es)

Dim
DimAligned dimali, dal
DimAngular dimang, dan
DimBaseline dba, dimbase
DimCenter dce
DimContinue dco, dimcont
DimDiameter ddi, dimdia
DimEdit dimed, ded
Dimension dim
DimLinear dli, dimlin
DimOrdinate dimord, dor
DimOverride dov, dimover
DimRadius dimrad, dra
DimStyle dst, dimsty
DimTEdit dimted

Dist di
Divide div
DLine dl
Donut do, bagel
DTtext dt
DView dv
DxfIn dn
DxfOut dx

E
EditLen lengthen, len
EditPline pedit, pe
Ellipse el
EntProp ddmodify, ai_propchk, mo
Erase e
ESnap -os, osnap, -osnap
ExpBlocks xb, bmake, b
ExpDimstyles ds
ExpFonts ddstyle, expstyle, expstyles
ExpLayers ddlmodes, la, explorer
Explode x
ExpLtypes ddltype, lt
Export exp
ExpUcs dducs, uc

Command Aliases
Aliases are one-, two, and three-letter abbreviations for commands. They let keyboardists en-
ter commands faster; it is far quicker to type “l” than to type “line”.

Aliases can be used to map the names of commands from other CAD packages, such as AutoCAD,
to progeCAD commands. For example, AutoCAD’s “pedit” is mapped to progeCAD’s EditPline
command.  Aliases cannot be used for command options, or for accessing options within dia-
log boxes.

Aliases are created and changed with the Tools | Customize | Aliases command.
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Command Alias(es)

ExpViews ddview, v
Extend ex
Extrude ext

F
Fillet f, fi
Font st, style
Freehand sketch

G
Grid g

H
Hatchedit he
Hide hi

I
IdPoint id
ImageAttach iat
ImageClip icl
InsertObj io
Interfere inf
Intersect in
Isoplane is

L
-Layer -la
Leader le
Lighting light, lights
Line 3dline, l
-Linetype -lt
List li, ls
LtScale lts

M
MatchProp ma
Materials rmat
Mesh 3dmesh
Mirror mi
Move m
MsnapShot mslide
MSpace ms
MText mt, t
MView mv

N
New n
NewWiz ddnew

O
Open op, import
Orthogonal ortho, or

Command Alias(es)

P
-Pan p, -p
Parallel o, offset
PasteSpec pa
Plane so, solid
Point po
Polygon pol
Polyline pline, pl
PPreview pre, makepreview, preview
-Print -plot
Print plot
PSpace ps
Purge pu

Q
Qtext qt

R
Rectangle rect, rec
Redraw r
RedrawAll ra
Regen re
RegenAll rea
Region reg
ReInit ri
Rename -ren
Render rr
Revolve rev
Rotate ro

S
Save sa
Scale sc
Script scr
Section sec
SelGrips selgrip
SetColor col, ddcolor
SetDim ddim, d
SetEsnap os, ddosnap, ddesnap
SetRender rpref
SetUcs ucp, dducsp
SetVar set
Shade sha
Slice sl
Snap sn
Spell sp
Spline spl
SplinEdit spe
Stretch s
Subtract su
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Command Alias(es)

T
Tablet ta
TbConfig to
Text -t, tx
Time ti
Tolerance tol
Torus tor
Trim tr

U
Undelete oops, oo
Union uni
Units -un

V
Vba vbaide
-View -v, v
View ddview
ViewCtl vp, ddvpoint
Viewpoint vpoint, -vp
VpLayer vl
VPorts vw, vport
VSnapshot vs, vslide

Command Alias(es)

W
WBlock w
WCloseAll closeall
Wedge we
WmfIn wi
WmfOut wo

X
XBind -xb
XClip clip , xc
XLine xl, infline
-XRef -xr, xa, xattach

Z
Zoom                       z

3
3dArray 3a
3dPoly 3p
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Mouse Buttons
Mouse and puck buttons execute commands. Mouse buttons cannot be customized; puck but-
tons  can be customized through the tablet.lsp program.

Button Action

Objects Not Selected
Left Selects entities, menu items, toolbar buttons, and so on.
Shift+Left Displays shortcut menu with entity snaps.
Right Ends command; repeats last command.

Entities Selected
Left (single click) Deselects entities.
Left (double-click) Displays entity properties dialog box.
Shift+Left Displays shortcut menu with entity snaps.
Right Displays shortcut menu with editing commands.

Wheel (scroll bars not displayed)
Roll forward Zooms in 1.25x.
Roll back Zooms out 0.8x.

Wheel (scroll bars displayed)
Roll forward Pans up.
Roll back Pans down.
Ctrl+Shift+Left Pans left or right.
Shift+Left Zooms in or out.

Other Commands
Left Starts and ends sketch mode (Sketch command).
Left Enables real-time rotation (RtRot command).


